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Warranty
Danware Data A/S warrants the quality of the physical material of the user package, that is manual and
CD-ROM. If these items are defective, we will exchange them at no cost within 60 days of purchase from
Danware Data.

Disclaimer
Danware Data A/S denies any and all responsibility for damages caused directly or indirectly as a result
of any faults with the enclosed programs and/or documentation.

License
Danware Data A/S retains the copyright to the user manual. All patent, copyright and other proprietary
rights in and to the programs will remain with Danware Data A/S or its licensers.
Your purchase gives you the right to copy and use the programs as described on your Danware License
Certificate included in your package.
Please save your Danware License Certificate and your original CD-ROM. They serve as your legal right
to use the software. You may also need them in order to receive future updates to the product.
Please be careful not to install or run the software on more PCs than your Danware License Certificates
permits you to do.
The programs may be copied for backup purposes only, and only as long as the above mentioned rules are
adhered to.

Trademarks
NetOp® and the red kite are registered trademarks of Danware Data A/S. All other products mentioned in
this manual are trademarks of their respective manufacturers.



4

Contents

Contents
......................................................................................................................91 Introduction 

......................................................................................................................102 Installation 
....................................................................................................................................................102.1 Interactive Installation
....................................................................................................................................................182.1.1 Change or Remove
....................................................................................................................................................192.2 Student Deployment
....................................................................................................................................................202.2.1 Deployment Wizard
....................................................................................................................................................242.2.2 Deploy

......................................................................................................................263 NetOp Teacher 
....................................................................................................................................................263.1 Load and Unload Teacher
....................................................................................................................................................263.1.1 Loading Alternatives
....................................................................................................................................................273.1.2 Setup Wizard
....................................................................................................................................................323.2 Teacher Window
....................................................................................................................................................323.2.1 Title Bar
....................................................................................................................................................323.2.2 Menu Bar
..................................................................................................................................................333.2.2.1 File Menu
..................................................................................................................................................333.2.2.2 Action Menu
..................................................................................................................................................343.2.2.3 Tools Menu
..................................................................................................................................................363.2.2.4 Selected View Menu
..................................................................................................................................................363.2.2.5 Help Menu

....................................................................................................................................................373.2.3 Toolbar
..................................................................................................................................................393.2.3.1 Demonstrate
...................................................................................................................................................403.2.3.1.1 Entire Desktop

..............................................................................................................................................40Screen Control Toolbox

..............................................................................................................................................41Student Demo Toolbox

..............................................................................................................................................42NetOp Marker Utility

..............................................................................................................................................42Title Bar

..............................................................................................................................................44Upper Toolbar

..............................................................................................................................................45Lower Toolbar

..............................................................................................................................................45Status Bar

..............................................................................................................................................45Figure Markers

..............................................................................................................................................46Text Marker

..............................................................................................................................................48NetOp Magnifier

..............................................................................................................................................49Delete Markers

..............................................................................................................................................49Marker Properties and Help

..............................................................................................................................................49Pass the Chalk
...................................................................................................................................................503.2.3.1.2 Selected Desktop Area
...................................................................................................................................................503.2.3.1.3 Media File

..............................................................................................................................................51Prepare Media File

..............................................................................................................................................52Play Media File
...................................................................................................................................................533.2.3.1.4 Media File on the Web
...................................................................................................................................................533.2.3.1.5 Recording
...................................................................................................................................................533.2.3.1.6 Specific Monitor
...................................................................................................................................................543.2.3.1.7 Student Desktop
...................................................................................................................................................553.2.3.1.8 Options
..................................................................................................................................................563.2.3.2 Attention
..................................................................................................................................................573.2.3.3 Control
...................................................................................................................................................583.2.3.3.1 Remote Control

..............................................................................................................................................59Remote Control Window

..............................................................................................................................................59Title Bar

..............................................................................................................................................61Toolbar or Toolbox

..............................................................................................................................................63Pane

..............................................................................................................................................63Status Bar

..............................................................................................................................................64Session Properties

..............................................................................................................................................65Display Tab

..............................................................................................................................................66Keyboard/Mouse Tab

..............................................................................................................................................67Compression Tab

..............................................................................................................................................68Desktop Tab



5

Contents

...................................................................................................................................................693.2.3.3.2 Monitor
..............................................................................................................................................70Monitor Toolbox

..................................................................................................................................................713.2.3.4 Communicate
...................................................................................................................................................723.2.3.4.1 Audio-Video Chat
...................................................................................................................................................733.2.3.4.2 Chat
...................................................................................................................................................753.2.3.4.3 Send Message

..............................................................................................................................................75Title Bar

..............................................................................................................................................75Menu Bar

..............................................................................................................................................76File Menu

..............................................................................................................................................76Edit Menu

..............................................................................................................................................77Search Menu

..............................................................................................................................................77Format Menu

..............................................................................................................................................78Toolbar

..............................................................................................................................................79Message Pane

..............................................................................................................................................79Status Bar
..................................................................................................................................................793.2.3.5 Workgroup
..................................................................................................................................................813.2.3.6 Run
...................................................................................................................................................823.2.3.6.1 Run Test
...................................................................................................................................................823.2.3.6.2 Run Survey
...................................................................................................................................................823.2.3.6.3 Run Program

..............................................................................................................................................83Run Program Browse
..................................................................................................................................................843.2.3.7 Commands
..................................................................................................................................................843.2.3.8 Files
...................................................................................................................................................853.2.3.8.1 Distribute Files
...................................................................................................................................................913.2.3.8.2 Collect Files
...................................................................................................................................................983.2.3.8.3 File Manager

..............................................................................................................................................99Title Bar

..............................................................................................................................................99Menu Bar

..............................................................................................................................................99File Menu
..............................................................................................................................................102Copy/Move/Synchronize/Clone
..............................................................................................................................................103Transfer Status
..............................................................................................................................................104Progress Tab
..............................................................................................................................................105History Tab
..............................................................................................................................................106Session History Tab
..............................................................................................................................................106Edit Menu
..............................................................................................................................................107View Menu
..............................................................................................................................................108Options Menu
..............................................................................................................................................110Transfer Tab
..............................................................................................................................................111Confirmation Tab
..............................................................................................................................................114Layout Tab
..............................................................................................................................................115Help Menu
..............................................................................................................................................115Toolbar
..............................................................................................................................................117Record Panel

..................................................................................................................................................1193.2.3.9 Policy

..................................................................................................................................................1193.2.3.10 Record
....................................................................................................................................................1213.2.4 Class Control Panel
..................................................................................................................................................1233.2.4.1 Details View
...................................................................................................................................................1243.2.4.1.1 Details View Pane
...................................................................................................................................................1253.2.4.1.2 Change Class Menu
...................................................................................................................................................1263.2.4.1.3 Groups Pane
...................................................................................................................................................1283.2.4.1.4 Student Context Menu
...................................................................................................................................................1293.2.4.1.5 Student Group Context Menu
..................................................................................................................................................1313.2.4.2 Classroom View
...................................................................................................................................................1323.2.4.2.1 Classroom View Pane
..................................................................................................................................................1343.2.4.3 Thumbnails View
...................................................................................................................................................1353.2.4.3.1 Thumbnails View Pane
..................................................................................................................................................1383.2.4.4 Lesson Plan View
...................................................................................................................................................1393.2.4.4.1 Change Lesson Plan
...................................................................................................................................................1413.2.4.4.2 Lesson Action
..................................................................................................................................................1423.2.4.5 Recordings View



6

Contents

...................................................................................................................................................1433.2.4.5.1 Recordings View Pane

...................................................................................................................................................1453.2.4.5.2 Recording Playback
..................................................................................................................................................1463.2.4.6 Tests View
...................................................................................................................................................1473.2.4.6.1 Tests View Pane

..............................................................................................................................................150Tests

..............................................................................................................................................158Drop-Down List Question

..............................................................................................................................................161Essay Question

..............................................................................................................................................162Label Image Question

..............................................................................................................................................163Match Image Question

..............................................................................................................................................164Match Text Question

..............................................................................................................................................165Multiple Choice Question

..............................................................................................................................................166Ordering Question

..............................................................................................................................................167Question and Answer Question

..............................................................................................................................................168Text Completion Question

..............................................................................................................................................169Surveys

..............................................................................................................................................171Results
..................................................................................................................................................1753.2.4.7 Activity View
...................................................................................................................................................1763.2.4.7.1 Activity View Pane
...................................................................................................................................................1783.2.4.7.2 Active Applications and Sites Pane
..................................................................................................................................................1803.2.4.8 Class Setup View
...................................................................................................................................................1803.2.4.8.1 Class Setup View Pane
...................................................................................................................................................1833.2.4.8.2 Available Students Pane
....................................................................................................................................................1853.2.5 Status Bar
....................................................................................................................................................1863.2.6 Teacher Tools
..................................................................................................................................................1863.2.6.1 Options
...................................................................................................................................................1883.2.6.1.1 General Tab
...................................................................................................................................................1893.2.6.1.2 Class Tab

..............................................................................................................................................191Class Server Setup
...................................................................................................................................................1933.2.6.1.3 Teachers Tab

..............................................................................................................................................194NetOp Teacher Profiles

..............................................................................................................................................196Windows Teacher Profiles
...................................................................................................................................................1983.2.6.1.4 Connection Tab
...................................................................................................................................................1993.2.6.1.5 Menu/Toolbar Tab
...................................................................................................................................................2003.2.6.1.6 Web Update Tab

..............................................................................................................................................201Web Update Schedule
...................................................................................................................................................2033.2.6.1.7 Demonstrate Tab
...................................................................................................................................................2043.2.6.1.8 Attention Tab

..............................................................................................................................................205Attention Bitmap

..............................................................................................................................................206Attention Text

..............................................................................................................................................207Attention Text File

..............................................................................................................................................208Attention Web Page
...................................................................................................................................................2093.2.6.1.9 Control Tab
...................................................................................................................................................2103.2.6.1.10 Audio-Video Chat Tab

..............................................................................................................................................211Advanced Audio Settings
...................................................................................................................................................2123.2.6.1.11 Run Tab
...................................................................................................................................................2143.2.6.1.12 Policy Tab

..............................................................................................................................................216Edit Policy

..............................................................................................................................................217Application Tab

..............................................................................................................................................219Internet Tab
...................................................................................................................................................2213.2.6.1.13 Sharing Tab
...................................................................................................................................................2223.2.6.1.14 Protection Tab
..................................................................................................................................................2233.2.6.2 Help Request

....................................................................................................................................................2233.3 NetOp Screen Image

....................................................................................................................................................2243.3.1 Capture Tab

....................................................................................................................................................2253.3.2 Image of Tab

....................................................................................................................................................2253.3.3 Save As Tab

....................................................................................................................................................2263.3.4 Preferences Tab

....................................................................................................................................................2273.4 NetOp Screen Video

....................................................................................................................................................2273.4.1 Title Bar

....................................................................................................................................................2273.4.2 Menu Bar



7

Contents

..................................................................................................................................................2283.4.2.1 File Menu

..................................................................................................................................................2283.4.2.2 Region Menu

..................................................................................................................................................2293.4.2.3 Options Menu

..................................................................................................................................................2343.4.2.4 About Menu
....................................................................................................................................................2353.4.3 Toolbar

......................................................................................................................2364 NetOp Student 
....................................................................................................................................................2364.1 Load and Unload Student
....................................................................................................................................................2374.1.1 Loading Alternatives
....................................................................................................................................................2384.1.2 Setup Wizard
....................................................................................................................................................2434.2 Student Window
....................................................................................................................................................2444.2.1 Title Bar
....................................................................................................................................................2444.2.2 Menu Bar
..................................................................................................................................................2444.2.2.1 File Menu
..................................................................................................................................................2454.2.2.2 View Menu
..................................................................................................................................................2454.2.2.3 Action Menu
..................................................................................................................................................2464.2.2.4 Tools Menu
..................................................................................................................................................2464.2.2.5 Help Menu

....................................................................................................................................................2474.2.3 Toolbar

....................................................................................................................................................2484.2.4 Tab Panel
..................................................................................................................................................2494.2.4.1 General Tab
..................................................................................................................................................2504.2.4.2 Class Tab
..................................................................................................................................................2514.2.4.3 Messages Tab
..................................................................................................................................................2524.2.4.4 Recordings Tab

....................................................................................................................................................2544.2.5 Status Bar

....................................................................................................................................................2544.2.6 Student Tools
..................................................................................................................................................2544.2.6.1 Options
...................................................................................................................................................2564.2.6.1.1 General Tab
...................................................................................................................................................2574.2.6.1.2 Class Tab

..............................................................................................................................................259Class Server Setup
...................................................................................................................................................2614.2.6.1.3 Student Login Tab
...................................................................................................................................................2634.2.6.1.4 Protection Tab
...................................................................................................................................................2644.2.6.1.5 Audio-Video Chat Tab

..............................................................................................................................................265Advanced Audio Settings
...................................................................................................................................................2654.2.6.1.6 Help Request Tab
...................................................................................................................................................2664.2.6.1.7 Connection Tab
...................................................................................................................................................2674.2.6.1.8 Web Update Tab
..................................................................................................................................................2684.2.6.2 Protection Password

......................................................................................................................2705 Common Tools 
....................................................................................................................................................2705.1 Communication Devices
....................................................................................................................................................2715.1.1 TCP/IP
..................................................................................................................................................2715.1.1.1 TCP/IP Settings
..................................................................................................................................................2725.1.1.2 TCP/IP Communication Profile Edit
...................................................................................................................................................2745.1.1.2.1 Advanced TCP/IP Configuration
...................................................................................................................................................2755.1.1.2.2 IP Broadcast List
....................................................................................................................................................2765.1.2 Terminal Server
..................................................................................................................................................2765.1.2.1 Terminal Server Settings
..................................................................................................................................................2775.1.2.2 Terminal Server Communication Profile Edit

....................................................................................................................................................2775.1.3 IPX
..................................................................................................................................................2775.1.3.1 IPX Settings
..................................................................................................................................................2795.1.3.2 IPX Communication Profile Edit

....................................................................................................................................................2805.1.4 NetBIOS
..................................................................................................................................................2815.1.4.1 NetBIOS Settings
..................................................................................................................................................2825.1.4.2 NetBIOS Communication Profile Edit

....................................................................................................................................................2835.2 System Info

......................................................................................................................2856 Advanced Tools 
....................................................................................................................................................2856.1 NetOp.ini
....................................................................................................................................................2876.1.1 [INSTALL] Section
....................................................................................................................................................2876.1.2 [COEXISTENCE] Section
....................................................................................................................................................2876.1.3 [TEACHER] Section



8

Contents

....................................................................................................................................................2886.1.4 [STUDENT] Section

....................................................................................................................................................2886.1.5 [IPX] Section

....................................................................................................................................................2886.1.6 [NetBIOS] Section

....................................................................................................................................................2896.1.7 [DTL] Section

....................................................................................................................................................2896.2 NetOp Configuration Files

....................................................................................................................................................2906.2.1 Default Location of User Configuration Files

....................................................................................................................................................2916.2.2 Other Locations of User Configuration Files

....................................................................................................................................................2916.3 NetOp School Communication

....................................................................................................................................................2926.4 NetOp School in Terminal Server Environments

....................................................................................................................................................2926.4.1 Installation (TSE)

....................................................................................................................................................2936.4.2 Teacher and Student Setup (TSE)

....................................................................................................................................................2936.4.3 NetOp Gateway Setup (TSE)

....................................................................................................................................................2946.4.4 NetOp School Functionality (TSE)

....................................................................................................................................................2946.5 NetOp Name Management

....................................................................................................................................................2956.6 NetOp School Class Management

Index....................................................................................................................................297



9

Introduction

1 Introduction
The basic NetOp School user documentation consists of the Teaching with NetOp School startup guide,
the NetOp Teacher Help and NetOp Student Help on-line help systems and the NetOp Teacher User's
Manual and NetOp Student User's Manual.

This NetOp School advanced user’s manual provides technical guidance to the advanced user or
administrator. Being intended for technical specialists that are assumed to understand English, it is available
only in English.

It contains these main sections:

· Installation

· NetOp Teacher

· NetOp Student

· Common tools

· Advanced tools
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Installation

2 Installation
The basic NetOp School user documentation covers interactive installation very briefly by recommending
users to follow the installation on-line instructions.

This section covers in details interactive installation and the installation or update of NetOp Student on
remote network computers in these sections:

· Interactive Installation

· Student Deployment

2.1 Interactive Installation

You can install the NetOp School modules NetOp Teacher and NetOp Student interactively from these
installation files:

· NetOpSchoolTeacher_<Language abbreviation>.msi

· NetOpSchoolStudent_<Language abbreviation>.msi

They are available for download from the NetOp KnowledgeBase, click Download products > NetOp School.

On the computer on which you want to install the module, run the installation file to show this window:

Click Next to show this window:

http://help.netop.com
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Read the license agreement and click one of the options:

¡ I accept the terms in the license agreement: Will enable the Next button.

¤ I do not accept the terms in the license agreement: Will leave the Next button disabled.

Until executing the installation, click Back to return to the previous window to change selections.

Click Next to show this window:
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User name []: May retrieve the user name from Windows or from a license.dat file in the installation file
directory. Specifying a user name is optional.

Organization []: May retrieve the organization name from Windows. Specifying an organization name is
optional.

License number []: May retrieve the license number from a license.dat file in the installation file directory. A
valid license number must be specified.

This is an example of a license.dat file:

The LICNAME value is a User name value.

The GSTSNR value is a NetOp Teacher License number value.

The HSTSNR value is a NetOp Student License number value.

Click Next to show this window:
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Click one of these options:

· Typical: Will install recommended features to show the Windows firewall configuration window when
clicking Next.

· Custom: Will enable you to select which features to install to show the Custom setup window when
clicking Next.

· Complete: Will install all available features to show the Windows firewall configuration window when
clicking Next.

Click Next to continue. If you clicked Custom, this window will be shown:
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The pane will show the main feature expanding into available sub-features. This table shows available
sub-features on NetOp Teacher and NetOp Student:

 
Sub feature

Available on module:
Functionality

Teacher Student

Assistant teacher Enables Assistant teacher •
Assistant teacher help system Includes Teacher Help with Assistant teacher •
Web update Enables Web update • •
Help system Includes module Help • •
Click a sub-feature icon to show a menu of options.

Click Reset to restore the original selection.

Click Disk usage to show this window:
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The pane will show records of available drives with disk size, available disk space and disk space required
by the installation specified in the Custom setup window.

Click Browse to show this window:

It shows the selected destination folder name, its contents of folders and its path. You can select another
destination folder to specify its path. Click OK to apply.
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When satisfied with the specification in the Custom setup window, click Next to show this window:

Leave the box checked to modify the Windows firewall configuration to enable NetOp communication. Click 
Next to show this window:

Check the box to save the installation msi file in the directory in which the NetOp module is installed to have it
available for reinstallation. Click Install to execute installation. When completed, this window will be shown:
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Leave the box checked to load the installed module. Click Finish to end installation.
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2.1.1 Change or Remove

To change or remove a NetOp Teacher or NetOp Student installation, click Start > [Settings > ]Control Panel
> Add or Remove Programs.

An installed NetOp Teacher will be listed as NetOp School Teacher and an installed NetOp Student will be
listed as NetOp School Student.

Click a record to highlight and expand it to show Change and Remove buttons.

Click Change to show this window:

Click Next to show this window:
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Click one of these options:

· Modify: Show the Custom setup window to modify installed features and the following Interactive
installation windows to reinstall applying the modified setup. Installation files must be available.

· Repair: Show a Repair window like the Ready to install window and the following Interactive installation
windows to reinstall. Installation files must be available.

· Remove: Show a Remove window like the Ready to install window. You can check a box to remove
module configuration files during module removal. The following Interactive installation windows will be
shown. Installation files do not need to be available.

In the Add or Remove Programs window, click Remove to remove the module showing a small window.
Installation files do not need to be available.

To remove NetOp completely from the computer, also delete the NetOp.ini file from the Windows (WINNT)
directory, remove other NetOp files placed in other directories and remove all NetOp keys from the Windows
registry.

2.2 Student Deployment

Student deployment installs and sets up NetOp Student on remote network computers.

Note: To facilitate the administration of student computers in a teaching environment, a uniform setup of
NetOp Student on computers is typically demanded. Student deployment meets this demand.

Student deployment has some basic requirements:

1. The deploying computer must run on one of the operating systems Windows Vista, XP, 2000 or NT.

2. Computers deployed to must run on one of the operating systems Windows Vista, XP, 2000 or NT.

3. The user logged on to Windows on the deploying computer must have remote installation rights, typically
administrator rights, on computers deployed to.

You cannot deploy NetOp Student to computers that run on one of the operating systems Windows ME, 98
or 95. However, in NetOp Pack'n Deploy you can generate uniform setup installation files that can be used
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for local installation.

This section contains these sections:

· Deployment wizard

· Deploy

2.2.1 Deployment Wizard

To start Student deployment, in the NetOp Teacher window Tools menu click Run student deployment to
show this window:

Click Next to show this window:
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Click Next to show a Windows Open window to open a NetOpSchoolStudent_<Language abbreviation>.msi
file to show this window:

Click one of these options:

¤ Simplified: Specify deployed NetOp Student module setup in the NetOp Student Setup wizard.
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¡ Advanced: Specify deployed NetOp Student module setup in the NetOp Student Options window.

¡ Existing: Specify deployed NetOp Student module setup by the configuration files of an existing NetOp
Student installation.

Note: For Simplified and Advanced to work, NetOp Student must be installed on the deploying computer.

Click Next to continue to show one of these alternatives:

· If Simplified was clicked, the NetOp Student Setup wizard will run in front of a Create configuration files
window. Set up deployed NetOp Student modules in the Setup wizard. After ending the Setup wizard, in
the Create configuration files window click Next to continue.

· If Advanced was clicked, the NetOp Student Options window will be shown in front of a Create
configuration files window. Specify deployed NetOp Student module setup on the Options window tabs.
After closing the Options window, in the Create configuration files window click Next to continue.

· If Existing was clicked, a Windows Open window will be shown to enable you to open the User
configuration files of an existing NetOp Student installation. Open a set of User configuration files to
continue.

When done, this window will be shown:

Click Next to open the NetOp Pack'n Deploy window Deploy page and show this window:
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Click Finish to close the window ending the Deployment wizard.
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2.2.2 Deploy

Click the Deployment wizard Start NetOp Pack'n Deploy window Next button to show this window:

It is the Deploy page of the NetOp Pack'n Deploy deployment utility. It enables you to deploy configured
installation files to install fully set up Netop modules on remote computers. It contains these details:

· Source data path [][Browse]: This disabled field will show the path to the installation file specified in the
Deployment wizard Select Student installation source window. You cannot change this selection here.

Deploy to

· Domain []: Click in the drop-down box list an available domain to show its name in the field and after
browsing the names of its accessible computers in the Domain computers pane below. Unavailable

computer names will show a  icon. Available computer names will show a  icon. To select computers

to deploy to, click available computer names to show a  icon. Click ¤ All or ¡ Selected to show all or
only selected computer names in the pane. The two remaining options ¡ Success and ¡ Failed will be
available after deployment.

· Computer list [] [Save] [Browse]: To save a computer selection, click [Save] to save the selection in a text
file. To apply a saved computer selection, click [Browse] to select a text file to show its path in the field and

mark available computer names in the pane that belong to the selection with a  icon.

Credentials

· User name: Installing NetOp modules on remote computers will require administrator rights. Specify the
name by which the user that installs on remote computers shall be identified.
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· Password: Specify the password by which the user that installs on remote computers shall be identified.

Optional

· License key []: If the directory in which the installation file resides contains a license.dat file with a NetOp
Student license number, this license  number will be specified. The field must contain a valid NetOp
Student license number.

· Log path []: Deployment to each remote computer will on the deploying computer create a local log file
named <Remote computer name>.log and if successfully connected to the remote computer a remote log
file named <Remote computer name>.rlg. These plain text log files will tell what went wrong in a failed
deployment. You can specify the folder in which these log files shall be saved. .\log means a DeployLog
folder under the NetOp Teacher User configuration files folder.

· Restart []: Click one of the options Never, If needed or Always to make the remote computer do that after
installation.

· MSI parameters []: To apply selected Windows Installer parameters to installations on remote computers,
specify them in this field. To view available Windows Installer parameters, from a command prompt
specify msiexec. The special NetOp parameter DW_FORCE_LAUNCH=1 will force NetOp Student to load
after being deployed.

Deploy

To execute deployment, click Deploy.

Progress will be indicated by these icons replacing pane  icons:

: Deploying installation files to the remote computer.

: Remote computer access failed. Read the <Remote computer name>.log file contents to identify what
went wrong.

: Installing on the remote computer.

: Remote installation was successful.

: Remote installation failed. Read the <Remote computer name>.rlg file contents to identify what went
wrong.
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NetOp Teacher

3 NetOp Teacher
This section explains Teacher properties in these sections:

· Load and unload Teacher

· Teacher window

· NetOp screen image

· NetOp screen video

3.1 Load and Unload Teacher

To load the Teacher, click Start > All programs > NetOp School > Teacher or use one of the available
Loading alternatives.

If you load the Teacher for the first time, the Setup wizard will run in front of the Teacher window.

If you have loaded the Teacher before, the Teacher window will be shown.

To unload the Teacher, in the Teacher window click the window control Close button, click the matching
window control command or File menu Exit command or press ALT+F4.

3.1.1 Loading Alternatives

These Teacher loading alternatives are available:

1. In the directory where the Teacher was installed, typically C:\Program Files\Danware Data\NetOp
School\Teacher, double-click ntchw32.exe.

2. Create a desktop shortcut to the Teacher program file ntchw32.exe. Double-click this shortcut.

3. From a Windows Run or Command prompt window, execute the Teacher program file ntchw32.exe.

To load the Teacher from another application, use a command that you can expand with a switch that
specifies the Class that shall be running on the Teacher when loaded.

The command syntax is:

<Path>ntchw32 [/N:<Class name>]

If the Class name contains spaces, it must be enclosed within quotation marks.

Example

To load a default directory installed Teacher to run the Class Dr. Nelson, use this command:

C:\Program Files\Danware Data\NetOp School\Teacher\ntchw32 /N:"Dr. Nelson"
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3.1.2 Setup Wizard

When a specific user loads the Teacher for the first time or if in the Teacher window you click the Tools
menu Run setup wizard command, this window will be shown in front of the Teacher window:

The Setup wizard will guide you through initial Teacher setup.

Click Next to show this window:
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It enables you to specify the initial Class name and features selection in these elements:

Note: You can change all Setup wizard specifications from the Teacher window at any time.

Class name []: When the Teacher is newly installed, My class will be specified. You can edit the initial Class
name in the field.

Features: Click one of these options:

¡ Simplified - Demonstrate, Attention, Control, Policy: Will enable only the Demonstrate, Attention, Control
and Policy actions that for many Teacher users are the only ones ever used.

¤ Standard - full feature set: Will enable all available actions.

¡ Customized - your own selection: Will enable the Customize button below. Click it to show the Options
window Menu/Toolbar tab for your own selection of enabled actions.

Click Next to show this window:
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It enables you to select which name type shall identify Students in the Teacher window. Click one of these
options:

¤ Student login name: The name type selected on the Student Options window Student login tab.

¡ Windows login name: The Student computer user Windows login name.

¡ Computer name: The Student computer name.

Click Next to show this window:
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It selects a Communication profile and optionally specifies the use of NetOp name management in these
elements:

· Communication profile []: Click in the drop-down box the Communication profile by which the Teacher shall
communicate.

NetOp Name Server

o Use NetOp Name Server: Will be enabled if a Communication profile that uses the TCP/IP Communication
device is clicked in the Communication profile drop-down box above. Check the box to enable the use of
NetOp name management and the fields below.

· Primary []: Specify the primary NetOp Name Server address. 

· Secondary []: Specify the secondary NetOp Name Server address. 

· Name space ID []: Specify the Name space ID used by the Students with which you shall communicate.

Click Next to show this window:
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We recommend that you leave the default Yes, I want to register my NetOp license on-line selection unless
you or somebody else in your organization has already registered or will register the license.

Click Next to connect to register or show this window:

Click Finish to close the window to end the Setup wizard.
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3.2 Teacher Window

This is the Teacher window:

It contains these sections:

· Title bar

· Menu bar

· Toolbar

· Class control panel

· Status bar

3.2.1 Title Bar

This is the Teacher window title bar:

Click the left Teacher button or right-click anywhere in the title bar to show a standard window control menu.

Typically, the running Class name will be shown next to the NetOp Teacher window name. If Teacher profiles
are implemented, the Teacher profile User name of the user logged in to the Teacher will be shown instead
of the Class name.

3.2.2 Menu Bar

This is the Teacher window menu bar:

It contains these menus:
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· File

· Action

· Tools

· <Selected view>

· Help

3.2.2.1 File Menu

This is the Teacher window File menu:

It contains this command:

· Exit: Click this command, press ALT+F4, click the Title bar window control menu Close command, click
the Title bar Close button or double-click the left Title bar button to unload the Teacher closing the Teacher
window.

3.2.2.2 Action Menu

This is the Teacher window Action menu:

It can contain these commands that match Toolbar buttons:

· Demonstrate: Click to show selected contents on selected Student computer screens as explained in the
Demonstrate section.

· Attention: Click to cover selected Student computer screens with a selected image to get users' attention
as explained in the Attention section.

· Control: Click to execute a selected type of control with selected Student computers as explained in the
Control section.

· Communicate: Expands into these commands:

· Audio-video chat: Click to start an Audio-video chat session with selected Student computer users as
explained in the Audio-video chat section.

· Chat: Click to start a Chat session with selected Student computer users as explained in the Chat
section.

· Send message: Click to send a NetOp message to selected Student computer users as explained in the
Send message section.

· Workgroup: Click to create a Workgroup from selected Students as explained in the Workgroup section.
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· Run test: ???Click to run a selected test on selected Student computers as explained in the Run test
section.

· Run program: ???Click to run a selected program on selected Student computers as explained in the Run
section.

· Commands: Expands into these commands:

· Log off: Click to log off users from Windows on selected Student computers.

· Restart: Click to restart selected Student computers.

· Shut down: Click to shut down selected Student computers.

· Rejoin: Click to make selected Student Leave class and Join class.

· Files: Expands into these commands:

· Distribute files: Click to distribute selected files to selected Student computers as explained in the
Distribute files section.

· Collect files: Click to collect selected files from selected Student computers as explained in the Collect
files section.

· File Manager: Click to manage and exchange files with selected Student computers as explained in the
File manager section.

· Policy: Click to apply a selected Policy to selected Student computers as explained in the Policy section.

· Record: Click to start recording a Teacher computer screen movie as explained in the Record section.

3.2.2.3 Tools Menu

This is the Teacher window Tools menu:

It contains these commands:

· Options: Click to show the Options window.

· Options as icons: Will be included if the Options window tabs version is enabled. Click to enable the
Options window icons version.

· Protection password: Click to show the Options window Protection tab.

· Log off: Will be included if Teacher profiles are implemented. Click to log off from the Teacher.

· Ask class server: Will be enabled if the Options window Class tab Use class server box is checked. Click
to ask Class server for the current or upcoming Class.

· Reannounce class: Will be enabled if the Options window Class tab Use class server box is unchecked.
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Click to send an Announcement of the running Class.

· Run student deployment: Click to run the Deployment wizard to install and set up NetOp Student on
remote computers.

· Check for new updates: Click to check for updates to the current Teacher installation according to the
Options window Web update tab.

· Publish new updates: Click to show a Windows Browse for folder window to select a folder to upload
downloaded Web update installation files to it.

· Run setup wizard: Click to run the Teacher Setup wizard.

· Copy teacher to removable media: Click to show a Windows Browse for folder window to select a
removable media folder, e.g. a USB key folder, to copy your entire Teacher installation to it to take it to
another computer or keep it as backup.

· Import teacher data: Click to show this window:

It enables you to import Teacher data from removable media to your computer. Check the categories of
Teacher data that you want to import and click OK to show the Browse for folder window to select the
removable media folder from which to import Teacher data. Imported files will overwrite resident files with
the same name.

· Debug trace: To include this command, press ALT+Z while showing the About NetOp School Teacher
window. Click to save a log of recent Teacher communication, which will assist NetOp professionals in
diagnosing communication problems. The debug trace is a plain text file. Interpreting its contents requires
special NetOp skills.
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3.2.2.4 Selected View Menu

This menu will be named by the Teacher window Class control panel selected view and will contain
commands that execute actions in the selected view:

The Details view menu shown above matches the Details view Student context menu. 

Similarly, other selected view menus will contain the same commands as the view's context menus. 

Menu contents will be explained in the respective view sections.

3.2.2.5 Help Menu

This is the Teacher window Help menu:

It contains these commands:

· Contents: Click to open the NetOp Teacher Help window that has a graphical table of contents in its left
pane.

· Online support: Click to open the Support for NetOp School web page to request technical support.

· Apply license/Online registration: Will be Apply license if a trial version is installed and Online registration if
a licensed version is installed.

· Apply license: Click to show this window:
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Specify your licensee name and your Teacher license number and click OK to replace the trial version
licensee name and license number by the specified licensee name and license number.

· Online registration: Click to open the NetOp product registration web page to register your license with
the NetOp manufacturer.

· About: Click to show this window:

It contains information on your Teacher installation. The build number in format YYYYDDD (Y=year
number digit, D=day number digit) is enclosed in parentheses next to the version number.

· System info: Click to show the System info window.

3.2.3 Toolbar

This is the Teacher window toolbar:

It contains buttons by which the Teacher user can execute actions, typically on selected Students. The full
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range includes these buttons:

· Demonstrate

· Attention

· Control

· Communicate

· Workgroup

· Run

· Commands

· Files

· Policy

· Record

Right-click in the tool bar to show this menu:

It contains these commands:

Show text labels: Click to hide or show button text labels hiding or showing the command check mark.

Customize: Click to show the Windows Customize toolbar window to customize the toolbar appearance.

Selection: Expands into these commands:

Select All: Click to select all connected Students in the Class control panel.

Deselect All: Click to deselect all Students in the Class control panel.

<Student groups>: Click a Student group to select connected Students in the selected Student group.
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3.2.3.1 Demonstrate

This is the Teacher window Toolbar Demonstrate button and menu:

Demonstrate enables showing selected contents on selected Student computers.

To start a Demonstrate session, select Students and click the Action menu Demonstrate command or click
the Demonstrate button for the default session or click a Demonstrate menu command for a custom session.

The Demonstrate menu that will open from the Demonstrate button down pointer button or from the Student
group context menu Demo to this group command contains these commands:

· Entire desktop 

· Selected desktop area 

· Media file 

· Media file on the web 

· Recording 

· Specific monitor 

· Student desktop 

· Options 

The default session command that is selected in the Demonstrate menu Options command Demonstrate
window Default button action drop-down box will be enclosed by asterisks.

Note: You can demonstrate running a program on the Teacher computer from a Toolbar Run button menu
program command Demo command.

During a Demonstrate session, Details view participating Student records will show this icon in the Status
column:

Classroom view and Class setup view participating Student icons will show a green check mark.

During a Demonstrate session, the Demonstrate button will appear pressed in and the Action menu
Demonstrate command will be check marked.

Click the pressed in Demonstrate button or check marked Demonstrate command to end the Demonstrate
session.

You can specify general Demonstrate properties on the Tools menu Options command/window Demonstrate
tab. 



40

NetOp Teacher

3.2.3.1.1  Entire Desktop

To Demonstrate the Teacher computer entire desktop, select Students and click this Demonstrate menu
command:

This will show the Teacher computer entire desktop or a scrolling section of it on selected Student computer
screens.

Note: If the Teacher computer uses multiple monitors, its entire desktop can spread across multiple
monitors.

You can control a screen area Demonstrate session from this Teacher computer screen toolbox:

 

It is explained in the Screen control toolbox section.

You can enable this toolbox on the screen of Student computers that receive a screen image demonstration:

It is explained in the Student demo toolbox section.

Screen Control Toolbox

On the Teacher computer, you can control a screen area Demonstrate session from this Screen control
toolbox:

Its title bar will show the Screen control name and <Teacher> if a Teacher screen is being demonstrated,
otherwise the name of the demonstrated screen Student. Click the left square button to make the toolbox the
active window. Click the right down pointer button to minimize the toolbox to the Windows taskbar notification
area.

It contains these tool tip identified buttons:

End session: Click this button to close the toolbox and end the Demonstrate session.

Teacher full screen/window: Will be enabled if a Student screen is demonstrated. Click to switch
between showing the Student screen in full screen mode or window mode on the Teacher. The startup
mode is specified in the Options window Demonstrate tab On teacher during student demo section. 

Start/stop sound transfer: Click to start or stop the transfer of microphone input and running application
sound from the computer being demonstrated to the computers that receive the demonstration. Sound
transfer and Audio-video chat cannot run at the same time.

Note: Sound transfer will typically work smoothly with new computers with integrated sound devices.
On older computers with older sound devices and older operating systems, if Sound transfer does not
work, look into recording sound mix setup. NetOp expects to find the recording sound mix name Wave
Out Mix. If only other recording sound mix names are available, add this section to the NetOp.ini file:

[AUDIO]

Sound_Mix=<Recording sound mix name>

If the computer sound device does not support recording sound mix, Sound transfer will not work.
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Start/stop audio-video chat: Click to start or stop an Audio-video chat session with the Students that
take part in the Demonstrate session. Audio-video chat and Sound transfer cannot run at the same
time.

Start/stop NetOp marker utility: Click to start or stop NetOp marker utility to create markers or magnify
an area on the demonstrated screen.

Student full screen/window: Click to switch between showing the demonstrated screen in full screen
mode or window mode on Students that receive demonstration. The startup mode is specified in the
Options window Demonstrate tab On receiving students section. 

Pass the chalk: Click to assign keyboard and mouse control in the demonstrated screen to a selected
Student. This functionality is explained in the Pass the chalk section.

Student Demo Toolbox

Check the Teacher Options window Demonstrate tab Launch toolbox box to show on the screen of Student
computers that receive a demonstration this Student demo toolbox:

Its title bar will show the Student computer name. Click the left square button to make the toolbox the active
window.

It contains these tool tip identified buttons (from left to right):

Request the microphone: Will be enabled if an Audio-video chat session is running during a
Demonstrate session. Click to request the microphone to make the button appear pressed in and
show the request in the Audio-video chat window. Click the pressed in button to withdraw the
microphone request and release the button. When a microphone request has been met, the pressed
in button will be released.

Request help: Click to Request help from the Teacher user to make the button appear pressed in.
Click the pressed in button to withdraw the help request and release the button. When a help request
has been met, the pressed in button will be released.

Request the chalk: Click to request keyboard and mouse control in the demonstrated screen to make
the button appear pressed in. Click the pressed in button to withdraw the chalk request and release
the button. When a chalk request has been met, the pressed in button will be released.
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NetOp Marker Utility

NetOp marker utility enables you to create figure and text markers on top of a screen image and magnifying
a section of a screen image.

You can load and unload NetOp marker utility on the Teacher computer from a Demonstrate Entire desktop,
Selected desktop area or Specific monitor session Screen control toolbox or Record session Recording
toolbox Start/stop NetOp marker utility button.

You can load and unload NetOp marker utility on a Student computer from a Demonstrate Student desktop
session Screen control toolbox Start/stop NetOp marker utility button or Remote control session NetOp
marker utility button or command. 

Note: The NetOp marker utility program vitawrap.exe will run on the local Teacher or Student computer.

NetOp marker utility will show this window:

It contains these elements:

· Title bar

· Upper toolbar

· Lower toolbar

· Status bar

Title Bar

This is the NetOp marker utility window title bar:

Click the title bar icon or right-click in the title bar to show this menu:
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The top section contains window control commands. The other sections contain these types of NetOp marker
utility commands:

· Figure marker commands, see Figure markers

· Text command, see Text marker

· Magnifier command, see NetOp magnifier

· Undo and Clear all commands, see Delete markers

· Properties and Help commands, see Marker properties and help

Click Minimize to minimize the NetOp marker utility window into this Windows taskbar notification area
button:

Behind the pencil, the most recently enabled marker tool symbol will be shown.

Right-click to show this menu:
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It contains a Restore command that will restore the NetOp marker utility window and the same NetOp marker
utility commands as the NetOp marker utility title bar menu.

Upper Toolbar

This is the NetOp marker utility window upper toolbar:

It contains these buttons:

Draw Ellipse: Click to appear pressed in or click the NetOp marker utility title bar menu or NetOp
marker utility button menu Ellipse command to enable the ellipse tool, see Figure markers.

Draw Rectangle: Click to appear pressed in or click the NetOp marker utility title bar menu or NetOp
marker utility button menu Rectangle command to enable the rectangle tool, see Figure markers.

Draw Arrow: Click to appear pressed in or click the NetOp marker utility title bar menu or NetOp marker
utility button menu Arrow command to enable the arrow tool, see Figure markers.

Draw Lines (Stop=MB2): Click to appear pressed in or click the NetOp marker utility title bar menu or
NetOp marker utility button menu Line command to enable the sectioned line tool, see Figure markers.

Draw Freehand: Click to appear pressed in or click the NetOp marker utility title bar menu or NetOp
marker utility button menu Freehand command to enable the freehand tool, see Figure markers.

Show Free Text: Click to appear pressed in or click the NetOp marker utility title bar menu or NetOp
marker utility button menu Text command to enable the Text marker tool.

Show Magnifier: Click to appear pressed in or click the NetOp marker utility title bar menu or NetOp
marker utility button menu Magnifier command to show the NetOp magnifier window.

Undo: Click or click the matching NetOp marker utility title bar menu or NetOp marker utility button
menu command to delete the most recently selected marker, see Delete markers.

Clear All: Click or click the matching NetOp marker utility title bar menu or NetOp marker utility button
menu command to delete all markers, see Delete markers.
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Lower Toolbar

This is the NetOp marker utility window lower toolbar:

It contains these buttons:

Select Font: Click or click the NetOp marker utility title bar menu or NetOp marker utility button menu
Font command to show the Windows Font window to select a Text marker font, see Marker
properties and help.

Select Color: Click or click the NetOp marker utility title bar menu or NetOp marker utility button menu
Color command to show the Windows Color window to select a Figure marker color, see Marker
properties and help.

Select Pen Thickness: Click to show a line width drop-down box or click the NetOp marker utility title
bar menu or NetOp marker utility button menu Line Width command to select a Figure marker or Text
marker frame line width, see Marker properties and help.

Help: Click or click the NetOp marker utility title bar menu or NetOp marker utility button menu Help
command to open the local help system on the NetOp marker utility section, see Marker properties
and help.

Status Bar

This is the NetOp marker utility window status bar:

It will show a hint to the mouse pointer position button or highlighted menu command.

Figure Markers

To select a figure marker tool with the mouse, click the Upper toolbar figure marker button to make it appear
pressed in or click the NetOp marker utility title bar menu or NetOp marker utility button menu figure marker
command to change the mouse pointer into a pencil with the figure marker shape.

To enable a figure marker tool from the keyboard, place the mouse pointer on the active NetOp marker utility
window Upper toolbar figure marker button and press F9 to change the mouse pointer into a pencil with the
figure marker shape. Alternatively, while the NetOp marker utility window is active press ALT+SPACE to
show the NetOp marker utility title bar menu and press the figure marker command first character keyboard
key or highlight the figure marker command and press ENTER.

To create a figure marker with the mouse, drag (sectioned line: click). To end a sectioned line, right-click.

To draw a figure marker from the keyboard, move the figure marker with the arrow keys. Press INSERT to
engage, move with the arrow keys and press INSERT to disengage or section a line. To end a sectioned line,
press F10.

To move a marker or change its appearance, move the mouse pointer to it to show an arrow-pointed +.

To move, drag or press INSERT to engage, move with the arrow keys and press INSERT to disengage.

To change appearance, right-click or press F10 to show this menu:
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Color: Click or click the marker and click the Lower toolbar Select color button to show the Windows Color
window to change the marker color selection (default: Red).

Line Width: Click to expand into a selection of numbers of pixels or click the marker and click the Lower
toolbar Select pen thickness button to show a drop-down box with a selection of line widths to change the
marker line width selection.

Undo: Click click the marker and click the Upper toolbar Undo button to delete the selected marker.

Clear All: Click or click the marker and click the Upper toolbar Clear All button to to delete all markers.

Click outside the menu or press F10 to close the menu.

To change figure marker tool properties, right-click or press F10 to show this menu:

This menu is similar to the Figure marker menu but has Unselect instead of Undo.

Unselect: Click, press ESCAPE, click the Upper toolbar pressed in figure marker button to release it or click
the NetOp marker utility title bar menu or NetOp marker utility button menu figure marker command to
unselect the figure marker tool to restore the normal mouse pointer.

Note: Selecting another marker tool will unselect the selected marker tool.

Text Marker

To select the text marker tool with the mouse, click the Upper toolbar the Show free text button to make it
appear pressed in or click the NetOp marker utility title bar menu or NetOp marker utility button menu Text
command to change the mouse pointer into an angle that indicates a text marker box corner.

To select the text marker tool from the keyboard, place the mouse pointer on the active NetOp marker utility
window Upper toolbar Show free text button and press F9 to make the button appear pressed in and change
the mouse pointer into an angle that indicates a text marker box corner. Alternatively, while the NetOp
marker utility window is active press ALT+SPACE to show the NetOp marker utility title bar menu and press
the T key or highlight the Text command and press ENTER.

To unselect the text marker tool, press ESCAPE or use one of the selection procedures explained above to
release the Show free text button and restore the normal mouse pointer.

Note: Selecting another marker tool will unselect the selected marker tool.

When the text marker tool is selected:

· To create a text marker with the mouse, drag a dotted rectangle to show the Text marker window.
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· To create a text marker from the keyboard, move the text marker tool with the arrow keys. Press INSERT
to engage, move with the arrow keys to create a dotted rectangle and press INSERT to disengage to show
this window:

This window specifies the text marker contents and appearance.

In the pane, specify the text marker text. Right-click to show an edit menu.

Use frame: []: The field of this drop-down box will by default show No to show no frame around the text
marker. The drop-down box list contains No and a selection of frame line widths. Select an option in the list
to show it in the field.

Font: Click to show the Windows Font window to change the text marker font and color selection.

OK: Click to close the Text marker window to show the text marker.

To move a marker or change its appearance, move the mouse pointer to it to show an arrow-pointed +.

To move, drag or press INSERT to engage, move with the arrow keys and press INSERT to disengage.

To change appearance, right-click or press F10 to show this menu:

 

This menu is similar to the Figure marker menu but has Font instead of Color.

Font: Click to show the Windows Font window to change the text marker font and color selection.

Note: This menu will include a Line width command only if a framed text marker is selected.
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NetOp Magnifier

To show the NetOp magnifier window with the mouse, click the Upper toolbar Show magnifier button to make
it appear pressed in or click the NetOp marker utility title bar menu or NetOp marker utility button menu
Magnifier command.

To show the NetOp magnifier window from the keyboard, place the mouse pointer on the active NetOp
marker utility window Upper toolbar Show magnifier button and press F9 to make the button appear pressed
in. Alternatively, while the NetOp marker utility window is active press ALT+SPACE to show the NetOp
marker utility title bar menu and press M or highlight the Magnifier command and press ENTER.

If the mouse pointer is outside this window, the window pane will show a magnified image of the mouse
pointer surroundings.

To move the window, drag its title bar or place the mouse pointer in the title bar, press INSERT to engage,
move with the arrow keys and press INSERT to disengage.

To resize the window, drag its sides or corners or position the mouse pointer on a side or corner to show a
double arrow, press INSERT to engage, move with the arrow keys and press INSERT to disengage.

To change the pane image magnification, drag the right side scroll bar button or place the mouse pointer
above or below it and press F9. Its top position will show a 1:1 scale image.

Right-click in the window or place the mouse pointer in the window and press F10 to show this menu:

Close: Click or click the NetOp marker utility window Upper toolbar Show magnifier button appearing pressed
in to release it to close the NetOp magnifier window.

Copy Ctrl+C: Click or press CTRL+C to copy the pane contents to the clipboard.

Refresh F5: The pane image will refresh when the mouse pointer is moved but by default not refresh if the
mouse pointer is not moved. Click or press F5 to refresh the pane image.

Refresh rate: Click to show this window:
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¨ Enable refresh timer: Check to refresh the pane image if the mouse pointer is not moved.

Interval (tenths of seconds): []: Specify a number to refresh at the specified interval.

Delete Markers

To delete markers, click one of these Upper toolbar buttons or click the matching NetOp marker utility title
bar menu or NetOp marker utility button menu command:

Undo: Delete the most recently selected marker.

Clear All: Delete all markers.

Note: When NetOp marker utility is unloaded, all markers and any NetOp magnifier window will disappear.

Marker Properties and Help

Specify marker properties and show help from the Lower toolbar buttons or matching NetOp marker utility
title bar menu or NetOp marker utility button menu commands:

(Select) Font: Click this button or click this command to show the Windows Font window to select a Text
marker font and color.

(Select) Color: Click this button or click this command to show the Windows Color window to select a Figure
marker color.

Select pen thickness/Line width: Click this button to show a line width drop-down box or click this command
to expand it into a selection of numbers of pixels to select a Figure marker or Text marker frame line width.

Help: Click this button or click this command to open the local help system on the NetOp marker utility topic.

Pass the Chalk

This is the Demonstrate Screen control toolbox Pass the chalk button:

It enables the Teacher user to pass the chalk, i.e. assign keyboard and mouse control of a demonstrated
screen, to a Student user, pass the chalk on to another Student user and take it back.

If the Student demo toolbox is shown on Students that receive a demonstration, Student users can click the
Request the chalk button to request the chalk. In the Teacher Demonstrate Screen control toolbox, the Pass
the chalk button will get a raised hand like the Request the chalk button if any chalk request is pending:

Click the Pass the chalk button to show a list of the Students that receive the demonstration. Students with a
check mark have requested the chalk. Select any shown Student to pass the chalk to the selected Student
closing the list. Click outside the list to close it without passing the chalk.

While a Student has the chalk, the Pass the chalk button will appear pressed in. The Student user with the
chalk and the Teacher user both have keyboard and mouse control in the demonstrated screen. If a Student
desktop is demonstrated, also the demonstrated Student user has keyboard and mouse control in the
demonstrated screen.

Two, possibly three, users moving the Teacher mouse pointer at the same time can make it difficult for the
Teacher user to execute desired mouse actions. The Teacher user can suppress Student keyboard and
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mouse input to the Teacher screen by holding down the CTRL key to execute desired mouse actions
undisturbed.

Note: Any keyboard or mouse action by the Student user with the chalk while the Teacher user holds down
the CTRL key will  return the chalk to the Teacher and release the Pass the chalk button.

Click the pressed in Pass the chalk button to show the list of Students that receive a demonstration. The
Student with the chalk will be marked with asterisks. Click the asterisk-marked Student to take the chalk
back and close the list. Click another Student to pass the chalk to the selected Student and close the list.
Click outside the list to leave the chalk where it is and close the list.

3.2.3.1.2  Selected Desktop Area

To Demonstrate a Teacher computer Selected desktop area, specify it in this Demonstrate window section:

Click Area to show a red frame window on your desktop. Drag its title bar and sides to enclose the area you
want to demonstrate and click OK to apply. 

Select Students and click this Demonstrate menu command:

This will show the Teacher computer Selected desktop area or a scrolling section of it on selected Student
computer screens.

You can control a screen area Demonstrate session from this Teacher computer screen toolbox:

 

It is explained in the Screen control toolbox section.

You can enable this toolbox on the screen of Student computers that receive a screen area demonstration:

It is explained in the Student demo toolbox section.

3.2.3.1.3  Media File

To Demonstrate a Media file, specify its path in this Demonstrate window section:

Click Browse to select an avi, mpg, mpeg or wmv Media file to specify its path in the drop-down box field. The
drop-down box list will contain the paths of previously specified Media files.

Select Students and in the Demonstrate menu click Media file to expand into the names of Media files
specified in the Demonstrate options window Media file section:

Click a Media file name to Prepare media file. When ready, the Teacher user can Play media file.
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Prepare Media File

When a Media file Demonstrate session is started, it will first be checked that the specified Media file is
available on the  Teachercomputer. If not, the session will end with an error message.

Then, the Teacher will request selected Students to prepare for running the specified Media file showing this
window:

Its pane will show selected Student records with a status message.

If Students report that the Media file is unavailable, the Teacher will attempt to distribute it to them. 

If all selected Students become ready to run the Media file, the window will close.

If some selected Students cannot become ready to run the Media file, the window will remain. You will have
these options:

· Continue: Click to close the window to play the Media file only on the Teacher and Students that are ready.

· Cancel: Click to close the window to cancel the Media file Demonstrate session.
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Play Media File

When in a Media file Demonstrate session the Teacher and selected Students are ready, the Teacher
computer screen will show this media player:

The media pane size will depend on the Media file. The media window title bar will show elapsed and in
parentheses total playing time in the format HH:MM:SS. The media pane may or may not show an initial
and/or final image. Depending on the Teacher Options window Demonstrate tab settings, selected Student
computer screens will show the media pane in a window or in full screen display with a black background. 

You can control the Media file Demonstrate session from the Media player control toolbox. Click its title bar
square button to make the toolbox the active window. It contains these buttons:

End session: Click to end the Demonstrate session to close the Teacher media player and selected
Students' media pane display.

Play: Click to appear pressed in to play the media on the Teacher and selected Students. Click Pause
to pause playing to resume or click Stop to end playing.

Pause: Click to appear pressed in to pause playing the media freezing the image and synchronizing
Student media playing with Teacher media playing. Click Play to resume playing.

Stop: Click to appear pressed in to stop playing the media freezing the image. Click Play to play the
media from the start.

Fast backward: Click to jump ten seconds back in the media, if playing or not.

Fast forward: Click to jump ten seconds forward in the media, if playing or not.

Zoom: Click to show 50, 100, 200 and Maximized. Click one to zoom the media pane by the selected
percentage or maximize the media pane.

Play list: Click to show the ten most recently specified or demonstrated media files or web media. Click
one to replace the currently selected media.
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3.2.3.1.4  Media File on the Web

To Demonstrate a media file that is available on the Internet, specify the media file URL in this Demonstrate
window section:

The drop-down box list will contain the URLs of previously specified Media files on the web.

Select Students and in the Demonstrate menu click Media file on the web to expand into the names of Media
files on the web specified in the Demonstrate options window Media file on the web section:

Click a Media file on the web name to Prepare media file. When ready, the Teacher user can Play media file.

3.2.3.1.5  Recording

To Demonstrate a Teacher computer desktop Recording, specify its file path in this Demonstrate window
section:

Click Browse to select a NetOp Recording dwr file to specify its path in the drop-down box field. The
drop-down box list will contain the paths of previously specified dwr files.

Select Students and in the Demonstrate menu click Recording to expand into the names of recording files
specified in the Demonstrate options window Recording section:

Click a Recording file name to play the recording in the Teacher computer screen Recording playback
window while demonstrating the Teacher computer Entire desktop to selected Students.

You can control a screen area Demonstrate session from this Teacher computer screen toolbox:

 

It is explained in the Screen control toolbox section.

You can enable this toolbox on the screen of Student computers that receive a screen area demonstration:

It is explained in the Student demo toolbox section.

3.2.3.1.6  Specific Monitor

To Demonstrate a Specific monitor of a Teacher computer that uses multiple monitors, select it in this
Demonstrate window section:
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Click a monitor in the drop-down box list to show it in the field as selected.

Select Students and click this Demonstrate menu command:

This will show the Teacher computer specific monitor screen area or a scrolling section of it on selected
Student computer screens.

You can control a screen area Demonstrate session from this Teacher computer screen toolbox:

 

It is explained in the Screen control toolbox section.

You can enable this toolbox on the screen of Student computers that receive a screen area demonstration:

It is explained in the Student demo toolbox section.

3.2.3.1.7  Student Desktop

To Demonstrate a Student computer desktop, select the Student whose desktop shall be demonstrated and
the Students to whom it shall be demonstrated and in the Demonstrate menu click Student desktop to
expand into a list of the names of selected Students:

One name may be enclosed by asterisks. That is the Student name selected in the Demonstrate window
Student desktop section for a default Student desktop Demonstrate session:

Click in the list any Student name to demonstrate the desktop of this Student computer to the other Students
in the list. In fact, the Teacher will be running a Remote control session with the selected Student while
running an Entire desktop Demonstrate session with the other Students in the list.

You can also start a Student desktop Demonstrate session from the Student context menu Demo this
student command.

You can control a screen area Demonstrate session from this Teacher computer screen toolbox:

 

It is explained in the Screen control toolbox section.

You can enable this toolbox on the screen of Student computers that receive a screen area demonstration:

It is explained in the Student demo toolbox section.
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3.2.3.1.8  Options

Click the Demonstrate menu Options command or click the Tools menu Options command/window
Demonstrate tab Default settings button to show this window:

It contains these sections:

· Default button action: The drop-down box list contains the names of available Demonstrate session types.
Click one to show it in the field to start this type of session when clicking the Demonstrate button.

Teacher

· Selected desktop area: Specifies a selected desktop area as explained in the Selected desktop area
section.

· Media file: Specifies a media file as explained in the Media file section.

· Media file on the web: Specifies a media file on the web as explained in the Media file on the web section.

· Recording: Specifies a recording as explained in the Recording section.

· Specific monitor: Specifies a specific monitor as explained in the Specific monitor section.

Student

· Student desktop: Specifies a Student computer desktop as explained in the Student desktop section.
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3.2.3.2 Attention

This is the Teacher window Toolbar Attention button and menu:

Attention will cover selected Student computer screens to call Student user attention.

To apply Attention, select Students and click the Action menu Attention command or click the Attention
button for the default Attention mode or click an Attention menu command for a custom Attention mode.

You can also apply default mode Attention from the Student context menu Apply attention on this student
command and the Student group context menu Apply attention on this group command.

The Attention menu that will open from the Attention button down pointer button contains these commands:

· Bitmap: Expands into the names of previously selected bitmap images and Browse. Click a bitmap image
name to apply Attention showing it. Click Browse to open a bitmap image file to apply Attention showing its
image. 

· Text: Click to apply Attention showing a text specified on the Tools menu Options command/window
Attention tab. 

· Text file: Expands into the names of previously selected text files and Browse. Click a text file name to
apply Attention showing its contents. Click Browse to open a text file to apply Attention showing its
contents. 

· Web: Click to apply Attention showing a web page specified on the Tools menu Options command/window
Attention tab. 

· Options: Click to show the Tools menu Options command/window Attention tab.

The default Attention mode that is selected in the Options window Attention tab Show attention section will be
enclosed by asterisks.

While Attention is applied, Details view participating Student records will show this icon in the Status column:

Classroom view and Class setup view participating Student icons will show a green check mark.

While Attention is applied, the Attention button will appear pressed in and the Action menu Attention
command will be check marked. Click the pressed in Attention button or check marked Attention command
to lift Attention.

You can specify general Attention properties on the Options window Attention tab.
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3.2.3.3 Control

This is the Teacher window Toolbar Control button and menu:

Control enables Remote control or Monitoring of selected Students.

To start a Control session, select Students and click the Action menu Control command or click the Control
button for the default Control mode or click a Control menu command for a custom Control mode.

You can also start a Remote control session from the Student context menu Remote control this student
command and start a Monitor session from the Student context menu Monitor this student command or
Student group context menu Monitor this group command.

The Control menu that will open from the Control button down pointer button contains these commands:

· Remote control: Click to start a Remote control session with a selected Student as explained in the
Remote control section. 

· Monitor students: Click to start a Monitor session with selected Students as explained in the Monitor
section. 

· Options: Click to show the Tools menu Options command/window Control tab.

The default Attention mode that is selected in the Options window Control tab Default control button section
will be enclosed by asterisks.

During a Remote control session, a Details view participating Student record will show this icon in the Status
column:

During a Monitor session, a Details view participating Student record will show this icon in the Status column:

Classroom view and Class setup view participating Student icons will show a green check mark.

During a Control session, the Control button will appear pressed in and the Action menu Control command
will be check marked. Click the pressed in Control button or check marked Control command to end the
Control session.

You can specify general Control properties on the Options window Control tab.
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3.2.3.3.1  Remote Control

To start a Remote control session with a selected Student, click the Control menu Remote control command,
or if Remote control is the default Control mode click the Control button.

If multiple Students are selected, this window will be shown:

Click in the drop-down box list which Student to Remote control.

You can also start a Remote control session from the Student context menu Remote control this student
command or by double-clicking a Student record or icon (not in Class setup view).

Note: Remote control is a one-to-one session between the Teacher and one Student. The Teacher can start
up to ten Remote control sessions one at a time and run them in parallel.

The Teacher computer screen will show the Student computer screen image, typically in a window:
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Remote control functionalities are explained in the Remote control window section.

Remote Control Window

This is the Remote control window:

It contains these elements:

· Title bar

· Toolbar

· Pane 

· Status bar

Title Bar

This is the Remote control window title bar:

 

Click its left end Remote control icon or right-click anywhere in it to show this menu:
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Its upper section contains window control commands. Its lower section contains Remote control commands,
some of which are duplicated by toolbar buttons:

· Send keystrokes: Expands into these commands:

Note: Sending the following keystroke combinations from the keyboard can have undesirable effects.
Therefore, they should always be sent from this menu or matching toolbar buttons.

· Send Ctrl+Esc: Click or click the matching Toolbar or toolbox button to send the keystroke combination
CTRL+ESC to the Student, typically to show the Student computer Start menu.

· Send Ctrl+Alt+Del: Click or click the matching Toolbar or toolbox button to send the keystroke
combination CTRL+ALT+DEL to the Student, typically to provide program shutdown options. 

Note: This command will be disabled if you are remote controlling a Student on a Windows 95 classic
computer.

· Send Alt+Tab: Click to send the keystroke combination ALT+TAB to the Student, typically to shift the
Student computer screen active window clockwise.

· Send Alt+Shift+Tab: Click to send the keystroke combination ALT+SHIFT+TAB to theStudent, typically to
shift the  Studentcomputer screen active window counterclockwise.

· Send Print screen: Click to send a PRINT SCREEN command to the Student to place an image of the
Student computer screen on the Student computer clipboard.

· Send Alt+Print screen: Click to send an ALT+PRINT SCREEN command to the Student to place an
image of the Student computer active window on the Student computer clipboard.

· Clipboard: Expands into these commands:

· Clipboard to student: Click or click the matching Toolbar or toolbox button to send the Teacher computer
clipboard contents to the Student computer clipboard.

· Clipboard from student: Click or click the matching Toolbar or toolbox button to retrieve the Student
computer clipboard contents to the Teacher computer clipboard.

· Print screen to clipboard: Click or click the matching Toolbar or toolbox button to take a snapshot of the
Student computer screen and place it on the Teacher computer clipboard.

· Print screen to file: Click or click the matching Toolbar or toolbox button to take a snapshot of the
Student computer screen and save it as a Teacher computer file.
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Note: When you use this functionality for the first time, a NetOp SnapShot folder will be created on your
computer desktop to contain snapshot files. You can change the snapshot files folder in the Options
window Sharing tab Snapshots element.

· Session properties: Click or click the matching Toolbar or toolbox button to show the Session properties
window.

· Full screen: Click or click the matching Toolbar or toolbox button or press the zoom hot key (default: CTRL
+Z) to show the Student screen image in full screen mode.

· NetOp marker utility: Click or click the matching Toolbar or toolbox button to load NetOp marker utility on
the Student computer and check mark the command. Click the check marked command to unload NetOp
marker utility.

· Mouse marker: Click to show a mouse marker arrow when clicking in the Student screen image (click
functionality disabled) and check mark the command. Click the check marked command to disable. 

· Restart student PC: Click or click the matching Toolbar or toolbox button to restart the Student computer
after a warning message. 

· Lock keyboard and mouse: Click or click the matching Toolbar or toolbox button to disable the Student
computer keyboard and mouse and check mark the command. Click the check marked command to
enable the Student computer keyboard and mouse.

· Transfer sound: Click or click the matching Toolbar or toolbox button to transfer Student computer
microphone input and running application sound and check mark the command. Click the check marked
command to not transfer Student computer microphone input and running application sound.

Note: Transfer sound will typically work smoothly with new computers with integrated sound devices. On
older computers with older sound devices and older operating systems, if Transfer sound does not work,
look into recording sound mix setup. NetOp expects to find the recording sound mix name Wave Out Mix.
If only other recording sound mix names are available, add this section to the NetOp.ini file:

[AUDIO]

Sound_Mix=<Recording sound mix name>

If the computer sound device does not support recording sound mix, Transfer sound will not work.

· Record: Click or click the matching Toolbar or toolbox button to start recording the Teacher desktop
showing the Recording toolbox. Control and stop recording in the Recording toolbox.

· Refresh: Click to refresh the Student screen image.

Toolbar or Toolbox

This is the Remote control window toolbar:

 

You can drag it by its left end to a horizontal or vertical position along a window edge or floating inside or
outside the window. This is the Remote control full screen toolbox:
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They contain the same tool tip identified buttons by which you can execute Remote control actions:

End session: Click or use Remote control window Title bar Close controls to close the Remote control
window/full screen display to end the Remote control session.

Session properties: Click or click the matching Title bar menu command to show the Session
properties window.

Full screen/window: Click, click the matching Title bar menu command or press the zoom hot key
(default: CTRL+Z) to switch between full screen and window display mode.

Send Ctrl+Esc: Click or click the matching Title bar menu command to send the keystroke
combination CTRL+ESC to the Student to typically show the Windows Start menu. 

Send Ctrl+Alt+Del: Click or click the matching Title bar menu command to send the keystroke
combination CTRL+ALT+DEL to the Student to typically provide program shutdown options.

Note: This button will be disabled if a Student running on a Windows 95 classic computer is remote
controlled.

Restart student computer: Click or click the matching Title bar menu command to restart the Student
computer after a warning message.

Clipboard to student: Click or click the matching Title bar menu command to send the Teacher
computer clipboard contents to the Student computer clipboard.

Clipboard from student: Click or click the matching Title bar menu command to retrieve the Student
computer clipboard contents to the Teacher computer clipboard.

Print screen to clipboard: Click or click the matching Title bar menu command to take a snapshot of
the Student computer screen and place it on the Teacher computer clipboard.

Print screen to file: Click or click the matching Title bar menu command to take a snapshot of the
Student computer screen and save it as a Teacher computer file.

Note: When you use this functionality for the first time, a NetOp SnapShot folder will be created on
your computer desktop to contain snapshot files. You can change the snapshot files folder in the 
Options window Sharing tab Snapshots element.

NetOp marker utility: Click or click the matching Title bar menu command to load NetOp marker utility
on the Student computer and make the button appear pressed in. Click the pressed in button to
unload NetOp marker utility.

Lock keyboard and mouse: Click or click the matching Title bar menu command to disable the Student
 computer keyboard and mouse and make the button appear pressed in. Click the pressed in button to
enable the Student computer keyboard and mouse.

Transfer sound: Click or click the matching Title bar menu command to transfer Student computer
microphone input and running application sound and make the button appear pressed in. Click the
pressed in button to not transfer Student computer microphone input and running application sound.

Note: Transfer sound will typically work smoothly with new computers with integrated sound devices.
On older computers with older sound devices and older operating systems, if Transfer sound does not
work, look into recording sound mix setup. NetOp expects to find the recording sound mix name Wave
Out Mix. If only other recording sound mix names are available, add this section to the NetOp.ini file:

[AUDIO]

Sound_Mix=<Recording sound mix name>

If the computer sound device does not support recording sound mix, Transfer sound will not work.

Record: Click or click the matching Title bar menu command to start recording the Teacher desktop
showing the Recording toolbox. Control and stop recording in the Recording toolbox.
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Pane

This is the Remote control window pane:

It will typically show an automatically scrolling full scale section of the Student computer screen image.
Alternatively, it can show a scaled Student computer screen image.

By default, the Teacher user and the Student user have equal access to working with Student computer
screen elements with keyboard and mouse.

The Teacher user can suppress the transfer of Student user mouse movements to the Teacher computer
screen by holding down the CTRL key.

The Teacher user can apply Lock keyboard and mouse generally when running a Remote control session or
during a session to disable any Student user keyboard and mouse activity.

On the other hand, you can generally protect the Student against specified Teacher actions including
controlling the Student without confirmation by its user.

Status Bar

This is the Remote control window status bar:

When the mouse pointer is over a Title bar menu command, the left end of the status bar will show a hint to
the command.

Two fields will show the keyboard and mouse status.

The right field will show the duration of the current session in the format HH:MM:SS.
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Session Properties

This is the Control Session properties window:

It specifies Remote control and Monitor Session properties on these tabs:

· Display

· Keyboard/Mouse

· Compression

· Desktop
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Display Tab

This is the Session properties window Display tab:

It specifies Control session window and DOS box characters display properties.

Student window fit

Click one of the options:

¤ Fit window to student screen: Resize the window to contain the full scale Student computer screen image.
If the Student computer screen image has more pixels than the maximized window Pane, the window will
have scrollbars.

¡ Fit student screen to window: Scale the Student computer screen image to fit within the selected window
Pane.

¡ Do not fit: Show the part of the full scale Student computer screen image that will fit within the selected
window Pane. If the Student computer screen image has less pixels than the selected window Pane, it will be
surrounded by black borders. If the Student computer screen image has more pixels than the selected
window Pane, it will have scrollbars.

DOS box font

Command window (DOS box) characters will be transferred as data and typically shown using the Teacher
computer system default font.

þ System default [Select font]: Leave checked to use the Teacher computer system default font. Click
[Select font] to show the Windows Font window to select a font and uncheck the box.
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Keyboard/Mouse Tab

This is the Session properties window Keyboard/Mouse tab:

It specifies Control session keyboard and mouse properties.

Keyboard

Click one of these options:

¤ Remote keyboard (Send all keystrokes to student): Send all Teacher computer keystrokes to the Student
computer.

¡ Local keyboard (Don't send special keystrokes): Send all Teacher computer keystrokes except special
Send keystrokes combinations to the Student computer. Send special Send keystrokes combinations to the
Teacher computer.

¡ No keyboard control: Send all Teacher computer keystrokes to the Teacher computer.

¨ Use teacher keyboard layout: If the Teacher computer keyboard layout and the Student computer
keyboard layout are different, Teacher computer keystrokes will come out wrong on the Student computer.
Check to send Teacher computer keystrokes not according to layout but according to contents.

¨ Don't transfer student Num Lock, Scroll Lock, Insert and Caps Lock: In some cases, these Student
computer keyboard settings may cause Teacher computer keyboard lights to flash. Check to disable the
transfer of these settings.

Mouse

Click one of these options:

¤ Remote mouse (Send all mouse events): Send all Teacher computer mouse events (clicks, drags and
moves) to the Student computer to move the Student computer mouse pointer in accordance with the
Teacher computer mouse pointer.

¡ Local mouse (Only send clicks and drags): Send only Teacher computer clicks and drags (not moves) to
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the Student computer to move the Student computer mouse pointer only when the Teacher user clicks and
drags in the screen image.

¡ No mouse control: Send all Teacher computer mouse events to the Teacher computer.

þ Display student mouse movements: Leave checked to move the Teacher computer mouse pointer in
accordance with Student user mouse movements. The Teacher computer user can press the CTRL key to
suppress this functionality.

Remote control hot keys assignment

· Zoom in and out ¨ Shift ¨ Ctrl ¨ Alt []: To change the keystroke combination that will switch between
Remote control window mode and full screen mode, check/uncheck boxes and specify a key in the field.

Compression Tab

This is the Session properties window Compression tab:

It specifies Control session screen image transfer properties.

Compression level

Screen image data can be compressed to reduce bandwidth consumption and speed up image transfer
across slow communication links. Click one of the options:

¤ Automatic: Compress screen image data according to the properties of the selected Communication
profile.

¡ No compression: The optimum selection for fast communication links.

¡ Low: The optimum selection for medium fast communication links.

¡ High: The optimum selection for slow communication links.

Demo in bitmap mode

If on the Options window Demonstrate tab the Demo in bitmap mode box is checked, a Student desktop
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Demonstrate session will typically use accelerated bitmap transfer.

¨ Disable accelerated bitmap transfer: If a Demo in bitmap mode Student desktop Demonstrate session
causes problems, check this box to see if it solves the problems.

Desktop Tab

This is the Session properties window Desktop tab:

It specifies Control session Student computer desktop features transfer properties.

Optimize screen transfer

Advanced Student computer desktop features slow down screen image transfer and are in most cases
unimportant to the Teacher and other Students that receive a demonstration. Therefore, NetOp will by default
transfer the screen image without advanced desktop features. If unacceptable, select which advanced
desktop features to transfer.

¤ Always: Always apply the optimization specified in the section below.

¡ Only when high compression: Apply the optimization specified in the section below only when NetOp
applies high compression to screen image data according to Compression tab settings.

¡ Never: Never apply the optimization specified in the section below.

Optimization Parameters

Click one of these options:

¤ Full optimization: Apply all Custom options subsection options.

¡ Custom optimization: Enable the Custom options subsection.

Custom Options

þ Disable wallpaper
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þ Disable screen saver

þ Disable animation gimmicks

þ Disable full window drag

þ Disable Active Desktop

þ Disable Vista Aero

3.2.3.3.2  Monitor

To start a Monitor session with selected Students, click the Control menu Monitor students command, or if
Monitor is the default Control mode click the Control button.

You can also start a Monitor session from the Student context menu Monitor this student command or from
the Student group context menu Monitor this group command.

Note: Monitor is a sequential one-to-one session between the Teacher and each selected Student.

The computer screen image of each selected Student will be shown sequentially on the Teacher computer
screen, typically in a window:

The Monitor display is very similar to the Remote control display, but the Teacher user will have no keyboard
and mouse control and most Toolbar or Toolbox buttons will be disabled.
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At an interval set on the Options window Control tab, the computer screen image of the next selected
Student will be shown.

This toolbox will be shown on the Teacher computer screen:

It is explained in the Monitor toolbox section.

Monitor Toolbox

This is the Monitor toolbox:

Its title bar will show:

· During monitoring countdown: Monitoring:, the name of the Student being monitored and the number of
seconds remaining before monitoring the next Student.

· While holding monitoring countdown: Holding: and the name of the Student being monitored.

· If switched to Remote control: Remote controlling: and the name of the Student being remote controlled.

It contains these tool tip identified buttons:

End session: Click to end the Monitor session.

Continue: When Holding, click to continue countdown.

Hold: Click to hold countdown.

Previous student: During countdown, click to jump to the previous Student to start a new
countdown.

Next student: During countdown, click to jump to the next Student to start a new countdown.

/
Remote control/Monitor: Click to switch between Remote control and Monitor. During Remote
control, the green icon Monitor control buttons will be disabled and countdown will be stopped.
The Remote control Title bar menu and Toolbar or toolbox controls except End session, Restart
student computer and Record will be enabled.

/
Full screen/Window: Click to switch between full screen mode and window mode.

Record: Click to start recording the Teacher desktop to show the Recording toolbox.

Print screen to clipboard: Click to take a snapshot of the Student computer screen and place it on
the Teacher computer clipboard.

Print screen to file: Click to take a snapshot of the Student computer screen and save it as a
Teacher computer file.

Note: When you use this functionality for the first time, a NetOp SnapShot folder will be created
on your computer desktop to contain snapshot files. You can change the snapshot files folder in
the Options window Sharing tab Snapshots element.

Transfer sound: Enabled during Monitor Hold and Remote control. Click to transfer Student
computer microphone input and running application sound and make the button appear pressed
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in. Click the pressed in button to not transfer Student computer microphone input and running
application sound.

Note: Transfer sound will typically work smoothly with new computers with integrated sound
devices. On older computers with older sound devices and older operating systems, if Transfer
sound does not work, look into recording sound mix setup. NetOp expects to find the recording
sound mix name Wave Out Mix. If only other recording sound mix names are available, add this
section to the NetOp.ini file:

[AUDIO]

Sound_Mix=<Recording sound mix name>

If the computer sound device does not support recording sound mix, Transfer sound will not
work.

Student list: Click to show a list of selected Students in monitoring order. Click a Student to jump
to it to start a new countdown.

3.2.3.4 Communicate

This is the Teacher window Toolbar Communicate button and menu:

Communicate enables different types of communication with selected Students.

To start a Communicate session, select Students and click one of these Action menu Communicate
command menu or Toolbar Communicate button menu commands:

· Audio-video chat

· Chat

· Send message

You can also start each type of Communicate session from the Student context menu or the Student group
context menu.
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3.2.3.4.1  Audio-Video Chat

To start an Audio-video chat session with selected Students, click the Communicate menu Audio-video chat
command to show this window:

It enables you to control an Audio-video chat session.

Note: Each Teacher and each Student can run only one Audio-video chat session at a time.

You can also start an Audio-video chat session from the Student context menu Audio-video chat with this
student command or the Student group context menu Audio-video chat with this group command.

A similar window with partly different controls will be shown on selected Students' computer screen. The
Teacher Audio-video chat window contains these elements:

Sound

Will show a microphone icon when the Teacher has the microphone, otherwise a loudspeaker icon. 

The field will show sound send volume colored blocks.

Click Volume to show the Teacher computer sound device volume control window to adjust the loudspeaker
output volume.

Class

The table will contain Audio-video chat participant records with these column details:

· Student login name: Will show the Teacher name and the Student login name of participating Students.
Will show a microphone icon if the participant has the microphone. Will show a raised hand if the Student
has requested the microphone (Request button is available on Student).
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· Time: Will show the time of a microphone request.

· Request text: Will show the text of a microphone request (Request text field is available on Student).

With only two participants, you can click one of these options (not available on Student):

¤ Open discussion: Initial selection with two participants. Both will have the microphone for duplex
communication (talk and listen at the same time).

¡ Moderated discussion: Always selected with more than two participants. The Teacher user can assign the
microphone for simplex communication (one talks, others listen).

· Assign: Enabled if Moderated discussion is selected. Click to make appear pressed in to enable assigning
the microphone by clicking a table record. Click again to withdraw the microphone to the Teacher (not
available on Student).

· Mute: Enabled if Moderated discussion is selected. Click to make appear pressed in to disable microphone
input.

Video

Initially, video will be disabled by this section bottom selection (not available on Student):

¡ Video: Enable video.

¤ No video: Disable video.

Click Video to show the Teacher computer camera view in the top of the section and the Student computer
camera view in the bottom of the section. With more than two participants, the camera view of the computer
to which the microphone is assigned will be shown in the bottom of the section. If a camera view is
unavailable, an error message will be shown.

Stop: Click to end the Audio-video chat session (not available on Student).

During an Audio-video chat session, a Details view participating Student record will show this icon in the
Status column:

Classroom view and Class setup view participating Student icons will show a green check mark.

You can specify general Audio-video chat properties on the Options window Audio-video chat tab.

3.2.3.4.2  Chat

To start a Chat session with selected Students, click the Communicate menu Chat command to show this
window:

Each Teacher can run multiple Chat sessions at a time.To identify the Chat session, optionally specify its
topic in the Topic field. Click OK to show this window:



74

NetOp Teacher

It enables you to control a Chat session.

You can also start a Chat session from the Student context menu Chat with this student command or the
Student group context menu Chat with this group command.

A similar window without the End chat button will be shown on the computer screen of selected Students.
The Teacher Chat window contains these elements:

· The title bar will show the specified Chat topic.

Chat

· Dialog []: Will show the Chat dialog. The contributor's name will precede each contribution.

· Enter chat contribution and click send []: Specify your Chat contribution by typing or pasting (CTRL+V).

· Send: Click to send your Chat contribution to the other participants to appear in the pane above.

· Font: Click to show the Windows Font window to format your Chat contribution.

· End chat: Click to close the Chat window of the Teacher and selected Students to end the Chat session
(not available on Student).

· Save: Click to show a Windows Save as window to save the Chat dialog.

During a Chat session, a Details view participating Student record will show this icon in the Status column:

Classroom view and Class setup view participating Student icons will show a green check mark.
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3.2.3.4.3  Send Message

To send a NetOp message to selected Students, click the Communicate menu Send message command to
show this window:

It enables you to send a NetOp message to selected Students.

You can also open the NetOp message window from the Student context menu Send message to this
student command or the Student group context menu Send message to this group command.

Note: As long as the NetOp message window is open, you cannot work in the Teacher window.

The Teacher NetOp message window contains these elements:

· Title bar

· Menu bar

· Toolbar

· Message pane

· Status bar

Title Bar

This is the Teacher NetOp message window title bar:

It will show the path of an opened NetOp message file, otherwise Untitled.

Menu Bar

This is the Teacher NetOp message window menu bar:

It contains these menus:

· File

· Edit

· Search

· Format
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File Menu

This is the Teacher NetOp message window File menu:

It contains these commands:

· Send Message: Click or click the Toolbar Send message button to send the open NetOp message to
selected Students closing the NetOp message window.

Note: A sent NetOp message will not automatically be saved on the Teacher computer. It will appear on the
computer screen of selected Students in a NetOp message window and automatically be saved on the
Student computer. If sending the NetOp message to all selected Students fails, a File distribution window will
show what failed.

· New: Click or click the Toolbar New button to empty the NetOp message window to create a NetOp
message.

· Open: Click or click the Toolbar Open button to show a Windows Open window to open a text file in the
NetOp message window.

Note: To open a file in the NetOp message window, it must have an extension that identifies it as a text file,
typically rtf, txt or doc.

· Save: Click or click the Toolbar Save button to save the open NetOp message in a file. If no file path has
been specified before, a Windows Save as window will be shown to specify it.

· Save as: Click to show a Windows Save as window to save the open NetOp message in a new file.

· Print: Click or click the Toolbar Print button to show a Windows Print window to print the open NetOp
message.

· Close: Click, press CTRL+F4, click the Title bar Close button or click the Title bar window control menu
Close command to close the NetOp message window.

Edit Menu

This is the Teacher NetOp message window Edit menu:

It contains these commands:
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· Undo Ctrl+Z: Click, press CTRL+Z or click the Toolbar Undo button to undo/redo the last Message pane
action.

· Cut Ctrl+X: Select Message pane text and click, press CTRL+X or click the Toolbar Cut button to remove
the selected text placing it on the clipboard.

· Copy Ctrl+C: Select Message pane text and click, press CTRL+C or click the Toolbar Copy button to copy
the selected text to the clipboard.

· Paste Ctrl+V: Click, press CTRL+V or click the Toolbar Paste button to paste the clipboard contents in the
Message pane cursor position.

· Clear all Ctrl+Del: Click or press CTRL+DEL to delete the Message pane contents.

· Delete Del: Select Message pane text and click or press DEL to delete the selected text.

Search Menu

This is the Teacher NetOp message window Search menu:

It contains these commands:

· Find: Click or click the Toolbar Find button to show the Windows Find window to specify a character
sequence to find it in the Message pane.

· Replace: Click to show the Windows Replace window to specify a character sequence to find and replace
it in the Message pane.

· Next F3: Click or press F3 to highlight the next occurrence of the character sequence specified in a
Windows Find or Replace window.

Format Menu

This is the Teacher NetOp message window Format menu:

It contains these commands:

· Character: Select Message pane text and click an expanded Bold, Italic, Underline or Strikeout command
or click the matching Toolbar buttons to apply this formatting to or remove this formatting from the selected
text. Commands will be check marked and buttons will appear pressed in when the formatting is applied.

· Font: Select Message pane text and click to show the Windows Font window to apply a selected font to the
selected text.

· Text data/RTF data: One of these commands will be check marked to indicate the Message pane text data
type. Click the unchecked command to change the Message pane text data type.

Note: The RTF data type supports hyperlinks.
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Toolbar

This is the Teacher NetOp message window toolbar:

It contains these buttons:

Send message: Click or click the File menu Send message command to send the open NetOp
message to selected Students closing the NetOp message window.

Note: A sent NetOp message will not automatically be saved on the Teacher computer. It will appear
on the computer screen of selected Students in a NetOp message window and automatically be saved
on the Student computer. If sending the NetOp message to all selected Students fails, a File
distribution window will show what failed.

New: Click or click the File menu New command to empty the NetOp message window to create a
NetOp message.

Open: Click or click the File menu Open command to show a Windows Open window to open a text
file in the NetOp message window.

Note: To open a file in the NetOp message window, it must have an extension that identifies it as a
text file, typically rtf, txt or doc.

Save: Click or click the File menu Save command to save the open NetOp message in a file. If no file
path has been specified before, a Windows Save as window will be shown to specify it.

Print: Click or click the File menu Print command to show a Windows Print window to print the open
NetOp message.

Undo: Click, press CTRL+Z or click the Edit menu Undo command to undo/redo the last Message
pane action.

Cut: Select Message pane text and click, press CTRL+X or click the Edit menu Cut command to
remove the selected text placing it on the clipboard.

Copy: Select Message pane text and click, press CTRL+C or click the Edit menu Copy command to
copy the selected text to the clipboard.

Paste: Click, press CTRL+V or click the Edit menu Paste command to paste the clipboard contents in
the Message pane cursor position.

Find: Click or click the Search menu Find command to show the Windows Find window to specify a
character sequence to find it in the Message pane.

Bold: Select Message pane text and click or click the Format menu Character > Bold command to
apply this formatting to or remove this formatting from the selected text. The button will appear
pressed in and the command will be check marked when the formatting is applied.

Italic: Select Message pane text and click or click the Format menu Character > Italic command to
apply this formatting to or remove this formatting from the selected text. The button will appear
pressed in and the command will be check marked when the formatting is applied.

Underline: Select Message pane text and click or click the Format menu Character > Underline
command to apply this formatting to or remove this formatting from the selected text. The button will
appear pressed in and the command will be check marked when the formatting is applied.
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Message Pane

This is the Teacher NetOp message window message pane:

In it, you can create and edit a NetOp message.

Note: The Student window Messages tab Subject column will show the contents of the first message line.
The RTF data type supports hyperlinks.

Status Bar

This is the Teacher NetOp message window status bar:

The fields to the right will indicate this:

· CAPS: Enabled (black text) if CAPS LOCK is enabled.

· NUM: Enabled (black text) if NUM LOCK is enabled.

· OVR: Enabled (black text) if INSERT is enabled.

3.2.3.5 Workgroup

This is the Teacher window Toolbar Workgroup button:

Workgroup enables creating a Workgroup session from selected Students.

To create a Workgroup session, select the Students that shall be in it and click the Action menu Workgroup
command or the Toolbar Workgroup button to show this window:
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Note: You can create a Workgroup session with the connected Students of a Student group from the Student
group context menu Workgroup session for this group command.

It enables you to specify the Workgroup session in these elements:

· Workgroup session name []: Will by default show the Class name and a number (1 for the first Class
Workgroup session, 2 for the next, etc.). You can edit the field contents.

· Select the assistant teacher from the list []: The table will contain selected Student records with these
column details:

· Student display name: Icon and Student user Student display name.

· Windows login name: Student user Windows login name.

· Computer name: Student Computer name.

To appoint the Workgroup session Assistant teacher, select a record to highlight it and change the Student
icon into a Workgroup icon.

Disable assistant teacher options

¨ Lock keyboard and mouse: Check to disable the Assistant teacher option to Lock keyboard and mouse of
Workgroup session Remote control session Student computers.

¨ Audio-video chat: Check to disable the Assistant teacher option to run an Audio-video chat session with
Workgroup session Students.

¨ Attention: Check to disable the Assistant teacher option to apply Attention to Workgroup session Students.

The OK button will become enabled when the Assistant teacher has been appointed. Click to apply
selections closing the window.
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This will happen:

· On the Student appointed Assistant teacher, the Student window will minimize to the Windows taskbar
notification area and the Assistant teacher window that has almost the same appearance and functionality
as the Teacher window will open.

· Workgroup session Students will disconnect from the Teacher to connect to the Assistant teacher.

· In the Teacher window Details view, the Student appointed Assistant teacher will in the Status column
show a Workgroup icon and in the Information column show Assistant teacher: <Workgroup name>.
Workgroup session Students will in the Status column show an Unconnected icon and in the Student
display name column be named <Workgroup name>/<Student display name>.

· In the Teacher window Classroom view, the Student appointed Assistant teacher will show a Workgroup
icon and other Workgroup session Students will appear unconnected being named <Workgroup name>/<
Student display name>.

· In the Teacher window Thumbnails view, the Student appointed Assistant teacher will appear connected
and Workgroup session Students will  appear unconnected being named <Workgroup name>/<Student
display name>.

· In the Teacher window Activity view, the Student appointed Assistant teacher will appear connected and
Workgroup session Students will appear unconnected being named <Workgroup name>/<Student display
name>.

· In the Teacher window Class setup view, the Student appointed Assistant teacher will appear connected
and Workgroup session Students will appear unconnected being named <Workgroup name>/<Student
display name>.

· The Teacher can control the Assistant teacher that will remain connected to the Class. In a Remote control
session with the Assistant teacher, the Teacher can through the Assistant teacher window control
Workgroup session Students.

· To end a Workgroup session, in the Student context menu of the Student appointed Assistant teacher
click Stop workgroup session to return all Workgroup session Students to the Class.

3.2.3.6 Run

This is the Teacher window Toolbar Run button and menu:

Run enables running a test, survey or program on selected Students.

To run a test, survey or program, select Students and click a Toolbar Run button menu command. In the
Action menu, click Run test to run the Tests view pane Tests tab first Test or click Run program to show the
Run program browse window to specify a Program to run it. 

You can also run a test, survey or program from the Student context menu or the Student group context
menu.

Run includes these features:

· Run test
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· Run survey

· Run program

3.2.3.6.1  Run Test

The Run menu Run test command will expand into Tests view Tests tab available Test commands:

Click a Test command to run the Test on selected Students as explained in the Results section.

3.2.3.6.2  Run Survey

The Run menu Run survey command will expand into Tests view Surveys tab available Survey commands:

Click a Survey command to run the Survey on selected Students as explained in the Results section.

3.2.3.6.3  Run Program

The Run menu can include these Run program elements:

· Click the Run program command to show the Run program browse window to browse for a program to run
it on selected Students.

· Click the Options command to show the Options window Run tab to manage Run menu program
commands.

· Click a program command to expand into these commands:

· Run on student: Click to run the Options window Run tab specified program on selected Student
computers. If a Student cannot find the program file on its computer, File not found will be shown in its
Details view record Information column. To ensure that the program file is available on Student
computers, Distribute it before attempting to Run it.

· Run locally: Click to run the program on the Teacher computer.

· Demo: Click to run the program on the Teacher computer while running an Entire desktop Demonstrate
session with selected Students.
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Run Program Browse

Click the Run menu Run program command to show this window:

It enables you to browse for a program to run it on selected Student computers. It contains these elements:

· Program path [][Browse]: Must specify the program file path on selected Student computers. The
drop-down box list will contain program file paths that have been used before. Click one to show it in the
field. Click [Browse] to show a Windows Open window to open a Teacher computer program file to show
its path in the field or specify the program file path manually.

Note: By default, the Open window will show only program files. You can also run other files, e.g. text files.
To run on Student computers, the file must be available on Student computers and identifiable by the
Program path drop-down box program file path specification.

· Command line switches []: To run the Program path drop-down box specified program with command line
switches, they must be specified in this drop-down box. Its list will contain switches that have been used
before. Click one to show it in the field or specify switches manually.

· Translate: Click to replace Program path drop-down box field specified path elements by available
matching environment variables to facilitate  path identification on Student computers regardless of
language differences.

Run

Click one of these options:

¤ Normal: Run the program in a normal size window.

¡ Maximized: Run the program in a maximized window.

¡ Minimized: Run the program minimized.

Click OK to run the specified program on selected Student computers. If a Student cannot find the program
file on its computer, File not found will be shown in the Details view Information column. To ensure that the
program file is available on Student computers, Distribute it before attempting to Run it.
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3.2.3.7 Commands

This is the Teacher window Toolbar Commands button and menu:

Commands enables executing system control commands on selected Students.

To execute a system control command on selected Students, select Students and click an Action menu
Commands command menu or Toolbar Commands button menu command.

You can also execute a system control command from the Student context menu Execute command on this
student menu or the Student group context menu Execute command on this group menu.

These Commands are available:

· Log off: Click to log off the user from Windows on selected Student computers.

· Restart: Click to restart selected Student computers.

· Shut down: Click to shut down selected Student computers.

· Rejoin: Click to make selected Students Leave class and Join class.

3.2.3.8 Files

This is the Teacher window Toolbar Files button and menu:

Files enables distributing, collecting or managing files with selected Students.

To start a Files session with selected Students, select Students and click an Action menu Files command
menu or Toolbar Files button menu command.

You can also start a Files session from the Student context menu or the Student group context menu.

These Files sessions are available:

· Distribute files

· Collect files

· File manager
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3.2.3.8.1  Distribute Files

To Distribute files to selected Student computers, click the Files menu Distribute files command to show this
window:

Click Next to show this window:
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It enables you to select which files and/or folders to distribute.

To select one or multiple files, click Add files to show the Windows Open window.

To select one folder, click Add folder to show the Windows Browse for folder window.

Note: All files and folders in a selected folder but not the folder itself will be distributed.

Selected files and folders will appear as check boxed table records. To deselect a file or folder, uncheck its
record's box.

To specify distribution properties in the Distribute files to students window instead of in this Distribution
wizard, click Advanced.

If at least one file is selected, the Next button will be enabled. Click it to show this window:
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It enables you to select to which Students files shall be distributed.

The To students pane will contain the names of connected Students. The names of initially selected Students
will be highlighted. The To groups pane will contain the names of available Student groups. Click Student
names to select/unselect Students. Click a Student group name to select the Students in the Student group.

If at least one Student is selected, the Next button will be enabled. Click it to show this window:
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It enables you to select the distributed files Student computer destination.

The Destination pane will contain available destination descriptions. Click a destination description to
highlight it to select the Student computer destination whose path is shown in the Details of selected item
field below. Path elements enclosed by % are environment variables.

If a Student computer destination is selected, the Distribute button will be enabled. Click it to distribute files
as specified.

This is the alternative Distribute files to students window:
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It combines the Distribution wizard window contents and includes additional options:

In the Source section, you can select a table record to enable the Delete button and show the record item
path in the Details of selected item field. Click Delete to delete the selected record.

Note: Source pane contents will be retained after file distribution, even after switching to another Class and
after logging off and on to the Teacher using Teacher profiles. Source pane contents will be lost when the
Teacher is unloaded.

In the Destination section, you can create, edit and delete Student computer destinations. Click New to show
this window:

It enables you to specify a Student computer destination in these elements:

· Description []: Specify the Student computer destination description.

· Path []: Specify the Student computer destination path, preferably by using environment variables.

Note: To show available computer environment variables, in a command window execute the command
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set. CLASSROOM, DESKTOP and MYDOCUMENTS are NetOp environment variables.

Select a destination and click Edit to show the Location window to edit it. Select a destination and click Delete
to delete it.

Note: Student computer locations are specific to each Class and will be retained when the Teacher is
unloaded. Edited and newly created Student computer locations will be written to the locstd.ndb NetOp
configuration file. Distributed files will without any warning overwrite any unprotected files with the same
name in the same Student computer location.

¨ Send files to same destination on students: Check to use the Teacher source location path as the Student
destination location path.

¨ Use this destination when files are dropped and don't prompt with this dialog: Check to enable Quick
distribution.

Quick distribution

Open Windows Explorer, select files and folders, drag them to a Class control panel Student, selected
Students, Student group or selected Student groups and drop them.

Note: Quick distribution will replace any Source section pane contents by Quick distribution selected source
files and folders.

File distribution will show this window:

It will show file distribution progress and results in these elements:

File distribution info

File: The name of the file currently being distributed, or "-" if all files have been distributed.

Files sent: The current number of files distributed.

Bytes sent: The current number of bytes distributed.

Elapsed time: The elapsed time of file distribution in the format HH:MM:SS.
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The colored blocks progress bar will indicate file distribution progress.

File distribution status []: The pane will graphically show the current file distribution status. Students to which

files have been distributed will be indicated by a named  icon. File distribution errors will be indicated by a
red exclamation mark. Expand each line by clicking the [+] button in front of it to show the paths and names
of distributed files and in case of file distribution errors a text that indicates their nature.

During a Distribute files session, a Details view participating Student record will show this icon in the Status
column:

Classroom view and Class setup view participating Student icons will show a green check mark.

3.2.3.8.2  Collect Files

To Collect files from selected Student computers, click the Files menu Collect files command to show this
window:

Click Next to show this window:
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It enables you to select which files and/or folders to collect.

Initially, the pane will contain the file and folder records of the most recent Distribute files session. To add
files to the selection, click Specify files to show this window:

It enables you to specify a collect file name or mask and a Student computer location in these elements:

· File type []: Specify a file name or a file mask (a file name with wildcard characters like *) to collect one
or multiple files in the Student computer location selected in the Location pane below. Leave empty to
collect all files in the location.

· Location []: Click a Student computer location to highlight it as selected. If the desired Student computer
location is unavailable, click Edit student location list to show this window:
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Its table contains records of available Student computer locations.

Click New to show the Location window to create a Student computer location. Select a record and click
Edit to edit the location in the Location window. Select a record and click Delete to delete it. When done,
click Close to close the window returning to the Collect file window.

Note: Student computer locations are specific to each Class and will be retained when the Teacher is
unloaded. Edited and newly created Student computer locations will be written to the locstd.ndb NetOp
configuration file.

The OK button will become enabled when a Student computer location has been selected. Click it to close
the window adding the collect file specification in the wizard window Source pane.

To deselect a collect file specification, uncheck its box.

¨ Include subfolders: Check to include the subfolders of specified folders.

¨ Delete on student after collection: Check to remove collected files from the Student computer.

Caution: Check only if you are certain that no files needed on the Student computer will be removed.

To specify collection properties in the Collect files from students window instead of in this Collection wizard,
click Advanced.

If at least one file is selected, the Next button will be enabled. Click it to show this window:
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It enables you to select from which Students files shall be collected.

The From students pane will contain the names of connected Students. The names of initially selected
Students will be highlighted. The From groups pane will contain the names of available Student groups. Click
Student names to select/unselect Students. Click a Student groups name to select the Students in the
Student group.

If at least one Student is selected, the Next button will be enabled. Click it to show this window:
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It enables you to select the Teacher computer destination of collected files.

The Destination pane will contain available destination descriptions. Click a destination description to
highlight it to select the Teacher computer destination whose path is shown in the Details of selected item
field below. Path elements enclosed by % are environment variables.

If a Teacher computer destination is selected, the Collect button will be enabled. Click it to collect files as
specified.

This is the alternative Collect files from students window:
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It combines the Collection wizard window contents and includes additional options:

In the Source section, you can select a table record to enable the Delete button and show the record item
path in the Details of selected item field. Click Delete to delete the selected record.

In the Destination section, you can create, edit and delete Teacher computer destinations. Click New to show
the Location window to create a Teacher computer location. Select a destination and click Edit to show the
Location window to edit it. Select a destination and click Delete to delete it.

Note: Edited and newly created Teacher computer locations will be written to the loctch.ndb NetOp
configuration file. Files collected from Students will be placed in a <Student name> folder in the specified
Teacher computer location to overwrite without any warning any unprotected files with the same name in the
same location.

File collection will show this window:
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It will show file collection progress and results in these elements:

File collection info

Student: The name of the Student from which files are currently being collected, or "-" if files have been
collected from all selected Students.

File: The name of the file currently being collected, or "-" if all files have been collected.

Files received: The current number of files collected.

Bytes received: The current number of bytes collected.

Elapsed time: The elapsed time of file collection in the format HH:MM:SS.

File collection status []: The pane will graphically show the current file collection status. Students from which

files have been collected will be indicated by a named  icon. File collection errors will be indicated by a red
exclamation mark. Expand each line by clicking the [+] button in front of the line to show the paths and
names of collected files and in case of file collection errors a text that indicates their nature.

During a Collect files session, a Details view participating Student record will show this icon in the Status
column:

Classroom view and Class setup view participating Student icons will show a green check mark.
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3.2.3.8.3  File Manager

To manage the files of a selected Student computer, click the Files menu File manager command.

If multiple Students are selected, this window will be shown:

Click in the drop-down box list the name of the Student whose files you want to manage.

You can also start a File manager session from the Student context menu File transfer with this student
command.

Note: File manager is a one-to-one session between the Teacher and one Student. The Teacher can start up
to ten File manager sessions one at a time and run them in parallel.

This window will be shown:

It contains these elements:

· Title bar 

· Menu bar 

· Toolbar 
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· Records panels 

During a File manager session, a Details view participating Student record will show this icon in the Status
column:

Classroom view and Class setup view participating Student icons will show a green check mark.

To end a File manager session, click the File manager window File menu Close command or use a Title bar
Close window control.

Title Bar

This is the File manager title bar:

It will show the name of the Student with which the File manager session is running.

Menu Bar

This is the File manager menu bar:

It contains these menus:

· File

· Edit

· View

· Options

· Help 

File Menu

This is the File manager window File menu:

It contains these commands:

· Copy files: Select Record panel records and click or click the matching Record panel context menu
command or Toolbar Copy files button or press any matching keyboard shortcut to show the Copy window.
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Note: Alternatively, drag records from one Record panel to the other and drop them to typically show the
Transfer status window.

· Move files: Select Record panel records and click or click the matching Record panel context menu
command or Toolbar Move files button or press any matching keyboard shortcut to show the Move
window.

· Sync files: Click or click the Toolbar Synchronize files button to show the Synchronize window.

Note: By default, Synchronize files will transfer folders and files to include folders and files that exist in
either Record panel in both Record panels replacing older files by newer files. On the Options window
Transfer tab, you can select the Synchronize options Transfer only if file exists and Transfer only one way.

· Clone files: Click or click the Toolbar Clone files button to show the Clone window.

Note: Clone files will delete all folders and files in the unselected Record panel and copy all folders and
files in the selected Record panel to the unselected Record panel.

· New folder: Click or click the Toolbar New folder button or press any matching keyboard shortcut to show
this window:

Specify the new folder name and click OK to create the folder in the selected Record panel.

· Drive info: Click to show this window:

It will show information on the selected Record panel computer drives in these elements:

· Drives: Will show drive icons and letters. Select a drive to show information on it in the Information
section.

· Information: Will show this information on the drive selected in the Drives pane:

· Type: Drive type.

· File system: Drive file system.

· Used space: Drive used space in bytes.
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· Free space: Drive free space in bytes.

· Capacity: Drive capacity in bytes.

· Delete: Select Record panel records and click or click the matching Record panel context menu command
or the Toolbar Delete button or press the matching keyboard shortcut to delete selected records. If
selected, a confirmation window will be shown.

Caution: If you delete a folder, folders and files in it will be deleted.

· Rename: Select a Record panel record and click or click the matching Record panel context menu
command or press any matching keyboard shortcut to show this window:

Edit the name and click OK to rename the record.

· Properties: Select a Record panel record and click or click the matching Record panel context menu
command or the Toolbar Properties button or press the matching keyboard shortcut to show this window:

Check/uncheck Attributes boxes and click OK to apply changes.

· Close: Click, use a matching Title bar window control or press the matching keyboard shortcut to end the
File manager session closing the File manager window.
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Copy/Move/Synchronize/Clone

Execute the File manager Copy files, Move files, Sync files or Clone files functionality to show this window:

Note: The title bar will show the name of the selected operation.

It specifies operation details, some of which you can edit before execution:

From

· Computer: Will show the selected Record panel designation.

· Folder/File: Will show the selected Record panel selection path, for one selected folder <Folder path>\*.*,
for one selected file <Folder path>\<File name>.

To

· Computer: Will show the unselected Record panel designation.

· Folder/File []: Will highlight the unselected Record panel current folder path and for one selected folder *.*,
for one selected file <File name>. You can edit the field contents to specify another destination folder
and/or file name.

Selected

· Folders: Will show the number of selected folders.

· Files: Will show the number of selected files.

Options

¨ Include subfolders: Will be enabled and checked if you have selected folders. Leave checked to transfer
also selected folder subfolders and their file contents. Uncheck to transfer only selected folders and their file
contents.

¨ End session when finished: Check to end the File manager session when this operation is finished.

· Options: Click to show the Options window to manage options for this operation.

Click OK to execute the operation to show the Transfer status window.
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Transfer Status

Click OK in the Copy/Move/Synchronize/Clone window to show this window:

It will show File manager Transfer status on these tabs:

· Progress 

· History 

· Session history 

Close: Will be enabled after the operation has completed. Click to close the window.

Cancel: Will be enabled during the operation. Click it to interrupt the operation. Executed file transfers will not
be undone.
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Progress Tab

This is the File manager Transfer status window Progress tab:

It will show operation execution progress in these elements:

Current command

Will during the operation show the command being executed. Will after the operation show Transfer ended.

Overall progression

Will show these overall progression details:

· Files transmitted: Will show the number of transferred files.

· Total files: Will show the number of selected files.

· Bytes transmitted: Will show the number of transferred bytes.

· Total bytes: Will show the number of bytes in selected files.

· Elapsed time: Will show the elapsed transfer time.

· Estimated time: Will show the estimated total transfer time.

The colored blocks bar will indicate overall operation progress.

Sending/Sent/Receiving/Received
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Will show the current or last file transfer local path and name.

The colored blocks bar will indicate the current or last file transfer progress.

· Bytes sent/received: Number of bytes sent or received in the current or last file transfer.

· BPS: Current or last file transfer speed in bytes per second.

¨ End session when finished: Check to end the File manager session when this operation is finished.

History Tab

This is the File manager Transfer status window History tab:

Its pane will show a graphical event log of the current or last File manager operation. Click [+] buttons to
expand and [-] buttons to collapse the event structure. 

Event log elements are explained in the NetOp script section of the NetOp Remote Control User's Manual
that is available from the www.netop.com website, select Support > KnowledgeBase > Documentation >
Manuals. Guest matches Teacher and Host matches Student.

http://www.netop.com


106

NetOp Teacher

Session History Tab

This is the File manager Transfer status window Session history tab:

Its pane will show a graphical event log of the current File manager session. Click [+] buttons to expand and
[-] buttons to collapse the event structure. 

Event log elements are explained in the NetOp script section of the NetOp Remote Control User's Manual
that is available from the www.netop.com website, select Support > KnowledgeBase > Documentation >
Manuals. Guest matches Teacher and Host matches Student.

Edit Menu

This is the File manager window Edit menu:

It contains these commands:

· Select all: Click or press any matching keyboard shortcut to select all folders and files in the selected

http://www.netop.com
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Record panel.

· Select by: Click or click the Toolbar Select files button or press any matching keyboard shortcut to show
this window:

Replace *.* by a file mask (a file name with wildcard characters like *) and click OK to select selected
Record panel unselected folders and files by the file mask.

· Deselect by: Click or press any matching keyboard shortcut to show this window:

Replace *.* by a file mask (a file name with wildcard characters like *) and click OK to deselect selected
Record panel selected folders and files by the file mask.

· Invert selection: Click or press any matching keyboard shortcut to make all selected Record panel selected
folders and files unselected and all unselected folders and files selected.

· Clear selection: Click to deselect all selected Record panel selected folders and files.

View Menu

This is the File manager window View menu:

It contains these commands:

· Large icons: Click to check mark or click the Toolbar Large icons button to show Record panel records as
horizontal rows of large icons.

· Small icons: Click to check mark or click the Toolbar Small icons button to show Record panel records as
horizontal rows of small icons.

· List: Click to check mark or click the Toolbar List button to show Record panel records as vertical columns
of small icons.
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· Details: Click to check mark or click the Toolbar Details button to show Record panel records in a table
with details in columns.

· Local: Click to check/uncheck or click the Toolbar Local button to switch between remote and local file
management.

· Arrange icons: Expands into these commands:

· By name: Click or press any matching keyboard shortcut to sort Record panel file records by file name,
ascending/descending like the Details selection.

· By type: Click or press any matching keyboard shortcut to sort Record panel file records by extension,
ascending/descending like the Details selection.

· By size: Click or press any matching keyboard shortcut to sort Record panel file records by file size,
ascending/descending like the Details selection.

· By date: Click or press any matching keyboard shortcut to sort Record panel file records by time,
ascending/descending like the Details selection.

· Auto arrange: Click to uncheck/check to disable/enable automatic file sorting by the current selection.

Note: Folder records in alphabetically ascending order will always be shown before file records. In Details
view, click a column heading to sort file records ascending/descending by it.

· Refresh: Click or press the matching keyboard shortcut to retrieve new information from the computers to
refresh Record panel contents.

Options Menu

This is the File manager Options menu:

It contains this command:

· Options: Click to show this window:
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It enables you to specify File manager options on these tabs:

· Transfer

· Confirmation

· Layout
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Transfer Tab

This is the File manager Options window Transfer tab:

It enables you to specify File manager Transfer options in these elements:

Synchronize

¨ Transfer only if file exists: Check to Synchronize files only if they exist in the unselected Record panel.

¨ Transfer only one way: Check to Synchronize files only from the selected Record panel to the unselected
Record panel.

General Transfer

þ Include subfolders: Leave checked to transfer also the contents of subfolders of selected folders.

þ Use delta file transfer: Leave checked to compare source files with matching destination files to transfer
only differences between source and destination files to save transmission bandwidth.

þ Enable crash recovery: Leave checked to transfer files in a way that they can be recovered after a
computer or network crash during file transfer.

¨ Close dialog when finished: Check to close the Transfer status window when a file transfer is finished.

¨ End session when finished: Check to end the File manager session when a file transfer is finished.

Default: Click to restore tab default settings.
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Confirmation Tab

This is the File manager Options window Confirmation tab:

It enables you to specify File manager Confirmation options in these elements:

Confirm when...

þ Delete non-empty folders: Leave checked to show this window if you are about to delete a folder that
contains folders or files:

Skip: Click to skip deleting the specified folder.

Delete: Click to delete the specified folder.

Advanced: Click to show this window:
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It will show your Delete confirmation selections to enable you to change them for this file transfer
operation before continuing.

Cancel: Click to cancel the file transfer at this point. Executed file transfer actions will not be undone.

¨ Overwriting/deleting files: Check to show this window or the Delete window if you are about to overwrite or
delete files:

Skip: Click to skip overwriting the specified file.

Overwrite: Click to overwrite the specified file.

Advanced: Click to show this window:
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Always skip...

Check boxes in this section to skip file transfer in this file transfer operation in case of checked
properties:

¨ Existing files

¨ Read-only files

¨ Hidden files

¨ System files

¨ On file write error

¨ On file read error

Confirm when...

This section will show your Overwrite/Delete confirmation selections to enable you to change them for
this file transfer operation before continuing.

þ Overwriting existing files: Leave checked to show the Overwrite window if you are about to overwrite
existing files.

þ Overwriting/deleting read-only files: Leave checked to show the relevant confirmation window if you
are about to overwrite/delete read-only files.

þ Overwriting/deleting hidden files: Leave checked to show the relevant confirmation window if you are
about to overwrite/delete hidden files.

þ Overwriting/deleting system files: Leave checked to show the relevant confirmation window if you are
about to overwrite/delete system files.

þ Overwriting/deleting read-only files: Leave checked to show the relevant confirmation window if you are
about to overwrite/delete read-only files.

þ Overwriting/deleting hidden files: Leave checked to show the relevant confirmation window if you are about
to overwrite/delete hidden files.
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þ Overwriting/deleting system files: Leave checked to show the relevant confirmation window if you are
about to overwrite/delete system files.

¨ Drag and drop (copying files with the mouse): Check to show a confirmation window before executing a
drag and drop file transfer.

Default: Click to restore tab default settings.

Layout Tab

This is the File manager Options window Layout tab:

It enables you to specify File manager Layout options in these elements:

Screen

þ Show toolbar: Leave checked to show the File manager window Toolbar.

þ Show status bar: Leave checked to show a status bar at the bottom of the two Record panels.

þ Save session path at exit: Leave checked to show the same Record panel contents when starting a File
manager session with the same Student next time. Uncheck to always show the system drive contents
when starting a File manager session.

Keyboard

Select one of these options:

¤ Use system hotkey layout: Use the operating system hot key layout, see the table below.

¡ Use NetOp hotkey layout: Use the NetOp hot key layout, see the table below.

Function Windows hot key NetOp hot key

Copy files  F3

Move files  F6

New folder  F7
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Delete DELETE F8

Rename F2  

Close ALT+F4 F10

Properties ALT+ENTER SHIFT+F1

Select all CTRL+A  

Select by  +

Deselect by  -

Invert selection  *

Arrange icons by name  CTRL+F3

Arrange icons by type  CTRL+F4

Arrange icons by size  CTRL+F6

Arrange icons by date  CTRL+F5

Refresh F5 CTRL+R

Select the left record panel  ALT+F1

Select the right record panel  ALT+F2

Help F1 F1

Note: Hot keys will be shown next to menu commands.

Icons

Select one of these options:

¡ Local associated and Host 'exe' icons: Show Record panel file icons according to Teacher file associations
but show Student .exe file icons according to Student file associations.

¤ Local associated icons: Show Record panel file icons according to Teacher file associations (saves
transmission bandwidth).

¡ Default icons: Show the same default icon for all Record panel files (saves transmission bandwidth and
processor capacity).

Default: Click to restore tab default settings.

Help Menu

This is the File manager Help menu:

It contains this command:

· Help topics F1: Click or press F1 to show NetOp Teacher Help.

Toolbar

This is the File manager toolbar:

It contains these buttons:

Copy files: Select Record panel records and click or click the File menu or Record panel context
menu Copy files command or press any matching keyboard shortcut to show the Copy window.

Note: Alternatively, drag records from one Record panel to the other and drop them to typically show
the  Transfer status window.
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Move files: Select Record panel records and click or click the File menu or Record panel context
menu Move files command or press any matching keyboard shortcut to show the Move window.

Synchronize files: Click or click the File menu Sync files command to show the Synchronize window.

Note: By default, Synchronize files will transfer folders and files to include folders and files that exist in
either Record panel in both Record panels replacing older files by newer files. On the Options window
Transfer tab, you can select the Synchronize options Transfer only if file exists and Transfer only one
way.

Clone files: Click or click the File menu Clone files command to show the Clone window.

Note: Clone files will delete all folders and files in the unselected Record panel and copy all folders
and files in the selected Record panel to the unselected Record panel.

New folder: Click or click the File menu New folder command or press any matching keyboard shortcut
 to show the New folder window.

Delete: Select Record panel records and click or click the File menu or Record panel context menu
Delete command or press the matching keyboard shortcut to delete selected records. If selected, a
confirmation window will be shown.

Properties: Select a Record panel record and click or click the File menu or Record panel context
menu Properties command or press the matching keyboard shortcut to show the Properties window.

Select by: Click or click the Edit menu Select by command or press any matching keyboard shortcut to
show the Select window.

Options: Click or click the Options menu Options command to show the Options window.

Local: Click to appear pressed in/released or click the View menu Local command to check/uncheck it
to switch between remote and local file management.

Large Icons: Click to appear pressed in or click the View menu Large icons command to check mark it
to show Record panel records as horizontal rows of large icons.

Small Icons: Click to appear pressed in or click the View menu Small icons command to check mark it
to show Record panel records as horizontal rows of small icons.

List: Click to appear pressed in or click the View menu List command to check mark it to show Record
panel records as vertical columns of small icons.

Details: Click to appear pressed in or click the View menu Details command to check mark it to show
Record panel records in a table with details in columns.
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Record Panel

The two File manager record panels have identical layout:

The top title bars will show <Teacher> in the left record panel and the Student name in the right record panel.
In a local file transfer session, the right record panel will show Teacher.

The selected record panel title bar will have a strong color and the unselected record panel title bar will have
a dimmed color. Click in a record panel or press a keyboard shortcut to select it. Press TAB to switch the
record panel selection. Record panels will remain equally sized.

The folder bar below contains a left drive drop-down box and a right folder drop-down box.

The drive drop-down box field will show the selected drive icon and letter. The drop-down box list will contain
the icon, letter and name of local and mapped network drives. Click a drive in the list to show it in the field.

The folder drop-down box field will show the path of the selected folder. The drop-down box list will contain
the paths of up to 30 folders that have been selected during the current File manager session. Select a folder
path in the list to show it in the field to show folder contents in the records pane below. Alternatively, specify a
folder path in the drop-down box field and press ENTER to select the folder.

The records pane below will contain records of folders and files in the selected folder as Large icons, Small
icons, List or Details. Change the view from the Toolbar or the View menu. Folder records in alphabetically
ascending order are shown before file records. Sort file records by clicking Details column headings or by
pressing a keyboard shortcut.

Details will show record details in a table with these column contents:

· Name: Record name.
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· Ext: <DIR> for folder, file extension for file.

· Size: File size in bytes. Folder size is 0 bytes.

· Date: Date and time of last record change.

· Attrib: First letters of record attributes:

· r: Read-only

· a: Archive

· h: Hidden

· s: System

Double-click a folder record to select this folder to show its path in the folder bar and its contents in the
records pane.

Double-click a records pane top folder record with two period characters (..) to move one step up in the folder
tree structure.

The bottom status bar will show the number of bytes in the number of selected record files. Bytes in files in
selected folder record folders are not included in the byte count.

Execute file transfers and manage records from Toolbar buttons and menu commands.

Right-click a record or multiple selected records to show this context menu:

Top section commands that may be different with different file selections and computer setups are similar to
Windows Explorer right-click context menu commands.

Lower sections commands match File menu commands.

Drag selected records in one record pane to the other record pane and drop them to copy them to a record
folder, if highlighted, or to the folder whose records are shown in the pane.

Press the right mouse button and drag selected records in one record pane to the other record pane and
drop them to show this context menu:

· Copy here: Click to copy selected records to a record folder, if highlighted, or to the folder whose records
are shown in the pane.

· Move here: Click to move selected records to a record folder, if highlighted, or to the folder whose records
are shown in the pane.

· Cancel: Click to cancel the attempted file transfer.
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3.2.3.9 Policy

This is the Teacher window Toolbar Policy button and menu:

Policy enables applying an Application and Internet Policy to selected Students.

The Options window Class tab Policy section Startup policy drop-down box selection determines the Policy
that will apply to Students when they connect to a Class.

To apply a Policy to selected Students, click the Action menu Policy command or the Toolbar Policy button to
apply the default Policy or click a Policy menu command to apply an available Policy. 

The Policy menu that opens from the Toolbar Policy button down pointer button will contain these
commands:

· Reset policy: Click to apply the Class Startup policy to selected Students.

· Allow all: Click to allow selected Students to run all Applications and access all Internet addresses.

· Deny all: Click to deny selected Students to run all Applications and access all Internet addresses.

· <Policy name>: Click to apply a user specified Policy to selected Students. The Policy menu can contain
multiple user specified Policy commands.

· Options: Click to show the Options window Policy tab to manage Policies.

Note: The default Policy name will be enclosed by asterisks.

3.2.3.10 Record

This is the Teacher window Toolbar Record button:

Record enables creating a Teacher computer desktop NetOp recording.

Note: You can also create a Teacher computer desktop NetOp recording from the Remote control window
Title bar menu or Toolbar or toolbox, from the Monitor toolbox and from the the Recordings view pane
context menu. You can create a .avi screen video with NetOp screen video.

Click the Record button to start recording the Teacher computer desktop showing this Recording toolbox:

It contains these tool tip identified buttons:
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End session: Click to end recording closing the toolbox and showing this window:

To facilitate identifying recordings in the Recordings view, rename New recording into another
recording name and click OK to apply.

Note: Each NetOp recording will automatically be saved in the Teacher User configuration files folder
screcord folder in a file named <Date and time>-Teacher-<Recording name>.dwr.

Record: Click to resume recording after Pause.

Pause: Click to pause recording.

Start/Stop NetOp marker utility: Click to make the button appear pressed in to load NetOp marker
utility on the Teacher computer. Click to make the button appear released to unload NetOp marker
utility.

Start/Stop microphone: Click to make the button appear pressed in to include Teacher computer
microphone input in the recording. Click to make the button appear released to exclude Teacher
computer microphone input.
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3.2.4 Class Control Panel

This is the Teacher window Class control panel:

It enables managing the running Class in views that you can select by clicking left view selection bar buttons:
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Details view: The upper Details view pane enables managing Class Students shown as
records with details in columns. The lower Groups pane enables managing Class Student
groups shown as icons or records.

Classroom view: The upper Classroom view pane enables managing Class Students shown
as named icons on an image background. The lower Groups pane enables managing Class
Student groups shown as icons or records.

Thumbnails view: The upper Thumbnails view pane enables managing Class Students shown
as named computer screen miniature images on an image background. The lower Groups
pane enables managing Class Student groups shown as icons or records.

Lesson plan view: Enables creating, managing and executing Class Lesson plans.

Recordings view: The upper Recordings view pane enables managing Class screen image
Recordings. The lower Groups pane enables managing Class Student groups shown as icons
or records.

Tests view: The upper Tests view pane enables managing Class Tests, Surveys and their
Results. The lower Groups pane enables managing Class Student groups shown as icons or
records.

Activity view: The upper Activity view pane enables managing which Applications and
Websites Class Students shown as records are running. The lower Active applications and
sites pane enables managing which applications and websites shown as records are run by
which Class Students.

Class setup view: The upper Class setup view pane enables managing Class Students and
Student groups shown as icons in a Class structure. The lower Available students pane
enables managing Students that are available for any Class.
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3.2.4.1 Details View

This is the Class control panel Details view:

It enables you to manage Class Students shown as records and Student groups.

A moveable horizontal separation divides it into two panes:

· The upper Details view pane enables you to manage Class Students shown as table records.

· The lower Groups pane enables you to manage Class Student groups shown as icons or table records.
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3.2.4.1.1  Details View Pane

This is the Details view pane:

Its title bar will show the names of the view and the running Class.

Click the Change class down pointer button to the right of the Class name to open the Change class menu.

The title bar right end will show a part/whole button:

Click it to switch between part mode without the upper right sector and whole mode with the upper right
sector. In part mode, only connected Students will be shown in the pane. In whole mode, also
unconnected Student members of the Class will be shown.

Class Students will be shown as records in a table with these column contents:

· Status: Icons will indicate Student status:

 Unconnected.

 In a Demonstrate session.

 In an Attention session.

 In a Remote control session.

 In a Monitor session.

 In an Audio-video chat session.

 In a Chat session.

 Assistant Teacher in a Workgroup session.

 In a Distribute files session.

 In a Collect files session.
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 In a File manager session.

 Has a pending Help request.

· Student display name: Student name as selected in the Options window General tab Student display name
section.

· Windows login name: Student computer Windows user login name.

· Computer name: Student computer Windows name.

· Policy: Student applied Policy name or None.

· Information: Any Student status messages such as a Help request message.

You can add up to two more custom columns from the Options window General tab Display custom columns
in details view section.

To execute an action with a connected Student, click its record to highlight it as selected and click a Toolbar
button or button menu command, Action menu command or Selected view menu command or right-click its
record and click a Student context menu command.

To start a Remote control session with a connected Student, double-click its record.

To execute an action with multiple connected Students, select Students by one of these methods:

· Click one record and while pressing the SHIFT key click another record to select clicked and in between
records connected Students.

· Click records while pressing the CTRL key to select clicked records connected Students. 

· From outside records, drag a dotted rectangle to select connected Students whose records are covered by
the rectangle.

Selecting connected Students will enable all available Toolbar buttons and Action menu commands. Click a
button or command to execute the action with selected Students.

Note: To execute an action with multiple Students, it may be faster and easier to create a Student group for
this purpose.

3.2.4.1.2  Change Class Menu

In the Class control panel upper pane title bar, click the down pointer button to the right of the Class name to
show this Change class menu:

It contains these commands:

· <Running class>: Will be included unless the Options window Class tab Use class server box is checked.
The running Class disabled name will be check marked.

· <Previous class>: Will be included unless the Options window Class tab Use class server box is checked.
Up to ten enabled names of previously run Classes can be included. Click a previously run Class name to
end running the <Running class> to start running the clicked name Class.

Caution: Changing the Class will disconnect connected Students.

· Show all classes: Will be enabled unless the Options window Class tab Use class server box is checked.
Click to show this window:



126

NetOp Teacher

It enables you to select a Teacher specified Class.

The pane will contain the names of available Teacher specified Classes.

Select a Class name and click OK to end the running Class to start the selected Class.

Caution: Changing the Class will disconnect connected Students. 

· Ask class server: Will be enabled if the Options window Class tab Use class server box is checked. Click
to show the Select class window.

· Options: Click to show the Options window Class tab.

3.2.4.1.3  Groups Pane

This is the Class control panel Groups pane:

It enables you to manage Student groups.

Right-click in the pane outside a Student group icon or record to show this menu:

It contains these commands:

· Large icons: Click to show Student groups as horizontal rows of large icons.
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· Small icons: Click to show Student groups as horizontal rows of small icons.

· List: Click to show Student groups as vertical columns of small icons.

· Details: Click to show Student groups as records in a table with these column contents: 

· Group name: Student group name.

· Member count: Student group number of members.

· Members: Student group members' Student display name.

· Create group: Click to show this window:

 

Specify the Student group name and click OK to create the Student group.

Note: You can edit or delete a Student group in Class setup view.

The Groups pane will always contain an All Student group that contains all Students in the Class.

You can add Students to a Student group by dragging their View pane records, icons or thumbnails to a
Groups pane Student group record or icon and drop them. Each Student can be a member of multiple
Student groups.

To execute actions with connected Students in a Student group, right-click the Student group icon or record
to show the Student group context menu. It will also contain a Delete command by which you can delete the
Student group.

To execute actions with connected Students in multiple Student groups, select Students by one of these
methods:

· Click a Student group icon or record to select it and connected Students in it.

· Click Student group icons while pressing the SHIFT or CTRL key to select them and connected Students in
them. 

· Click one Student group record and while pressing the SHIFT key click another Student group record to
select clicked and in between records Student groups and connected Students in them.

· Click Student group records while pressing the CTRL key to select clicked records Student groups and
connected Students in them.

· From outside icons or records, drag a dotted rectangle to select Student groups whose icons or records
are covered by the rectangle and connected Students in them. 

· Click the All Student group to select all connected Students in the Class.

This will enable all available Toolbar buttons and Action menu commands.
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3.2.4.1.4  Student Context Menu

Right-click a connected Student Details view record, Classroom view icon or Thumbnails view thumbnail to
show this context menu:

It enables you to execute actions with the right-clicked Student from these commands:

· Demo this student: Will be enabled if at least one other connected Student is selected. Click  to
Demonstrate the right-clicked Student desktop to other selected Students.

· Apply attention on this student: Click to start an Attention session with the Student.

· Monitor this student: Click to start a Monitor session with the Student.

· Remote control this student: Click to start a Remote control session with the Student.

· Chat with this student: Click to start a Chat session with the Student.

· Audio-video chat with this student: Click to start an Audio-video chat session with the Student.

· Send message to this student: Click to create a NetOp message to the Student.

· Stop workgroup session: Will be enabled if the Student is assistant Teacher in a Workgroup. Click to end
the Workgroup session.

· Move this student to another class: Click to show this window:
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It enables you to temporarily move the Student to a running Class on another computer.

· To temporarily move the Student to a specific name running Class of a Teacher that the Student can
reach by browse communication, click Class name, specify the Class name and click Move.

· To temporarily move the Student to the running Class of a specific address Teacher, click Teacher IP
address or DNS name, specify the Teacher computer IP address or DNS name and click Move.

If the Class is not found and when the moved to Class ends running, the Student will return.

· Run a test on this student: Will expand into available Tests. Click one to run it on the Student.

· Run a survey on this student: Will expand into available Surveys. Click one to run it on the Student.

· Run a program on this student: Will expand into the Run menu Run program elements. Click one to run it
on the Student.

· Execute command on this student: Will expands into the Commands menu. Click a command to execute it
on the Student.

· Collect files from this student: Click to start a Collect files session with the Student.

· Distribute files to this student: Click to start a Distribute files session with the Student.

· Distribute files on clipboard: Will be enabled if files are stored on the Teacher computer clipboard. Click to
Distribute the Teacher computer clipboard contents to the most recently specified Student computer file
location.

· File transfer with this student: Click to start a File manager session with the Student.

· Clear help request: Will be enabled if a help request from this Student is pending. Click to cancel the help
request on Teacher and Student.

Note: The menu can contain additional View specific commands. Commands will be disabled if unavailable
with the current Teacher status.

3.2.4.1.5  Student Group Context Menu

Right-click a Groups pane Student group icon or record to show this context menu:

It enables you to execute actions with the connected Students in the right-clicked Student group from these
commands:

Note: If no Students in the Student group are connected, the menu will contain only Create group and Delete
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.

· Demo to this group: Will expand into the Demonstrate menu. Click an element to start a Demonstrate
session with the Student group connected Students.

· Apply attention on this group: Click to start an Attention session with the Student group connected
Students.

· Monitor this group: Click to start a Monitor session with the Student group connected Students.

· Chat with this group: Click to start a Chat session with the Student group connected Students.

· Audio-video chat with this group: Click to start an Audio-video chat session with the Student group
connected Students.

· Send message to this group: Click to create a NetOp message to the Student group connected Students.

· Workgroup session for this group: Click to start a Workgroup session with the Student group connected
Students.

· Move this group to another class: Click to show this window:

It enables you to temporarily move the Student group connected Students to a running Class on another
computer.

· To temporarily move the Student group connected Students to a specific name running Class of a
Teacher that the Student group connected Students can reach by browse communication, click Class
name, specify the Class name and click Move.

· To temporarily move the Student group connected Students to the running Class of a specific address
Teacher, click Teacher IP address or DNS name, specify the Teacher computer IP address or DNS
name and click Move.

If the Class is not found and when the moved to Class ends running, the Student group connected
Students will return.

· Run a test on this group: Will expand into available Tests. Click one to run it on the Student group
connected Students.

· Run a survey on this group: Will expand into available Surveys. Click one to run it on the Student group
connected Students.

· Run a program on this group: Will expand into the Run menu Run program elements. Click one to run it on
the Student group connected Students.

· Execute command on this group: Will expands into the Commands menu. Click a command to execute it
on the Student group connected Students.

· Distribute files to this group: Click to start a Distribute files session with the Student group connected
Students.

· Collect files from this group: Click to start a Collect files session with the Student group connected
Students.
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· Distribute files on clipboard: Will be enabled if the Teacher computer clipboard contains files. Click to start
a Distribute files session with the Student group connected Students using clipboard Source files.

· Create group: Click to show the New folder window to create a Student group.

· Delete: Click to show a confirmation window to confirm deleting the Student group.

Note: Commands will be disabled if unavailable with the current Teacher status.

3.2.4.2 Classroom View

This is the Class control panel Classroom view:

It enables you to manage Class Students shown as icons and Student groups.

A moveable horizontal separation divides it into two panes:

· The upper Classroom view pane enables you to manage Class Students shown as named icons on an
image background.

· The lower Groups pane enables you to manage Class Student groups shown as icons or table records.
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3.2.4.2.1  Classroom View Pane

This is the Classroom view pane:

Its title bar will show the names of the view and the running Class.

Click the Change class down pointer button to the right of the Class name to open the Change class menu.

The title bar right end will show a part/whole button:

Click it to switch between part mode without the upper right sector and whole mode with the upper right
sector. In part mode, only connected Students will be shown in the pane. In whole mode, also
unconnected Student members of the Class will be shown.

Class Students will be shown as these variants of named icons:

Connected: The Student is connected to the Class but not in session.

Unconnected: The Student is recognized as a member but currently not connected to the Class.

In session: The Student is connected to the Class and in one or multiple sessions.

Help request: The Student is connected to the Class with a pending Help request.

Students will preferably be named by their Student display name. If no name of the Student display name
type was specified when the Student record was created, the name with which the Student record was
created will be enclosed in brackets.

You can drag Student icons all over the pane. If the pane size has been reduced to leave Student icons
outside the visible part of the pane, the pane will have scrollbars.
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Right-click in the pane to show this context menu:

Note: Any other commands in the menu belong to the Student context menu.

Click Set background bitmap to show this window:

It enables you to manage the background image in these elements: 

Bitmap

þ Enable background bitmap: Leave checked to use a background image. Uncheck to use a white
background and disable the other window options.

þ Tile background bitmap: Leave checked to repeat a small background image as tiles covering the entire
pane. Uncheck to show the background image only in the upper left corner of the pane.

[] [Browse]: Click [Browse] to show a Windows Open window to select a .bmp image file to show its path in
the field.

Tip: The Media folder in the folder in which the Teacher is installed contains multiple .bmp background
image files. Some users create their own classroom plan or geographical map image for the Student icon
background.

To execute an action with a connected Student, click its icon to highlight it as selected and click a Toolbar
button or button menu command, Action menu command or Selected view menu command or right-click its
record and click a Student context menu command.

To start a Remote control session with a connected Student, double-click its icon.

To execute an action with multiple connected Students, select Students by one of these methods:

· Click icons while pressing the SHIFT or CTRL key to select clicked icons connected Students. 

· From outside icons, drag a dotted rectangle to select connected Students whose icons are covered by the
rectangle.

Selecting connected Students will enable all available Toolbar buttons and Action menu commands. Click a
button or command to execute the action with selected Students.

Note: To execute an action with multiple Students, it may be faster and easier to create a Student group for
this purpose.
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3.2.4.3 Thumbnails View

This is the Class control panel Thumbnails view:

It enables you to manage Class Students shown as computer screen miniature images and Student groups.

A moveable horizontal separation divides it into two panes:

· The upper Thumbnails view pane enables you to manage Class Students shown as named computer
screen miniature images on an image background.

· The lower Groups pane enables you to manage Class Student groups shown as icons or table records.
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3.2.4.3.1  Thumbnails View Pane

This is the Thumbnails view pane:

Its title bar will show the names of the view and the running Class.

Click the Change class down pointer button to the right of the Class name to open the Change class menu.

The title bar right end will show a part/whole button:

Click it to switch between part mode without the upper right sector and whole mode with the upper right
sector. In part mode, only connected Students will be shown in the pane. In whole mode, also
unconnected Student members of the Class will be shown.

Class Students will be shown as these variants of named computer screen miniature images:

Connected: The Student is connected to the Class.

Unconnected: The Student is recognized as a member but currently not connected to
the Class.

Students will preferably be named by their Student display name. If no name of the Student display name
type was specified when the Student record was created, the name with which the Student record was
created will be enclosed in brackets.

Right-click in the pane to show this context menu:
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Note: Any other commands in the menu belong to the Student context menu.

It contains these commands:

· Thumbnail: Expands into thumbnail sizes in pixels width times height with a check mark next to the
selected size and Customize. Click a size to apply it to thumbnails in pane. Click Customize to show this
window:

It enables you to create a customized thumbnail in these elements:

· Width [] X []: Specify the thumbnail pixels width in the field and the horizontal pixels spacing between
thumbnails in the spin box.

· Height:[] Y:[]: Specify the thumbnail pixels height in the field and the vertical pixels spacing between
thumbnails in the spin box.

· Colors: Select in the drop-down box the number of thumbnail colors from 16 to 16777216.

· Update interval [] s: Specify the image update interval in seconds in the spin box. Use the controls to
adjust the update interval

Note: Smaller thumbnails, fewer colors and a longer update interval will generate less network traffic.
When applied, a customized thumbnail size will appear in the list of thumbnail sizes.

· Sort: Expands into these commands, one of which will be check marked as the currently selected option:

· None: Thumbnails in horizontal rows from the upper left pane corner will not be sorted.

· Ascending: Thumbnails in horizontal rows from the upper left pane corner will be sorted alphabetically
ascending.

· Descending: Thumbnails in horizontal rows from the upper left pane corner will be sorted alphabetically
descending.

· Floating: You can drag thumbnails all over the pane. If the pane size has been reduced to leave
thumbnails outside the visible part of the pane, the pane will have scrollbars.

· Display group first: Expands into None and the names of available Student groups, one of which will be
check marked as the current selection. Click a Student group name to place the thumbnails of its Student
members before other thumbnails placed in horizontal rows from the upper left pane corner.

· Set background bitmap: Click to show this window:
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It enables you to manage the background image in these elements: 

Bitmap

þ Enable background bitmap: Leave checked to use a background image. Uncheck to use a white
background and disable the other window options.

þ Tile background bitmap: Leave checked to repeat a small background image as tiles covering the entire
pane. Uncheck to show the background image only in the upper left corner of the pane.

[] [Browse]: Click [Browse] to show a Windows Open window to select a .bmp image file to show its path in
the field.

Tip: The Media folder in the folder in which the Teacher is installed contains multiple .bmp background
image files. Some users create their own classroom plan or geographical map image for the Student
thumbnail background.

To execute an action with a connected Student, click its thumbnail to highlight it as selected and click a
Toolbar button or button menu command, Action menu command or Selected view menu command or
right-click its record and click a Student context menu command.

To start a Remote control session with a connected Student, double-click its thumbnail.

To execute an action with multiple connected Students, select Students by one of these methods:

· Click thumbnails while pressing the SHIFT or CTRL key to select clicked icons connected Students. 

· From outside thumbnails, drag a dotted rectangle to select connected Students whose thumbnails are
covered by the rectangle.

Selecting connected Students will enable all available Toolbar buttons and Action menu commands. Click a
button or command to execute the action with selected Students.

Note: To execute an action with multiple Students, it may be faster and easier to create a Student group for
this purpose.
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3.2.4.4 Lesson Plan View

This is the Class control panel Lesson plan view:

It enables you to create, manage and execute Lesson plans that facilitate running a Class smoothly by using
prepared Lesson actions that shall be executed during the Class.

Its title bar will show the names of the view and the running Class.

Click the Change class down pointer button to the right of the Class name to open the Change class menu.

The title bar right end will show <No lesson plan selected> or the selected Lesson plan name.

Click the down pointer button to the right of <No lesson plan selected> or the selected Lesson plan name to
show the Change lesson plan menu.

Click the title bar far right Execute button ( ) to execute the Lesson action whose record is selected in the
table below. 

The table will contain Lesson action records with these column details:

· Description: Toolbar button action type icon, execution icon (Undone (nothing), Done ( ) or Disabled ( ))
and Lesson action description.

· Action: Action menu or Toolbar button action type name.

· Details: Action option name, if applicable.

· Student/Group: Name of the Student or Student group on which the Lesson action will be executed.

· Notes: First line of the Lesson action notes.

The Notes pane below will show the complete selected Lesson action record notes.

Right-click a Lesson action record to show this context menu:
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It will contain some or all of these commands:

· Execute: Will be disabled if the selected Lesson action record is marked Done ( ) or Disabled ( ). Click,
click the Lesson plan view title bar far right Execute button ( ) or double-click the Lesson action record to
execute the Lesson action.

· Add: Click to show the Lesson action window to add a Lesson action record below the selected Lesson
action record.

· Edit: Click to show the Lesson action window to edit the selected Lesson action record.

· Delete: Click to delete the selected Lesson action record.

· Disable/Enable: Click to disable/enable the selected Lesson action record marking it accordingly.

· Mark as done/undone: Click to mark the selected enabled Lesson action record as Done ( ) or Undone
(nothing).

· Move up (-): Click or press - (minus) to move the selected Lesson action record one step up.

· Move down (+): Click or press + (plus) to move the selected Lesson action record one step down.

3.2.4.4.1  Change Lesson Plan

Click the Lesson plan view title bar Change lesson plan down pointer to show this Change lesson plan menu:

It enables you to manage Lesson plans from these commands.

· The upper menu section can contain the disabled and check marked name of the selected Lesson plan
and the names of up to ten previously selected Lesson plans. Click a previously selected Lesson plan to
select it to show it in the Lesson plan view.

· Show all lesson plans: Click to show this window:
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The pane will contain all Lesson plans of the running Class. Select a Lesson plan and click Select to show
it in the Lesson plan view.

Manage lesson plans: Click to show this window:

It enables you to create, copy, delete and select Lesson plans in these elements:

· The pane will contain all Lesson plans of the running Class.

· New: Click to show this window:

Specify a Lesson plan name and click OK to create an empty Lesson plan.

· Copy: Select a Lesson plan in the pane and click to show the Lesson plan window. Specify a Lesson
plan name and click OK to create a copy of the selected Lesson plan.

· Delete: Select a Lesson plan in the pane and click to delete it.

· Select: Select a Lesson plan in the pane and click to show it in the Lesson plan view.
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· Close: Click to close the window without showing the selected Lesson plan in the Lesson plan view.

Note: Lesson plan .xml files will by default be stored in the Teacher User configuration files Lessonpl folder.
You can change the Lesson plan files folder in the Options window Sharing tab Lesson plans element.

3.2.4.4.2  Lesson Action

Click the Lesson action menu Add or Edit command to show this window:

It enables you to create or edit a Lesson action record in these elements:

· Action []:  The drop-down box list will contain available Toolbar button icons and names. Click the Toolbar
button icon and name under which to specify the desired action to show it in the field as selected. If options
are available under the selected Toolbar button, a [Configure] button will be available. Click it to show the
Toolbar button options window to select an option to show it or its selection elements under the Action
drop-down box. Complete available selections to specify the action.

· Student/Group []: Depending on the specified action, the drop-down box list will contain available Student
or Student group names. Click one to show it in the field to execute the action on the shown Student or
Student group Student members.

· Description []: Specify what shall identify the Lesson action in the Lesson plan view table Description
column.

· Notes []: Specify in the pane the notes that shall accompany the Lesson action.
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3.2.4.5 Recordings View

This is the Class control panel Recordings view:

It enables you to manage and play back NetOp recordings and manage Student groups.

A moveable horizontal separation divides it into two panes:

· The upper Recordings view pane enables you to play back and manage Class NetOp recordings.

· The lower Groups pane enables you to manage Class Student groups shown as icons or table records.
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3.2.4.5.1  Recordings View Pane

This is the Recordings view pane:

Its title bar will show the names of the view and the running Class.

Click the Change class down pointer button to the right of the Class name to open the Change class menu.

The left folders pane will initially contain a Recordings root folder. Right-click in the folders pane to show this
context menu:

It contains these commands:

· Cut: Select a user created folder and click to remove the folder with its contents to place it on the
clipboard.

· Copy: Select a folder and click to place a copy of the folder with its contents on the clipboard.

· Paste: Click to paste the clipboard contents into the selected folder.

· New folder: Click to create a folder in the selected folder showing this window:

Specify the folder name and click OK to create.

· Delete: Select a folder and click to show a confirmation window to confirm deleting the folder with its
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contents.

· Rename: Select a folder and click to show this window:

Edit the folder name and click OK to rename

Note: New NetOp recordings will by default be saved in the Teacher User configuration files folder
screcord folder <Class name> folder to appear as records in the Recordings root folder. You can change
the recordings files folder in the Options window Sharing tab Recordings element.

The right records pane will show selected folder recording records in a table with these column contents:

· Name: Recording icon and recording name.

· Recorded: Recording date and time.

· Duration: Recording duration.

· Teacher: Recording type of NetOp module.

Right-click in the records pane to show this context menu:

It contains these commands:

· Local playback: Click to play back the most recently clicked record recording in the Recording playback
window.

· Rename: Click to rename the most recently clicked record recording in this window:

Edit the recording name and click OK to rename.

· Cut: Select one or multiple (pressing SHIFT or CTRL) records and click to remove records to place them
on the clipboard.

· Copy: Select one or multiple (pressing SHIFT or CTRL) records and click to place a copy of them on the
clipboard.
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· Paste: Click to paste the clipboard contents into the records pane.

· New: Expands into:

· Local recording: Click to start a Record session.

· Folder: Click to show the New folder window to create a folder in the selected folder.

· Delete: Select one or multiple (pressing SHIFT or CTRL) records and click to show a confirmation
window to confirm deleting them.

Drag or press CTRL and drag selected records to a folder and drop them to move or copy selected records
to the folder.

Drag records to a Groups pane Student group and drop them to distribute record recording files to Student
group connected Students.

Double-click a record to play back the record recording in the Recording playback window.

Note: You can create a .avi screen video with NetOp screen video.

3.2.4.5.2  Recording Playback

In the Teacher Recordings view pane records pane, double-click a record or click the context menu Local
playback command or in the Student Recordings tab records pane double-click a record or click the context
menu Playback recording command to play back the recording in this window:

Note: If you run a Demonstrate Recording session, the recording will play back in the same window on the
Teacher. 
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The window title bar will next to the window name show the Recording name.

The toolbar below contains these playback controls:

Stop: Click, click the title bar menu Stop command or use a window Close control to stop playing the
recording and close the window. 

Pause: Click or click the title bar menu Pause command to pause playing the recording.

Play: Click or click the title bar menu Play command to start or resume playing the recording.

Back: Click or click the title bar menu Back command to return to the beginning of the recording.

Speed: Use the up/down controls to multiply the playback speed by a factor up to x20.

The automatically scrolling pane will have scrollbars.

The bottom status bar has a colored blocks progress indicator and will show elapsed playing time in the
format HH:MM:SS.

3.2.4.6 Tests View

This is the Class control panel Tests view:

It enables you to create, manage and execute Class Tests and Surveys and manage their Results and
manage Student groups.

A moveable horizontal separation divides it into two panes:

· The upper Tests view pane enables you to create, manage and execute Class Tests and Surveys and
manage their Results.

· The lower Groups pane enables you to manage Class Student groups shown as icons or records.
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3.2.4.6.1  Tests View Pane

This is the Tests view pane:

Its title bar will show the name of the view, initially with the addition (Public), and the name of the running
Class.

Click the Change class down pointer button to the right of the Class name to open the Change class menu.

The left folders pane will initially contain a Tests root folder. Right-click in the folders pane to show this
context menu:

It contains these commands:

· Cut: Select a user created folder and click to remove the folder with its contents to place it on the
clipboard.

· Copy: Select a folder and click to place a copy of the folder with its contents on the clipboard.

· Paste: Click to paste the clipboard contents into the selected folder.

· New folder: Click to create a folder in the selected folder showing this window:
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Specify the folder name and click OK to create.

· Delete: Select a user created folder and click to show a confirmation window to confirm deleting the
folder with its contents.

· Rename: Select a user created folder and click to show this window:

Edit the folder name and click OK to rename.

· Public tests: Click to show (Public) in the Tests view pane title bar to show in the pane only folders and
records that are shared by all users of the Teacher computer. Public folders and tests will be stored in
an All Users User configuration files folder Tests sub-folder.

· Private tests: Click to show (Private) in the Tests view pane title bar to show in the pane only folders and
records that are private to the user logged in to the Teacher computer. Private folders and tests will
initially be stored in a personal User configuration files folder Tests sub-folder.

· Private folder: Click to show a Browse for folder window that initially will show the path to your initial
private Tests sub-folder. Select another folder to make it your private folder.

The right records pane will show selected folder records on three tabs named Tests, Results and Surveys in
a table with these column contents:

· Name: Test or Survey name, on the Results tab also run date and time.

· Author: Test or Survey author name (optional, not on the Results tab).

· Time: Test or Survey most recent modification date and time (not on the Results tab).

· Description: Test or Survey description (optional, not on the Results tab).

· Class: Test or Survey run Class name (Results tab only).

· Score: Test or Survey run average score percentage (Results tab only).

· Group: Test or Survey run Student group name, if applicable (Results tab only).

Right-click in the records pane to show this context menu:

It contains these commands:

· Rename: Select a record and click to rename it in this window:
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Edit the Test or Survey name and click OK to rename.

· Edit: Not included on the Results tab. Select a record and click or double-click the record to show the
Test designer or Survey window to edit the Test or Survey.

· Cut: Select one or multiple (pressing SHIFT or CTRL) records and click to remove records to place them
on the clipboard.

· Copy: Select one or multiple (pressing SHIFT or CTRL) records and click to place a copy of them on the
clipboard.

· Paste: Click to paste the clipboard contents into the records pane.

· New test: Included only on the Tests tab. Click to show the New test window.

· View: Included only on the Results tab. Click to show the Test report window.

· New survey: Included only on the Surveys tab. Click to show the New survey window.

· Delete: Select one or multiple (pressing SHIFT or CTRL) records and click to show a confirmation
window to confirm deleting them.

· Properties: Not included on the Results tab. Select a record and click to show a read-only Options
window to view Test or Survey properties.

Double-click a Result record to show the Test report window.

Drag or press CTRL and drag selected records to a folder and drop them to move or copy selected records
to the folder.

You can run a Test or Survey:

· on Student group connected Students by dragging a Test or Survey record to a Groups pane Student
group and drop it.

· from the Action menu Run test command.

· from a Toolbar Run menu Run test or Run survey sub-command.

· from a Student context menu Run a test on this student or Run a survey on this student command.

· from a Student group context menu Run a test on this group or Run a survey on this group command.
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Tests

The Tests view pane Tests tab will initially include a SampleTest that illustrates the available Question types.

To create a Test, click the Tests view pane Tests tab context menu New test command to show this window:

Specify the Test Name and optionally a  Description.

Note: The Name in capital letters and any Description will be shown in the NetOp test window when the Test
opens on Student computers.

 Click OK to show this window:
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To work in the Test designer window instead of in the Test wizard, click Advanced.

Click Next to show this window:
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It enables you to create the Test Questions. Click Add to show this window:

Its pane contains named icons of available Question types:

· Drop-down list: To answer the Question, click a drop-down box list element.
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· Essay: To answer the Question, write a text.

· Label image: To answer the Question, drag labels and drop them on matching image elements.

· Match image: To answer the Question, drag images and drop them next to a matching text.

· Match text: To answer the Question, drag text elements and drop them in a matching vacant position in
a text.

· Multiple choice: To answer the Question, click one, alternatively multiple answer options.

· Ordering: To answer the Question, drag elements and drop them in the correct order.

· Question and answer: To answer the Question, write an answer.

· Text completion: To answer the Question, from dictation write words into fields to complete a text.

Select a Question type and click OK to show a window like this:

This is a Question editor window that enables you to specify the details of each Question and its answer
options. Click OK to close the Question editor to show the Question as a record in the Test wizard
Questions window table.

Note: Click a Question type hotspot above to jump to the section that explains its Question editor.

The Test wizard Questions window table will contain Question records with these column details:

· Topic: An optional Question description specified in the Question editor.

· Type: The Question type selected in the Choose question type window.

· Resource: Yes if any Question resources are included, otherwise No.
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· Weight: The Question weight specified in the Scoring extension.

· Passed: The Question passed score specified in the Scoring extension.

To remove a Question record, select it and click Remove.

Before continuing, click Scoring to show this Scoring lower extension of the window:

The graphic shows the Test composed of gray Question blocks. The width of each gray block represents the
Question weight (percent of Test) and the gray block height represents the Question passed score (percent
correct). The selected Question block will be darker than the others. Click a block to select it. You can drag
the internal borders of the selected Question block to adjust its Question weight and Question passed score.
You will notice that the Question weight and Question passed score figures to the right and in the table above
will change in concert with your changes in the graphic.

You can also change the figures to the right and press ENTER to recalculate.

A Question answer will count as Passed if its score passes the Question passed score, otherwise as Failed.
The sum of Passed Question weights will typically make up the Test score that will be compared with the
specified Test passed score.

If you check the Award negative box, Failed Question answers will count negatively. The sum of Passed
Question weight minus the sum of Failed Question weight percentages will make up the Test score that will
be compared with the specified Test passed score.

Click Next to show this window:
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It enables you to select the colors and patterns style of the NetOp test window in which the Test will be
shown on Students.

Click Next to show this window:
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It enables you to specify Test options in these elements:

· Description []: You can edit the Test Description.

Settings

· Author []: Optionally, select a Test author name in the drop-down box list or specify it in the field.

· Created/Modified: Will show the dates and times the Test was created and most recently modified.

· Test type: Select your preferred option in the drop-down box list to show it in the field:

· Unrestricted: The NetOp test window shown on Students will include a table of contents to enable the
user to return and change answers to previous Questions.

· Restricted: The NetOp test window shown on Students will include no table of contents. The user can
only run the Test from begin to end without returning to previous Questions.

· Time limit [] Minutes: To apply a time limit in minutes for completing the Test, specify a number. The
remaining number of minutes will be shown to the Student user in the lower left corner of the NetOp test
window.

· þ Autostart test: Leave checked to automatically start the Test when distributed to Students and
automatically terminate the Test when all Students have submitted their answers. Uncheck to start and
terminate the Test manually from NetOp test monitor.

· þ Prompt for name before test begins: Leave checked to show a window on Students that requests the
user to specify a name before starting the Test.
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· þ Perform real-time reporting during test: Leave checked to show Students' Test performance real time in
NetOp test monitor.

· þ Send test result when: []: Leave checked to send the Test result (Score percentage and Passed Yes/No)
to Students. Select your preferred option in the drop-down box list to show it in the field:

· Test received: When each Student has submitted the Test and answers have been evaluated (as
Students finish the Test).

· Test terminated: When the Test has been terminated automatically or manually by closing the NetOp
test monitor window (all Students at the same time).

Click Finish to end the Test wizard closing the window.

This is the alternative Test designer:

Its table matches the Test wizard Questions window table.

The Add question, Remove question and Scoring buttons match Test wizard Questions window buttons. The
Add question button down pointer will show the Choose question type window contents in a menu.

The Style button will show the Test wizard Style window contents in a Style window.

The Options button will show the Test wizard Options window contents in an Options window.

Note: Private Test .nxt files will be stored in the user personal Teacher User configuration files Tests folder.
Public Test .nxt files will by default be stored in the All users Teacher User configuration files Tests folder.
You can change the public Test files folder in the Options window Sharing tab Tests - public folder element.
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Drop-Down List Question

In the Choose question type window or menu, select Drop-down list to show this Question editor:

It enables you to specify the properties of a Drop-down list Question in these elements:

· Topic (Optional) []: Optionally, specify a topic that will be shown in capital letters above the Question.

· Question/Instructions []: Specify the Question text and/or answering instructions.

· Text []: Specify a text that includes the true answer element. Select the true answer element and click
Select to emphasize it to include it  in a drop-down box list among false answer elements.

· False answers []: Click Add to show Write a false answer here highlighted in the pane. Overwrite by a false
answer element. You can add multiple false answer elements. To remove a false answer element, select it
and click Remove.

·  Time limit: Click to show this window:



159

NetOp Teacher

To set a time limit for answering this Question, check the box, specify a number in the field, click Seconds
or Minutes and click OK. To remove the time limit, click the button, uncheck the box and click OK.

·  Resources: Click to show this window:

It enables you to include file resources with the Question.

Click Add to show this window:
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Click [...] to show a Windows Open window to open a resource file to show its name in the Name field
and its path in the Source field. Click OK to add the resource file to show the Name field contents in the
Question resources window left pane.

Click a left pane resource name to preview resource contents in the right Preview pane.

Double-click a left pane resource name to show the Resource window to edit resource properties.

Click a left pane resource name and click Remove to remove the resource.

Note: Included file resources will be available in the NetOp test window below the Question.

·  Preview: Click to preview the Question in a maximized Preview window.

Click OK to insert the Question record in the Test Questions table.
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Essay Question

In the Choose question type window or menu, select Essay to show this Question editor:

It enables you to specify the properties of a Essay question in these elements:

· Topic (Optional) []: Optionally, specify a topic that will be shown in capital letters above the Question.

· Question/Instructions []: Specify the Question text and/or answering instructions.

Note: Answering an Essay question with any text will score as a correct answer regardless of the text
contents.

·  Time limit: Click to show the Time limit window.

·  Resources: Click to show the Question resources window.

·  Preview: Click to preview the Question in a maximized Preview window.

Click OK to insert the Question record in the Test Questions table.
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Label Image Question

In the Choose question type window or menu, select Label image to show this Question editor:

It enables you to specify the properties of a Label image question in these elements:

· Topic (Optional) []: Optionally, specify a topic that will be shown in capital letters above the Question.

· Question/Instructions []: Specify the Question text and/or answering instructions.

· Add image: Click to show a Windows Open window to open an image file to show the image in the Answer
pane.

· Add label: Click to add a label with the text Write label text here. Replace this text by the desired label text
and click outside the label. Drag the label to the desired position. You can add almost any number of
labels.

· Remove label: Click a label to select it. Click Remove label to remove the selected label.

·  Time limit: Click to show the Time limit window.

·  Resources: Click to show the Question resources window.

·  Preview: Click to preview the Question in a maximized Preview window.

Click OK to insert the Question record in the Test Questions table.
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Match Image Question

In the Choose question type window or menu, select Match image to show this Question editor:

It enables you to specify the properties of a Match image question in these elements:

· Topic (Optional) []: Optionally, specify a topic that will be shown in capital letters above the Question.

· Question/Instructions []: Specify the Question text and/or answering instructions.

· Add: Click to show a Windows Open window to open an image file to show the image in an Answer pane
section with the image to the left and a text area to the right. Specify in the text area the text that the image
shall match. Preferably add between three and six images. 

Note: All images will be shown in the size 100 x 100 pixels. Therefore, images should be trimmed to a
square shape and clearly show relevant details when resized to 100 x 100 pixels.

· Remove: Select an Answers pane section and click to remove it.

·  Time limit: Click to show the Time limit window.
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·  Resources: Click to show the Question resources window.

·  Preview: Click to preview the Question in a maximized Preview window.

Click OK to insert the Question record in the Test Questions table.

Match Text Question

In the Choose question type window or menu, select Match text to show this Question editor:

It enables you to specify the properties of a Match text question in these elements:

· Topic (Optional) []: Optionally, specify a topic that will be shown in capital letters above the Question.

· Question/Instructions []: Specify the Question text and/or answering instructions.

· Text []: Specify, typically by pasting clipboard text from another application by pressing CTRL+V, the entire
text in which Student users must match text elements. Select a text element, typically one or multiple
words, and click Select to emphasize the text element and show it in the Word list pane. You can select
almost any number of text elements. To unselect a selected text element, select it in the Text pane and
click Unselect.

·  Time limit: Click to show the Time limit window.

·  Resources: Click to show the Question resources window.
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·  Preview: Click to preview the Question in a maximized Preview window.

Click OK to insert the Question record in the Test Questions table.

Multiple Choice Question

In the Choose question type window or menu, select Multiple choice to show this Question editor:

It enables you to specify the properties of a Multiple choice question in these elements:

· Topic (Optional) []: Optionally, specify a topic that will be shown in capital letters above the Question.

· Question/Instructions []: Specify the Question text and/or answering instructions.

· Click Add to add an Answers pane section with a select button and a text area. Click the select button to
select it to select this answer as the correct answer. Specify in the text area the correct answer. Add
typically two to four more Answers pane sections with incorrect answers. To remove an Answers pane
section, select it and click Remove. 

· A Multiple choice question with round select buttons enables only one correct answer. To enable multiple
correct answers, check the Multiple correct answers box to replace round select buttons by square check
boxes. Correct answer boxes must be checked. Incorrect answer boxes must be unchecked.

· To show available answers in a random order in the NetOp test window, check the Random order box.

·  Time limit: Click to show the Time limit window.

·  Resources: Click to show the Question resources window.



166

NetOp Teacher

·  Preview: Click to preview the Question in a maximized Preview window.

Click OK to insert the Question record in the Test Questions table.

Ordering Question

In the Choose question type window or menu, select Ordering to show this Question editor:

It enables you to specify the properties of an Ordering question in these elements:

· Topic (Optional) []: Optionally, specify a topic that will be shown in capital letters above the Question.

· Question/Instructions []: Specify the Question text and/or answering instructions.

· Click Add to add an Answer pane section numbered 1 with a text area. Specify in the text area the word,
sentence or number that Student users must place first in the order of sections. Click Add again to add a
section numbered 2 below to specify the element that must be placed second, etc. In the NetOp test
window, unnumbered sections will be shown in a random order.

· To remove a section, select it and click Remove to automatically rearrange section numbering. A new
section will always be added at the bottom.

·  Time limit: Click to show the Time limit window.

·  Resources: Click to show the Question resources window.
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·  Preview: Click to preview the Question in a maximized Preview window.

Click OK to insert the Question record in the Test Questions table.

Question and Answer Question

In the Choose question type window or menu, select Question and answer to show this Question editor:

It enables you to specify the properties of a Question and answer question in these elements:

· Topic (Optional) []: Optionally, specify a topic that will be shown in capital letters above the Question.

· Question/Instructions []: Specify the Question text and/or answering instructions.

· Click Add to add an Answers pane section with a text area. Specify in the text area a correct answer. You
can add multiple sections with a correct answer. When creating the Question and correct answers, take
into account that for a specified answer to score as correct, it must exactly match an answer specified in
an Answers pane section.

· To remove a section, select it and click Remove.

·  Time limit: Click to show the Time limit window.

·  Resources: Click to show the Question resources window.

·  Preview: Click to preview the Question in a maximized Preview window.

Click OK to insert the Question record in the Test Questions table.
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Text Completion Question

In the Choose question type window or menu, select Text completion to show this Question editor:

It enables you to specify the properties of a Text completion question in these elements:

· Topic (Optional) []: Optionally, specify a topic that will be shown in capital letters above the Question.

· Question/Instructions []: Specify the Question text and/or answering instructions.

· Completion text []: Specify, typically by pasting clipboard text from another application by pressing CTRL
+V, the entire text in which Student users from dictation must type words into fields to complete the text.
Select a word and click Select to emphasize the word and show it in the Word list pane. You can select
almost any number of words. To unselect a selected word, select it in the Completion text pane and click
Unselect.

·  Time limit: Click to show the Time limit window.

·  Resources: Click to show the Question resources window.

·  Preview: Click to preview the Question in a maximized Preview window.

Click OK to insert the Question record in the Test Questions table.
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Surveys

To create a Survey, click the Tests view pane Surveys tab context menu New survey command to show this
window:

Specify a Survey Name that will be shown in capital letters when the Survey opens on Student computers
and click OK to show this window:

It enables you to specify the properties of a Survey in these elements:

Note: A NetOp School Survey consists of one Multiple choice question. No Styles or Options are available. 

· Topic (Optional) []: Optionally, specify a topic that will be shown in capital letters above the Question.

· Question/Instructions []: Specify the Question text and/or answering instructions.

· Click Add to add an Answers pane section with a select button and a text area. Specify the answer in the
text area. You can add multiple Answers pane sections with answers. To remove an Answers pane
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section, select it and click Remove. 

· A Multiple choice question with round select buttons enables selecting only one answer. To enable
selecting multiple answers, check the Multiple answers box to replace round select buttons by square
check boxes.

Note: A Survey asks for user attitudes, not for correct answers. Although scoring as such is therefore
irrelevant, you can use the scoring functionality to measure Survey bias towards the attitude of one or
multiple answer options.

·  Resources: Click to show the Question resources window.

·  Preview: Click to preview the Question in a maximized Preview window.

Click OK to insert the Survey record on the Test view pane Surveys tab.

Note: Private Survey .nxs files will be stored in the user personal Teacher User configuration files Tests
folder. Public Survey .nxs files will by default be stored in the All users Teacher User configuration files Tests
folder. You can change the public Survey files folder in the Options window Sharing tab Surveys - public
folder element.
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Results

When you start running a Test or Survey, this window will be shown on the Teacher computer screen:

It monitors Test and Survey progress in these elements:

·  Run: Will be green (enabled) if the selected Test or Survey is paused. Click to run the selected Test or
Survey. Will be gray (disabled) if the selected Test or Survey is running or stopped.

·  Pause: Will be green (enabled) if the selected Test or Survey is running. Click to pause the selected
Test or Survey. Will be gray (disabled) if the selected Test or Survey is paused or stopped.

·  Stop: Will be red (enabled) if the selected Test or Survey is running or paused. Click to stop the
selected Test or Survey to remove it on Students. Will be gray (disabled) if the selected Test or Survey is
stopped. You cannot restart a stopped Test or Survey.

·  : The list of this drop-down box will contain the names of active Tests or Surveys
. The buttons to the left will control the Test or Survey whose name is shown in the field. Select a name in
the list to change button control.

The pane will show these data for each active Test or Survey:
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· Test name: Test or Survey name.

· Passing score: The Test Scoring extension specified Test passed score, for a Survey always 100.00%.

· Student records in a table with these column details:

· User: Student name.

· Progress: For each Test Question a light bulb icon with these attributes:

· : Unanswered

· : Current

· : Question score passed the Test Scoring extension specified Question passed score

· : Question score failed the Test Scoring extension specified Question passed score

· Score: Current Test score

· Passed: Yes if the current Test score passed the Test Scoring extension specified Test passed score,
otherwise No.

To manually terminate active Tests and Surveys, close NetOp test monitor from a title bar Close window
control to show a confirmation window to confirm termination.

Upon manual or automatic termination, a Test will show this window:

Student records will show the Test passed  or failed  icon and score and individual Questions passed or
failed icons and scores. You can expand each Student record into its details:
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Wrong answers will be shown in red text.

Upon termination, a Survey will show this window (expanded):
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The upper section will show the number of hits on each answer from all Students that answered the Survey.

The Tests view pane Results tab will show the average score of each Test or Survey run:
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Click a record context menu View command or double-click a record to show detailed Test or Survey results
in the Test report window.

Note: Result .nxr files will be stored in the folder of the matching Test or Survey.

3.2.4.7 Activity View

This is the Class control panel Activity view:

It enables you to view and control which Applications and Websites are being used on Student computers.

Initially, the Activity view will be passive showing no activity details. The text Press start button will flash next
to the lower Active applications and sites bar Start activity control button. Click Start activity control to retrieve
connected Students information on running applications and viewed websites to show this information by
Student in the upper Activity view pane and by Application and Website in the lower Active applications and
sites pane.
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3.2.4.7.1  Activity View Pane

This is the Activity view pane:

Its title bar will show the name of the view and the name of the running Class.

Click the Change class down pointer button to the right of the Class name to open the Change class menu.

The title bar right end will show a part/whole button:

Click it to switch between part mode without the upper right sector and whole mode with the upper right
sector. In part mode, only connected Students will be shown in the pane. In whole mode, also
unconnected Student members of the Class will be shown.

Below, two tabs with Class Student record tables are available.

The Current applications tab table has these column contents:

· Student display name: Student name as selected in the Options window General tab Student display name
section. 

· Running applications: Icons of applications running on the Student computer with a red frame around the
active application icon.

· Current: The activity of the Student computer active application when it became the active application. 

· Policy: Student Policy name.

Right-click an application icon to show this menu:

It contains these commands:

Close: Click to unload the record Student computer application.

Deny: Click to unload the record Student computer application denying reloading it during this connection.

Hide: Click to hide the record Student computer application window until unhidden or end of connection.

Unhide: Click to unhide the hidden record Student computer application window.
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Properties: Click to show this record Student computer application window:

It will show the application program file path and activity title.

History: Click to show this all connected Student computer applications window:

It will show ordered by Student or by application the Started time, Stopped time and Duration of applications run
on connected Student computers since the Activity view was activated. Click Refresh to refresh data. Click Save
to show a Windows Save as window to save data in a comma separated values (.csv) file. Click Print to print out
data.

Task manager: Click to show this record Student computer window:
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This simplified two-tabs Task manager enables you to remotely view and end Student computer running
applications and processes.

The Current websites tab table has matching website column contents and the same context menu, the only
difference being that the Deny command is disabled.

3.2.4.7.2  Active Applications and Sites Pane

This is the Activity view Active applications and sites pane:

Its title bar contains these buttons:

 Stop activity control: Click to stop retrieving connected Students information on running Applications and
viewed Websites to stop showing this information in the panes.
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 Start activity control: Click to start retrieving connected Students information on running Applications and
viewed Websites to show this information in the panes.

Note: Clicking Stop activity control will not neutralize the effect of an issued Deny or Hide command.

The table has these column contents:

· Running applications: Application icon and name or Website URL. Different versions of the same
application may be shown in separate records. 

· Count: The number of Student computers on which the Application runs or the Website is shown.

· Students: The names of Students on whose computer the Application runs or the Website is shown.

Right-click a record to show this menu:

It contains these commands:

Close: Click to unload the record Application on all Student computers that run it.

Deny: Click to unload the record Application on all Student computers that run it denying reloading it
during this connection.

Hide: Click to hide the record Application window on all Student computers that run it until unhidden or
end of connection.

Unhide: Click to unhide the hidden record Application window.

History: Click to show the Application history window.

Refresh: Click to refresh the Active applications and sites pane contents.
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3.2.4.8 Class Setup View

This is the Class control panel Class setup view:

It enables you to set up Class Students and Student groups. 

A moveable horizontal separation divides it into two panes:

· The upper Class setup view pane will show Class Students as named icons in an All students element
and Student members of Student groups as shortcut icons in named Student group elements in a Student
groups element. 

· The lower Available students pane can show Students that are available for any Class as named icons or
table records.

3.2.4.8.1  Class Setup View Pane

This is the Class setup view pane:

Its title bar will show the name of the view and the running Class.

Click the Change class down pointer button to the right of the Class name to open the Change class menu.

The pane will contain these elements:

· A Student groups element that will expand into available named Student group elements that will expand
into named member Student shortcut icons.
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· An All students element that will expand into all Class Student icons.

Student icons and shortcut icons can show these attributes:

: Connected, not in session or help requested.

: Connected, in session or help requested.

: Unconnected.

Right-click to show this context menu:

It contains these commands:

· Cut: Will be enabled if an All students element Student icon or a Student group element Student shortcut
icon was right-clicked. Click to place the Student on the clipboard. If a Student shortcut icon was
right-clicked, it will be removed when pasting into another Student group element.

· Copy: Will be enabled if an All students element Student icon or a Student group element Student shortcut
icon was right-clicked. Click to place a copy of the Student on the clipboard to paste it into another Student
group element.

· Paste: Will be enabled if there are Students on the clipboard. Click to add clipboard Students to the All
students element and, if selected, to a Student group element.

· Add student to group: Will be enabled if a Student group element or a Student shortcut icon under it is
selected. Click to show this window:

The pane will contain records of all Class Students. Select a record and click OK to add the record Student
icon to the selected Student group element.

Note: Each Student can be a member of any number of Student groups. You can also add a Student to a
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Student group by dragging an All students icon Student icon to a Student group element and dropping it. In
the other views, you can add a Student to a Student group by dragging a Student record, icon or thumbnail
to a Groups pane Student group icon or record and dropping it.

· New: Will expand into these commands:

· Create student: Click to show this window:

It enables you to specify these properties of a new Student account:

· Student login name []: The name specified on the Student Options window Student login tab.

· PC name (computer name) []: Student computer name.

· Computer domain []: Student computer domain.

· Windows login name []: Student computer user Windows login name.

· Windows login domain []: Student computer user Windows login domain.

· Wake on LAN MAC address []: Student computer network card MAC address.

Note: You can start a Student computer equipped with a Wake on LAN network card from the
Teacher.

Note: You can create a Student account in the Student information window only if you specify at least
one of Student login name, Computer name or Windows login name. You should always specify the
Student login name because a connecting Student will be identified as an existing Student account only
if the connecting Student Student login name matches the existing Student account Student login name.
In that case, other existing Student account names will be overwritten by the matching names of the
connecting Student.

Click OK to close the window to add the new Student icon under the All students element and, if a
Student group element or a Student group element Student shortcut icon was selected, create a
matching Student shortcut icon under the Student group element.

Note: You can also create a Student account by making the Student connect to the Class after in the
Teacher Options window General tab Options section checking the Save new students between classes
box. You can also create a Student account by copying or dragging an available Student icon or record
from the Available students pane and pasting or dropping it in the Class setup view pane or on a Student
group element in it if the Student shall be a member of the Student group.

· Create group: Will be enabled if the Student groups element or a Student group element under it is
selected. Click to show this window:
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Specify the Student group name and click OK to create.

Note: In other views with a Groups pane, create a Student group from the Groups pane right-click
context menu.

· Delete: Will be enabled if Student icon, Student group element or Student shortcut icon is selected. Click to
show a confirmation window to confirm deleting the element. You cannot delete a connected Student icon.

Note: Deleting an All students element Student icon will delete the Student account and matching Student
shortcut icons under Student group elements. Deleting a Student group element will delete Student
shortcut icons under it. Deleting a Student shortcut icon will delete only that.

· Wake on LAN: Will be enabled if an All students element unconnected Student icon, an unconnected
Student shortcut icon, the All students element with unconnected Student icons under it or a Student group
element with unconnected Student shortcut icons under it is selected. Click to send a Wake on LAN
command to selected unconnected Students to start their computers if equipped with a Wake on LAN
network card whose MAC address is specified in their Student information window.

· Student information: Will be enabled if an All students element Student icon is selected. Click to show the
Student information window with the properties of the selected Student account. If you selected a
connected Student icon, the Student information window fields will be disabled so that you cannot change
their contents.

Note: You can start Action menu command and Toolbar button actions with one Student from a Class setup
view pane Student icon, but the Student context menu and the Student group context menu are unavailable.
Many more action options are available in the other views.

3.2.4.8.2  Available Students Pane

This is the Class setup view Available students pane:

Provided that the Options window General tab Options section Get available students box is checked, the
Available students pane will enable you to see, connect and invite available Students.

A Student that Joins class by the Options window Class tab Be available for any class option will
automatically connect to a running Class of which it is a member. If no Class of which the Student is a
member is running, the Student will - visibly in the Available students pane - be available for any Class.

The Available students pane will contain available Students as named icons or records.

You can select available Students by one of these methods:

· Click an icon or record to select it.

· Click icons while holding down the SHIFT or CTRL key to select them.

· Starting outside icons, drag a dotted rectangle to select icons covered by the rectangle.
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· Click one record and pressing the SHIFT key click another record to select clicked and in between records.

· Click one record and pressing the CTRL key click other records to select clicked records.

· Starting outside records, drag a dotted rectangle to select records covered by the rectangle.

Right-click selected available Students to show this menu:

It contains these commands:

· Copy: Will be enabled if available Students are selected. Click to copy selected available Students to the
clipboard to enable pasting them in the Class setup view pane.

Note: Pasting available Students on the clipboard in the Class setup view pane will connect them to the
Class and make them members of the Class. Alternatively, drag selected available Students to the Class
setup view pane and drop them. Pasting in or dropping on a Student group element will also make Students
members of the Student group.

· Invite: Will be enabled if selected available Students are not invited. Click or click the Available students

pane title bar  button to show this window:

It enables you to invite available Students to join the Class.

Optionally, specify in the pane an invitation text as shown and click OK to send the invitation. The Invite
button and the icons or records of available Students to which the invitation was sent will indicate that an
invitation is pending. This window will appear on invited available Students:
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The available Student user has the option to click OK to accept or Cancel to decline the invitation.

Note: If the Student user declines, the Student will remain in the Available students pane changing back
to its not invited appearance.

· Large icons: Click to show available Students as horizontal rows of large icons.

· Small icons: Click to show available Students as horizontal rows of small icons.

· List: Click to show available Students as vertical columns of small icons.

· Details: Click to show available Students as table records with these column contents:

· Computer name: Student computer name.

· Student login name: The name specified on the Student Options window Student login tab. 

· Windows login name: Student user Windows login name.

· Windows login domain: Student user Windows login domain.

· Address: Student computer IP address if using TCP/IP communication or MAC address if using IPX or
NetBIOS communication.

3.2.5 Status Bar

This is the Teacher window status bar:

When the mouse pointer is over a menu command, the status bar will show a hint to the command.

The right end of the status bar will show these indicators:

All students: The number indicates the number of Students in the Class.

Connected students: The number indicates the number of connected Students in the Class.

Selected students: The number indicates the number of selected Students in the Class.

Available students: The number indicates the number of available Students in the Available students
pane.

NetOp Name Server: Will be included if the Advanced TCP/IP configuration window Use NetOp
name server box is checked. These availability indicators can be shown on the yellow pages icon:

· Nothing: Selected NetOp Name Servers are available.
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· Red exclamation mark: One of two selected NetOp Name Servers is available.

· Red X: No NetOp Name Server is available.

3.2.6 Teacher Tools

This section explains Teacher tools in these sections:

· Options

· Help request

3.2.6.1 Options

Click the Tools menu Options command to show typically this window:

It provides access to Option tabs.

Right-click in the window pane to show this menu:

It contains these commands:

· Open: Will be enabled if an icon is right-clicked. Click or double-click an icon to show the Option tab
window.

· Large icons: Will be enabled from the small icons window shown below. Click to show the large icons
window shown above.

· Small icons: Will be enabled from the large icons window shown above. Click to show this small icons
window:
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· Options as tabs: Click to show this tabs window after closing and reopening the Options window:

To return to the icons window, click the Tools menu Options as icons command. 

The Options window contains these tabs:

· General

· Class

· Teachers
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· Protection

· Sharing

· Connection

· Menu/toolbar

· Web update

· Demonstrate

· Attention

· Control

· Audio-video chat

· Run

· Policy

3.2.6.1.1  General Tab

This is the Teacher Options window General tab:

It enables you to specify Teacher General properties in these elements:

Options

þ Save new students between classes: Check to retain Students that have connected to a Class as
members of the Class.

þ Get available Students: Check to make the Available students pane show Students that are available and
make available Students that are members of the Class connect to the Class.

Student display name

Click one of these options to identify Students in the Classroom view, Thumbnail view, Activity view and
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Class setup view by the selected name type.

¤ Student login name: The name type or name specified on the Student Options window Student login tab.

¡ Windows login name: The name by which the Student computer user is logged in to Windows.

¡ Computer name: The Windows name of the Student computer.

Note: if the selected name type of an unconnected Student is unavailable on the Teacher, the Student will be
identified by another name type in brackets.

Display custom columns in details view

¨ Check to enable the fields to the right to add the column specified in the fields in the Details view pane to
the right of the default columns. 

· Title []: Specify the column heading name.

· Column value []: Specify the environment variable or Windows registry key and value name whose value
shall appear in the column.

Connection password

· Specify a password to enable only Students whose Options window General tab Connection password
section contains the same password to connect.

3.2.6.1.2  Class Tab

This is the Teacher Options window Class tab:

It enables you to specify Teacher Class properties in these elements:

Class

· Class name []: Will be disabled if Use class server is checked. The drop-down box list will contain the
names of available Teacher specified Classes. Click one to show it in the field as selected to run the
selected Class when clicking OK.

Caution: Changing the Class will disconnect connected Students.
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· Add: Will be disabled if Use class server is checked. Click to show this window:

Specify the Class name in the field and click OK to create the Class showing its name in the Class name
drop-down box field.

· Copy: Will be disabled if Use class server is checked. Click to show the New class window to create a
Class with the Student members of the Class whose name is shown in the Class name drop-down box
field.

· Delete: Will be disabled if Use class server is checked. Click to delete the Class whose name is shown in
the Class name drop-down box field to show the next drop-down box list entry in the field. You cannot
delete the running Class.

¨ Use class server [Setup]: Check to disable the elements above to use a Class server Class specification
instead of a Teacher Class specification. Click [Setup] to show the Class server setup window to set up the
Teacher to use a Class server.

¨ Always select class at startup: Check to always show this Class tab when the Teacher is loaded. Leave
unchecked to:

· if the Use class server box is unchecked, run the Class that was running when the Teacher was last
unloaded.

· if the Use class server box is checked, show the Select class window. 

þ Notify when students join late: Leave checked to show this Windows taskbar notification area Teacher
icon notification if a Student connects to the running Class some time after it started running:

Auto join demo, monitor, chat and attention 

· Auto join []: Click in the drop-down box list one of these options to show it in the field as selected:

· No - never: Newly connected Students will not join an ongoing Demonstrate, Attention, Monitor,
Audio-video chat or Chat session.

· Yes - automatic: Newly connected Students will automatically join an ongoing Demonstrate, Attention,
Monitor, Audio-video chat or Chat session.

· Prompt before join: Show this window when a Student connects during an ongoing Demonstrate,
Attention, Monitor, Audio-video chat or Chat session.



191

NetOp Teacher

Click Yes to join the newly connected Student or No to not join.

Policy

Startup policy []: The drop-down box list will contain the names of available Policies in the Class selected in
the Class name drop-down box or if the Use class server box is checked in any Course or Lesson that is
available to the Teacher from the Class server. Click one to show it in the field to apply it to Students that
connect to the Class.

Class Server Setup

Click the Class tab Setup button to show this window:

It enables you to set up the Teacher to use NetOp School class management in these elements:

· Class server []: Specify the Class server ID specified on the used NetOp Class Server.

¨ IP address or DNS name (if on another subnet) []: If the used NetOp Class Server is on an IP subnet
different from the Teacher computer IP subnet, you must check the box and specify the NetOp Class Server
computer IP address or DNS name.

þ Extend lesson: Leave checked to enable the Teacher user to extend a Lesson beyond its scheduled end
time. Uncheck to disable.

Identify teacher by

Click one of these options for identifying the Teacher to the NetOp Class Server:

¤ Windows login name: By the name by which the Teacher user is logged in to Windows.

¡ Computer name: By the Teacher computer Windows name.

¡ Teacher profile name: By the Teacher user Teacher profile name.

Note: This selection must be compatible with the NetOp School class management Teacher identification.

When a Teacher that is set up to Use class server is loaded, it will request Class information from the used
NetOp Class Server to show this window:
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The Teacher user can at any time show this window from the Change class menu Ask class server
command. 

It enables the Teacher user to select an available Class to run it.

If NetOp School class management runs in Non-scheduled mode, the names of Courses to which the
Teacher is assigned will be shown in the pane. Select a Course name to show only the Teacher name in
the fields below. Click OK to run a Class of the selected Course.

If NetOp School class management runs in Scheduled mode, if a Lesson of a Course to which the Teacher
is assigned is running, the Course name will be shown in the pane. Select a Course name to show Lesson
From time, To time, Classroom name and Teacher name in the fields below. Click OK to run the selected
Course Lesson. If no Lesson of a Course to which the Teacher is assigned is running, the user can select
to show upcoming Course Lessons in the Select class window to select one to run it.

Click Cancel to close the window without changing the Class. If no Class was running before the Select
class window was shown, My class will run.
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3.2.6.1.3  Teachers Tab

This is the Teacher Options window Teachers tab:

It enables you to specify the use of Teacher profiles for authenticating Teacher users in these elements:

Authentication

¨ Use teacher profiles: Leave unchecked to not require users to log in to the Teacher. Check to require
users to log in to the Teacher to replace the Teacher name section below by a Teacher profiles section.

Note: Using Teacher profiles enables protecting the Teacher against misuse.

If the Use teacher profiles box is checked, the Authentication section will include this box:

¨ Validate using Windows security management: Leave unchecked to use NetOp teacher profiles. Check to
use Windows teacher profiles.

Teacher name

This section enables identifying the Teacher to Students by a title and a name:

Title []: Optionally, specify a title.

Name []: Optionally, replace the default name Teacher by another name.

Note: This title and name will apply to all users of the Teacher.
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NetOp Teacher Profiles

If on the Teachers tab the Use teacher profiles box is checked and the Validate using Windows security
management box is unchecked to use NetOp teacher profiles, the Teachers tab will contain these sections:

It enables you to specify NetOp teacher profiles in these Teacher profiles section elements:

Teacher profiles

· The table will contain NetOp teacher profile records with these column contents:

· User name: NetOp teacher profile user name.

· Add user: Click to show this window:

It enables you to specify a NetOp teacher profile in these elements:

Login
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· User name []: Specify the NetOp teacher profile user name by which the user must log in to the Teacher.

· Change password: Click to show this window:

· Change password for []: Will show the NetOp teacher profile User name.

· Old password []: Specify the current NetOp teacher profile password (initially none).

· New password []: Specify the new NetOp teacher profile password.

· Confirm password []: Re-specify the new NetOp teacher profile password for confirmation.

Note: Password characters will show as dots or asterisks. To require no password, leave the New
password and Confirm password fields empty.

Teacher name

This section enables identifying the Teacher to Students by a title and a name:

· Title []: Optionally, specify a title.

· Name []: Optionally, replace the default name Teacher by another name.

Note: This title and name will apply only to the NetOp teacher profile user.

Click OK to create the NetOp teacher profile showing the NetOp teacher profile User name in the Teacher
profiles section table.

· Edit: Select a table record and click to show the Teacher profile window to edit it.

· Delete: Select a table record and click to delete it.

If NetOp teacher profiles are used, this window will be shown in front of the Teacher window when loading
the Teacher and after logging off from the Teacher:

Specify your NetOp teacher profile User name and Password and click OK to log in to the Teacher. 

Note: If NetOp teacher profiles are used, the NetOp teacher profile User name will replace the running Class
name in the Teacher window Title bar.

To log off from the Teacher, select the Tools menu Log off command that will be is included in the Tools
menu only if NetOp Teacher profiles or Windows teacher profiles are used.
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Windows Teacher Profiles

If on the Teachers tab the Use teacher profiles box is checked and the Validate using Windows security
management box is checked to use Windows teacher profiles, the Teachers tab will contain these sections:

It enables you to specify Windows teacher profiles in these Teacher profiles section elements:

Teacher profiles

· []: The table will contain Windows teacher profile records with these column contents:

· User name: Windows teacher profile user or group name.

· Domain: Windows teacher profile user or group domain.

· Add user: Click to show this window:

It enables you to specify a user Windows teacher profile in these elements:
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Login

· Domain []: The drop-down box list will contain the names of reachable domains. Click the name of the
domain in which the user Windows teacher profile user shall be authenticated to show it in the field.

· User name []: The drop-down box list will contain the user names in the domain selected above. Click
the user name by which the user Windows teacher profile user must log in to show it in the field.

Teacher name

This section enables identifying the Teacher to Students by a title and a name:

· Title []: Optionally, specify a title.

· Name []: Optionally, replace the default name Teacher by another name.

Note: This title and name will apply only to the user Windows teacher profile user.

Click OK to create the user Windows teacher profile showing its User name and Domain in the Teacher
profiles section table.

· Add group: Click to show this window:

It enables you to specify a group Windows teacher profile in these elements:

Login

· Domain []: The drop-down box list will contain the names of reachable domains. Click the name of the
domain in which the group Windows teacher profile user shall be authenticated to show it in the field.

· Group name []: The drop-down box list will contain the group names in the domain selected above. Click
the name of the group of which a group Windows teacher profile user must be a member to show it in
the field.

Teacher name

This section enables identifying the Teacher to Students by a title and a name:

· Title []: Optionally, specify a title.

· Name []: Optionally, replace the default name Teacher by another name.

Note: This title and name will apply only to the group Windows teacher profile group members.

Click OK to create the group Windows teacher profile showing its Group name and Domain in the Teacher
profiles section table.

· Edit: Select a table record and click to show the Teacher profile window to edit it.

· Delete: Select a table record and click to delete it. You cannot delete the active Teacher profile.
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If Windows teacher profiles are used, this window will be shown in front of the Teacher window when loading
the Teacher and after logging off from the Teacher:

Specify your Windows login user name, password and domain and click OK to log in to the Teacher. 

Note: If Windows teacher profiles are used, the Windows login user name will replace the running Class
name in the Teacher window Title bar.

To log off from the Teacher, select the Tools menu Log off command that will be is included in the Tools
menu only if NetOp Teacher profiles or Windows teacher profiles are used.

3.2.6.1.4  Connection Tab

This is the Teacher Options window Connection tab:

It enables you to specify Teacher Connection properties in these elements:

Max packet size

Click one of these options:
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¤ Automatic: Let NetOp determine the maximum size of data packets sent from the Teacher to Students.

¡ Specify [] (512 - 5120): Specify in the interval 512 to 5120 bytes the maximum size of data packets sent
from the Teacher to Students.

Note: A large packet size that will typically work on a local network but not on the Internet will provide a
higher data transfer speed. A small packet size may contribute to solving a communication problem.

Communication profile

· The drop-down box list will contain available Communication profiles. Click one to show it in the field as
selected.

· New: Click to show the Communication profile edit window to create a Communication profile.

· Edit: Click to show the Communication profile edit window to edit the selected Communication profile.

· Delete: Click to delete the selected Communication profile.

NetOp Name Server

· Name space ID []: To connect to Students using NetOp name management, this field must contain the
Name space ID specified in the matching field on Students.

Student polling

By default, no communication will take place between the Teacher and connected Students between actions,
in which case a lost connection will not be detected and restored. Polling Students at intervals will detect and
if possible restore a lost connection.

¨ Polling every [] Sec.: If you frequently experience lost connections to Students, check the box and specify
a number in the field to poll Students with an interval of the specified number of seconds.

Note: For Connection tab changes to apply, you must reload the Teacher.

3.2.6.1.5  Menu/Toolbar Tab

This is the Teacher Options window Menu/Toolbar tab:
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It enables you to customize the Action menu and Toolbar.

In the pane, right-click elements to uncheck/check boxes to remove/restore Action menu and Toolbar
elements.

¨ Enable desktop toolbar: Check to add a desktop Toolbar along a screen edge or in a floating window. In
addition to Toolbar buttons it will include an Options button and a Student and Student group selection
button.

3.2.6.1.6  Web Update Tab

This is the Teacher Options window Web update tab:

It enables you to update the Teacher installation from the web in these elements:

· Update server []: Specify the web address of the server from which to download Teacher update files
(default: update.netop.com, the NetOp web update server on the Internet).

Note: To support the update of many NetOp installations in an organization, we recommend to Publish new
updates to an internal web update server.

· HTTP proxy [] [Detect]: Specifying a HTTP proxy is typically not required. Before specifying a HTTP proxy,
click Update now to test the web update connection. If this yields a message indicating connection to the
update server, specify no HTTP proxy. If Update now yields no connection, click [Detect] to make NetOp
attempt to detect the HTTP proxy server to show its name and port number in the HTTP proxy field. Click
Update now to test the connection. If unsuccessful, consult with your network/system administrator about
what must be specified in the HTTP proxy field (format: <Server name>:<Port number>).

· Update now: Click to connect to the update server specified in the Update server field. A Web update
message will notify you if connection to the update server failed, if no updates are available or if updates
are available and in the latter case ask you if you want to download and install updates.

· Schedule: Click to show the Web update schedule window.
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Web Update Schedule

Click the Teacher or Student Options window Web update tab Schedule button to show this window:

It enables you to specify a Web update schedule in these elements:

Schedule

Click one of these options:

¤ Disabled: Scheduled Web update will be disabled. The other sections in the window will be disabled.

¡ Automatic download, prompt before install: Scheduled Web update will download available new update
files and prompt the user when downloaded.

¡ Automatic download and install: Scheduled Web update will download and install available new update
files.

¨ Allow system restart after install: Leave unchecked to show a message if restarting the computer is
required after installing update files. Check to restart the computer after installing update files, if required.

Run

Click one of these options:

¤ At loading: Check for new updates when the Teacher or Student is loaded. The Delay section in the image
above will be shown.

Delay

[0] minute delay: Specify in the range 0 to 99 the number of minutes after loading the Teacher or Student
Web update shall run.

¡ Daily: Check for new updates on a daily basis. This section will be shown instead of the Delay section:
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Start at

[12:00] every [1] day: Specify the time of the day and by a number in the range 1 to 99 the interval in days.

¨ Randomize within the hour: Check to randomize within the hour following the specified time to avoid
crowding.

Note: If the Teacher or Student is not loaded at the scheduled time, Web update will run when the Teacher
or Student is loaded next time.

¡ Weekly: Check for new updates on a weekly basis. This section will be shown instead of the Delay
section:

Start at

[12:00] every [1] week: Specify the time of the day and by a number in the range 1 to 99 the interval in
weeks.

¨ <Weekday>: Check boxes to check for new updates on selected weekdays.

¨ Randomize within the hour: Check to randomize within the hour following the specified time to avoid
crowding.

Note: If the Teacher or Student is not loaded at the scheduled time, Web update will run when the Teacher
or Student is loaded next time.

¡ Monthly: Check for updates on a monthly basis. This section will be shown instead of the Delay section:

Start at

[12:00] on the [1] day of the month: Specify the time of the day and by a number in the range 1 to 28 the
day of the month.

¨ Randomize within the hour: Check to randomize within the hour following the specified time to avoid
crowding.

Note: If the Teacher or Student is not loaded at the scheduled time, Web update will run when the Teacher
or Student is loaded next time.

Start date

Year [] Month [] Day []: Select in the drop-down boxes the Web update schedule start date.
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3.2.6.1.7  Demonstrate Tab

This is the Teacher Options window Demonstrate tab:

It enables you to specify general Demonstrate properties in these elements:

· Default settings: Click to show the Demonstrate window to specify the Demonstrate default action and
Demonstrate action details.

On demoed student

¨ Lock keyboard and mouse: Check to initially disable the demonstrated Student computer keyboard and
mouse.

· Session properties: Click to show the Session properties window to specify Remote control session
properties.

Note: The Teacher will Remote control a demonstrated Student.

On teacher during student demo

þ Hide teacher main window and show demo in full screen at startup: Check to initially minimize the Teacher
window and show the demonstrated Student screen image in full screen mode.

Note: Leaving checked will not hide a Desktop toolbar.

On receiving students

þ Show demo in full screen at startup: Check to initially show the demonstration in full screen mode.

¨ Demo in bitmap mode: Check to transfer a demonstrated screen image in bitmap mode. With some
computer hardware setups, certain screen image details may be missing with the faster command mode
transfer.

¨ Launch toolbox: Check to show the Student demo toolbox when receiving a screen image demonstration.
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3.2.6.1.8  Attention Tab

This is the Teacher Options window Attention tab:

It enables you to specify what shall be shown on the computer screen of Students during an Attention
session.

Show attention

Click one of these options to show a lower section that enables you to specify option details:

¤ Bitmap

¡ Text

¡ Text file

¡ Web page
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Attention Bitmap

On the Attention tab, in the Show attention section select Bitmap to show this lower Attention bitmap section:

It enables you to specify the properties of the image shown on a Student computer Attention screen in these
elements:

Attention bitmap

· File name [] [Browse]: Initially, the drop-down box field will be empty. Attention bitmap will use the image of
the netopsch.bmp file that resides in the folder in which the Student is installed. For Attention bitmap to use
a different image, click [Browse] to show a Windows Open window to open a .bmp file to show its path in
the field. If other images have been used before, the paths of their .bmp files will be available in the
drop-down box list. Click a list path to show it in the field to use its image. To use the image of the 
netopsch.bmp file, clear the field contents.

Note: If the specified file is not found on a Student computer, the Teacher will attempt to distribute the file
to the Student computer. If unsuccessful, the Attention screen will show a File not found message instead
of the image.

Bitmap display method

Select one of these options:

¤ Centered: Will show the image centered on the Student computer screen.

¡ Stretched: Will resize the image to cover the Student computer screen.

· Background color: Click to show the Windows Color window to select a background color to fill out the part
of the Student computer screen not covered by a Centered image.
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Attention Text

On the Attention tab, in the Show attention section select Text to show this lower Attention text section:

It enables you to specify the properties of the text shown on a Student computer Attention screen in these
elements:

Attention text

· Specify the text of maximum 128 characters that shall be shown on the Student computer Attention
screen. Use CTRL+ENTER for line breaks.

þ Center text: Leave checked to center the text on the Student computer Attention screen. Uncheck to place
the text in the upper left corner of the Student computer Attention screen.

· Background color: Click to show the Windows Color window to select a background color for the text.

· Font: Click to show the Windows Font window to select a text font.
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Attention Text File

On the Attention tab, in the Show attention section select Text file to show this lower Attention text file
section:

It enables you to specify the properties of the text shown on a Student computer Attention screen in these
elements:

Attention text file

· Default text file [] [Browse]: Click [Browse] to show a Windows Open window to open a text file to show its
path in the field. The text file contents will be shown on a Student computer Attention screen.

þ Center text: Leave checked to center the text file contents on the Student computer Attention screen.
Uncheck to place the text file contents in the upper left corner of the Student computer Attention screen.

· Background color: Click to show the Windows Color window to select a background color for the text file
contents.

· Font: Click to show the Windows Font window to select a text file contents font.
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Attention Web Page

On the Attention tab, in the Show attention section select Web page to show this lower Attention web page
section:

It enables you to specify the web page shown on a Student computer Attention screen in this element:

Attention web page

Web page address []: Specify the address of the web page that shall be shown on a Student computer
Attention screen.

Note: If a Student computer is unable to show the specified web page, the Attention screen will show an
error message instead of the web page.
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3.2.6.1.9  Control Tab

This is the Teacher Options window Control tab:

It enables you to specify the default Control action and general Remote control and Monitor properties in
these elements.

Default control button

Click one of these options:

¤ Remote control: Start a Remote control session when clicking the Action menu Control command or the
Toolbar Control button.

¡ Monitor: Start a Monitor session when clicking the Action menu Control command or the Toolbar Control
button.

Remote control

¨ Lock student keyboard and mouse: Check to initially disable the Student computer keyboard and mouse.

¨ Show remote control in full screen: Check to initially show the Student computer screen image in full
screen mode on the Teacher computer.

¨ Remote control in bitmap mode: Check to transfer the Student computer screen image in bitmap mode.
With certain computer hardware setups, some screen image details may be missing with the faster
command mode transfer.

Monitor students

· Monitor interval between [15] s.: Specifies the number of seconds in the range 4 to 999 between
monitoring a new selected Student.

¨ Monitor students in full screen: Check to initially show the Student computer screen image in full screen
mode on the Teacher computer.

¨ Monitor in bitmap mode: Check to transfer the Student computer screen image in bitmap mode. With
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some computer hardware setups, certain screen image details may be missing with the faster command
mode transfer.

· Session properties: Click to show the Session properties window.

3.2.6.1.10  Audio-Video Chat Tab

This is the Teacher Options window Audio-video chat tab:

It enables you to specify Teacher Audio-video chat properties in these elements.

Microphone sensitivity

· Silence level: Drag the slide to set the microphone sound input below which no audio data shall be sent.

· Line hold: Drag the slide to set the time after falling below the Silence level audio data shall continue to be
sent.

Note: Optimize by changing slide positions while running an Audio-video chat session.

· Advanced: Click to show the Advanced audio settings window.

· Check sound system: Click to check the Teacher computer sound system to show a check result
message.
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Advanced Audio Settings

Click the Audio-video chat tab Advanced button to show this window:

It enables you to select the preferred playback and record sound device and prioritize the use of available
audio compression codecs in these elements:

Playback

· Preferred device []: The drop-down box field will initially show <Use any available device>. If audio
playback devices are connected to the Teacher computer, <Use any available device> may use the
computer sound system or a connected device. To use your preferred device, click its name in the
drop-down box list to show it in the field.

Record

· Preferred device []: The drop-down box field will initially show <Use any available device>. If audio
recording devices are connected to the Teacher computer, <Use any available device> may use the
computer sound system or a connected device. To use your preferred device, click its name in the
drop-down box list to show it in the field.

Audio compression

· Try audio compression codecs in the following order []: The pane will contain a prioritized list of Teacher
computer available audio compression codecs. An Audio-video chat session will use the highest prioritized
codec that is also available on selected Student computers. You can change the list priority with these
controls:

· Up/Down: Select a codec and click to move the codec up or down in the prioritized list.

· Use defaults: Click to restore the default Windows priority.
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3.2.6.1.11  Run Tab

This is the Teacher Options window Run tab:

It enables you to add, edit or delete Run menu programs in these elements:

The table will specify Run menu program records with these column contents:

· Description: The program icon and description that will appear in the Run menu.

· Path: The Teacher computer program file path.

Manage records from these buttons:

· Add: Click to show this window:
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It enables you to add or edit a Run menu program command in these elements:

· Click [Browse] to show a Windows Open window to open a program file to show its name in the
Description field and its Teacher computer path in the File name field. You can also Run files other than
program files, such as text files.

· Description []: Will specify the Run menu program command text that you can edit.

· File name []: Will specify the path from which the computer will run the program.

· Command line switches []: To apply command line switches to running the program, specify them in the
field.

· Translate: Click to replace File name field path elements by available environment variables to facilitate
path identification on Student computers regardless of language differences.

Run

Click one of these options:

¤ Normal: Run in a normal window.

¡ Maximized: Run in a maximized window.

¡ Minimized: Run minimized.

· Properties: Select a record and click to show the Run window to view or edit record properties.

· Delete: Select a record and click to delete it.
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3.2.6.1.12  Policy Tab

This is the Teacher Options window Policy tab:

It enables you to create, edit, copy, delete and rename Policies and select the default Policy in these
elements:

The table will specify Policy records with these column contents:

· Description: Policy icon and name.

Note: The basic Allow all and Deny all Policies will always be included. The default Policy name will be
enclosed by asterisks.

· New: Click to show this window:

Specify a new Policy name and click Continue to show the Edit policy window.

· Edit: Select a Policy record and click to show the Edit policy window.

Note: You cannot edit, delete or rename a basic Policy.

· Copy: Select a Policy record and click to show this window:
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Specify a name for the new Policy that will initially be identical to the selected Policy.

· Delete: Select a Policy record and click to show a confirmation window to confirm deleting the Policy.

· Rename: Select a Policy record and click to show this window:

Specify a new name for the Policy.

· Set as default: Select a Policy record and click to mark the Policy name with asterisks to apply this Policy
to selected Students when clicking  the Action menu Policy command or the Toolbar Policy button.

þ Show notification on students: Leave checked to show a Policy icon in the Student computer screen
Windows taskbar notification area if a Policy is applied and show a notification from this icon when the Policy
is applied or changed.

Note: Policy .xml files will by default be stored in the Teacher User configuration files Policies folder. You can
change the Policy files folder in the Options window Sharing tab Policies element.
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Edit Policy

In the New policy window, click Continue or on the Policy tab, click Edit to show this window:

It enables you to create or edit Policy properties. The title bar will show the Policy name. The window has
these tabs:

· Application Tab

· Internet Tab
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Application Tab

This is the Edit policy window Application tab:

It enables you to create or edit Policy Application properties in these elements:

Click one of these basic Policies:

¤ Allow all: Allow Students to run all applications except those shown in the Except pane.

¡ Deny all: Allow Students to run only the applications shown in the Except pane.

Click Rescan to show these Applications pane folder contents: 

· Desktop: Will contain Teacher computer user Desktop application shortcut names and comments and .exe
file names ordered alphanumerically.

· Start menu: Will contain Teacher computer user Start menu folder Programs folder application shortcut
names and comments ordered alphanumerically.

· Default programs dir: Will contain Teacher computer default program folder (typically C:\Program files) .exe
file names ordered alphanumerically.

· User defined: Will initially be empty.
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Double-click a folder to show/hide its contents.

Right-click any folder to show a New command. Click it to show a Windows Open window to open a file to
add its path in the User defined folder.

Right-click any application shortcut or file name to show this menu:

It contains these commands:

· New: Click to show a Windows Open window to open a file to add its path in the User defined folder.

· Rename: Click to show a Rename window to change the application shortcut or file name only in the
Applications pane.

· Add to exception list: Click or drag the application shortcut or file name to the Except pane and drop to
add the shortcut or file name application to the exceptions from the basic policy selected above.

· Delete: Click to delete the application shortcut or file name only in the Applications pane. 

If Allow all is selected above, Except pane entries will show this icon: .

If Deny all is selected above, Except pane entries will show this icon: .

To remove an Except pane entry, right-click it and select Delete.
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Internet Tab

This is the Edit policy window Internet tab:

It enables you to create or edit Policy Internet properties in these elements:

Click one of these basic Policies:

¤ Allow all: Allow Students to access all Internet addresses except those shown in the Except pane.

¡ Deny all: Allow Students to access only the Internet addresses shown in the Except pane.

The Internet addresses pane will contain one User defined folder that will initially be empty.

Double-click the folder to show/hide its contents.

Right-click the folder to show this window:
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Specify an Internet address or an Internet address fragment such as game, sex or violence and click OK to
create this item in the User defined folder.

Right-click an item in the User defined folder to show this menu:

It contains these commands:

· New: Click to show the New item window to create an item in the User defined folder.

· Rename: Click to show a Rename window to change the item.

· Add to exception list: Click or drag the item to the Except pane and drop to add the item to the
exceptions from the basic policy selected above.

· Delete: Click to delete the item only in the Internet addresses pane. 

If Allow all is selected above, Except pane entries will show this icon: .

If Deny all is selected above, Except pane entries will show this icon: .

To remove an Except pane entry, right-click it and select Delete.

Note: In the Options window Sharing tab Blocking page element, you can specify the Internet address of a
web page that shall be shown instead of the web page of a denied Internet address.
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3.2.6.1.13  Sharing Tab

This is the Teacher Options window Sharing tab:

It enables you to specify shared folders for some of the Teacher created files to enable sharing these files
with other Teachers.

It contains these elements:

· Lesson plans [] [Browse]: Click [Browse] to show the Browse for folders window to select a local computer
or network shared folder to share Lesson plans with other Teachers that specify the same shared folder.

· Policies [] [Browse]: Click [Browse] to show the Browse for folders window to select a local computer or
network shared folder to share Policies with other Teachers that specify the same shared folder.

· Recordings [] [Browse]: Click [Browse] to show the Browse for folders window to select a local computer or
network shared folder to share Recordings with other Teachers that specify the same shared folder.

· Snapshots [] [Browse]: Click [Browse] to show the Browse for folders window to select a local computer or
network shared folder to share Remote control or Monitor session Print screen to file snapshots with other
Teachers that specify the same shared folder.

· Tests - public folder [] [Browse]: Click [Browse] to show the Browse for folders window to select a local
computer or network shared folder to share Public tests view Tests with other Teachers that specify the
same shared folder.
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· Surveys - public folder [] [Browse]: Click [Browse] to show the Browse for folders window to select a local
computer or network shared folder to share Public tests view Surveys with other Teachers that specify the
same shared folder.

· Blocking page (specify URL prefixed by HTTP://) []: If an Internet address is blocked by a Policy, a blocking
page will be shown instead.  The default blocking page has the URL path http://www.netop.com/blocking/.
To replace the default blocking page by another web page, specify its URL path.

Note: The specified URL path will be stored in the NetOp.ini file [TEACHER] section BLOCKPATH key.

3.2.6.1.14  Protection Tab

This is the Teacher Options window Protection tab:

It enables you to protect selected Options window tabs by a password in these elements:

Protection password

Change protection password: Click to show this window:

Specify the Protection password in these fields:

· Old password []: Specify the current Protection password (disabled if no Protection password is applied).

· New password []: Specify the new Protection password (leave empty if no Protection password shall be

http://www.netop.com/blocking
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applied).

· Confirm password []: Re-specify the new Protection password for confirmation.

Click OK and close the Options window to apply.

Protect options

The section contains check boxed names of the available Options window tabs (except Protection that will
always be protected by a Protection password). Check boxes to protect tabs.

Note: In the Options as tabs mode, the Options window but not the individual tabs will be protected by the
Protection password.

3.2.6.2 Help Request

A connected Student can send a Help request to the Teacher.

When a Help request arrives, the Teacher user will be alerted by a sound being played and this icon being
shown in the Windows taskbar notification area:

Right-click to show a list of the Students with a pending Help request.

A Help request will typically be accompanied by a problem description that will be shown in the Details view
pane Information column.

Respond to a Help request by any Action menu or Toolbar action, typically by double-clicking the Details view
pane Student record, Classroom view pane Student icon or Thumbnails view pane Student thumbnail to start
a Remote control session with the Student. A responded to Help request will be cleared.

To clear a Help request, right-click the Details view pane Student record, Classroom view pane Student icon
or Thumbnails view pane Student thumbnail to show the Student context menu and select Clear help request
.

3.3 NetOp Screen Image

NetOp screen image is a Teacher tool for capturing screen images.

To load NetOp screen image, click Start > All programs > NetOp School > Tools > Screen image or run the
file ScreenGrabber.exe in the Screen image folder under the folder in which NetOp Teacher is installed to
show this window:
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It enables you to specify NetOp screen image setup on these tabs:

· Capture

· Image of

· Save as

· Preferences

After setup, click OK to minimize NetOp screen image into this button in the Windows taskbar notification
area:

To capture a screen image as specified in NetOp screen image setup, press the Capture key specified on
the  Capturetab.

To restore the NetOp screen image setup window, click the button context menu Open command.

To unload NetOp screen image, click the button context menu Close command or the NetOp screen image
setup window Cancel button or a title bar Close control.

3.3.1 Capture Tab

This is the NetOp screen image setup window Capture tab:

It enables you to specify Capture setup in these elements:

· Capture key []: The drop-down box list contains from F1 to F10 referring to these keyboard keys. Click a
key in the list to show it in the field as the selected Capture key.

Note: If your first choice Capture key appears to be used by another functionality, select another.

Delay

þ Delay before capture (1 - 60 seconds) []: Leave checked and adjust the number in the spin box to delay
capture to enable preparations before capturing the image. Uncheck to capture without delay.
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3.3.2 Image of Tab

This is the NetOp screen image setup window Image of tab:

It enables you to select which screen area to capture in this element:

Click one of these options:

¤ Active window: Will capture the computer screen active window.

¡ Client window: Will capture the computer screen active window without its title bar.

¡ Full screen: Will capture the entire computer screen.

¡ Rectangular area: Will change the mouse pointer into a pointing hand. Drag a rectangle to capture its
contents.

3.3.3 Save As Tab

This is the NetOp screen image setup window Save as tab:

It enables you to specify image file save properties in these elements:

· Save as name []: Will be disabled if the Name automatically box is checked. The drop-down box list will
contain image file names used before. Click one to show it in the field as selected or specify a name in the
field.
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Note: A captured image file will without warning overwrite any older file in the same location with the same
name.

þ Name automatically: Leave checked to automatically name captured image files image<Number> using
the next available number not used by image files in the same location.

· Save as type []: The drop-down box list contains these image file types:
· Windows bitmap (*.bmp)
· JPEG (*.jpg)
· GIF (*.gif)
· PNG (*.png)

Click an image type to show it in the field as selected.

Save in directory: [] [...]: Will initially specify a NetOp ScreenImages folder in your My documents folder.
Click [...] to show the Browse for folder window to select a folder whose path will be specified

3.3.4 Preferences Tab

This is the NetOp screen image setup window Preferences tab:

It enables you to specify capture preferences in these elements:

¨ Remove button: Check to remove the notification area NetOp screen image button while capturing.

þ Notify upon completion: Leave checked to play a sound and show this notification upon capture
completion:
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3.4 NetOp Screen Video

NetOp screen video is a Teacher tool for recording screen videos.

To load NetOp screen video, click Start > All programs > NetOp School > Tools > Screen video or run the
file ScreenCapture.exe in the Screen video folder under the folder in which NetOp Teacher is installed to
show this window:

It enables you to record a screen image area video sequence like this:

1. Click the Toolbar  Record button to show a mouse moveable recording region.

2. Move the mouse to position the region. Click to start recording showing flashing colored corners.

3. Click the Toolbar  Stop button to show a Windows Save as window.

4. Specify a file name and click Save to save the recording file.

Note: The recording .avi file will play in Windows media player.

The NetOp screen video window contains these elements:

· Title bar

· Menu bar

· Toolbar

3.4.1 Title Bar

This is the NetOp screen video window title bar:

You can unload and minimize NetOp screen video with the available window controls.

While pausing recording, Paused will flash in the title bar.

3.4.2 Menu Bar

This is the NetOp screen video window menu bar:

It contains these menus:

· File

· Region

· Options

· About
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3.4.2.1 File Menu

This is the NetOp screen video window File menu:

It contains these commands:

· Record: Click, click the Toolbar Record button or press the Record/Pause keyboard shortcut to start
recording. Recording region options are explained in Region menu. Other options are explained in Options
menu.

· Stop: Click, click the Toolbar Stop button or press the Stop keyboard shortcut to stop recording.

· Pause: Click, click the Toolbar Pause button or press the Record/Pause keyboard shortcut to pause
recording. While pausing, the Title bar will flash Paused. To resume recording, click Record.

· Exit: Click or use a Title bar Close window control to unload NetOp screen video closing the NetOp screen
video window.

3.4.2.2 Region Menu

This is the NetOp screen video window Region menu:

It contains these commands:

· Dragged region: Click to check mark as the selected region option to show cross hairs to drag a region
when starting recording.

· Specified region: Click check mark as the selected region option to show this window:
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It enables you to specify the recording region in these elements:

· Specify: Click to change the mouse pointer into pencil cross hairs. Drag a rectangular frame to enter its
dimensions into the enabled fields below.

· Width [] px: Specify the pixels region width.

· Height [] px: Specify the pixels region height.

¨ Fixed top left corner: Check to enable the fields below to specify the region top left corner offset from the
screen top left corner.

Note: If Fixed top left corner is checked, the region will be fully defined. Recording will start immediately
without showing a mouse moveable recording region.

· Left offset [] px: Specify the region left border pixels distance from the screen left border.

· Top offset [] px: Specify the region top border pixels distance from the screen top border.

· Full screen: Click to check mark as the selected region option to record a full screen video when starting
recording.

3.4.2.3 Options Menu

This is the NetOp screen video window Options menu:

It contains these commands:

· Video options: Click to show this window:
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It enables you to specify video properties in these elements:

· Video codec []: The drop-down box list will contain the names of available video codecs. Click a video
codec name to show it in the field as selected.

· About: Click to show information on the selected video codec.

· Configure: Will be enabled only if a configurable video codec is selected. Click to show the matching
configuration window.

· Quality: Drag this slide to select the video quality as shown by a number between 0 and 100 to the right.
A higher quality video file will be larger.

You can auto adjust or specify frame rates. Initially, the Auto adjust box will be checked to disable the fields
and enable the bottom frame rate slide. Its left Max frame rate end represents recording 200
frames/second and its right end represents recording 1 frame/minute. It will automatically specify field
numbers in two ranges:

Recording frame rate Set key frames every Capture frame every Playback rate

200 - 1 frames/second Second 0.005 - 1 second Recording frame rate

60 - 1 frames/minute 20 frames 1 - 60 seconds 20 frames/second

Uncheck the Auto adjust box to disable the bottom frame rate slide and enable the fields to specify
numbers in these ranges:

· Set key frames every [] frames: 1 - 200.

Note: Playback will synchronize at each key frame.

· Capture frame every [] milliseconds: 1 - 7200000 (2 hours).

Note: A large number of frames will make a large file.
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· Playback rate [] frames/second: 1 - 200.

· Cursor options: Click to show this window:

It enables you to specify cursor properties in these elements:

Cursor display

Click one of these options:

¡ Hide cursor: Do not include the cursor in the recording.

¤ Show cursor: Include the cursor in the recording. Select one of these sub-options:

¤ Use default cursor: Include the screen cursor in the recording.

¡ Use custom cursor []: The drop-down box list will contain the names of available custom cursors.
Click a name to show it in the field. Include this cursor in the recording.

¡ Use cursor from file []: Click the  button to show a Windows Open window with the contents of
the Windows Cursors directory. Open a cursor file to include this cursor in the recording.

Note: The selected cursor will be shown in the upper right part of the section.

Cursor highlight

¨ Highlight cursor: Check to show a highlight around the cursor.

· Size []: Drag the slide to change the size of the cursor highlight. Its half size will be shown to the right.

· Shape [] [Color]: The drop-down box list will contain available cursor highlight shape names. Click a
shape name to show it in the field as selected. Click the Color button to show the Windows Color window
to select a cursor highlight color.

· Record audio: Click to check mark to record sound playing on the computer and input to the computer
from e.g. a microphone. Click the check marked command to uncheck it.

· Audio options: Click to show this window:
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It enables you to specify audio properties in these elements:

Audio capture device []: The drop-down box list will contain the names of available audio capture devices.
Click a name to show it in the field as selected.

Recording format []: The drop-down box list will contain the names of available recording formats. Click a
format to show  it in the field as selected.

Compression format [] [] [Choose compression format]: The two upper fields will show the type and
attributes of the selected compression format. Click Choose compression format to show this window:

It enables you to specify an audio compression format in these elements:

· Name: [] [Save as] [Remove]: The drop-down box list will contain the names of saved audio
compression formats. Click a name to show it in the field as selected. Click Save as to show this
window:
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Specify the name by which the audio compression format shall be saved.

Click Remove to remove the selected saved audio compression format.

· Format []: The drop-down box list will contain the names of available audio compression formats. Click
a name to show it in the field as selected. 

· Attributes []: The drop-down box list will contain available sets of compression format attributes. Click
a set to show it in the field as selected.

Interleave video and audio

þ Interleave every [] ¡ Frames/¤ Milliseconds: Leave checked to interleave video and audio. Specify a
number in the field. Select Frames or Milliseconds.

· Enable autopan: Click to check mark to automatically move the recording region center towards the mouse
pointer position while recording. Click the check marked command to uncheck it to not move the region.

· Autopan speed: Click to show this window:

Drag the slide to set the maximum pan speed in the range 1 - 200. The pan speed of the slider position will
be shown in the lower right corner of the window.

· Program options: Expands into these commands:

· Minimize upon recording: Click to check mark to minimize the NetOp screen video window to the
Windows taskbar when recording.

· Suppress flashing frame: Click to check mark to suppress the selected region flashing frame during
recording.

· Recording thread priority: Expands into these commands:

· Normal: Click to check mark to assign normal priority to the recording thread.

· Above normal: Click to check mark to assign above normal priority to the recording thread.

· Highest: Click to check mark to assign highest priority to the recording thread.

· Time critical: Click to check mark to assign time critical priority to the recording thread.

· Keyboard shortcuts: Click to show this window:
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Record/Pause key []: The drop-down box list will contain available keyboard shortcuts. Click one to show it
in the field as the selected Record/Pause keyboard shortcut.

Stop key []: The drop-down box list will contain available keyboard shortcuts. Click one to show it in the
field as the selected Stop keyboard shortcut.

Cancel recording key []: The drop-down box list will contain available keyboard shortcuts. Click one to
show it in the field as the selected Cancel recording keyboard shortcut.

Note: A canceled recording leaves no file to be saved.

3.4.2.4 About Menu

This is the NetOp screen video window About menu:

About: Click to show this window:
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It shows the NetOp screen video version and build number that will be asked for if you request technical
support.

3.4.3 Toolbar

This is the NetOp screen video window toolbar:

It contains these buttons:

Record: Click, click the File menu Record command or press the Record/Pause keyboard shortcut
to start recording. Recording region options are explained in Region menu. Other options are
explained in Options menu.

Pause: Click, click the File menu Pause command or press the Record/Pause keyboard shortcut to
pause recording. While pausing, the Title bar will flash Paused. To resume recording, click Record.

Stop: Click, click the File menu Stop command or press the Stop keyboard shortcut to stop
recording.
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4 NetOp Student
This section explains Student properties in these sections:

· Load and unload Student

· Student window

4.1 Load and Unload Student

The Student will typically be set up to Load at Windows startup, to Join class when loaded and to Minimize
into this Windows taskbar notification area button:

The button tool tip will show the Student Status and its computer IP address if communicating using the TCP/
IP Communication device.

Right-click the NetOp Student button to show this menu:

It contains these commands:

· Restore: Click to show the Student window.

· Exit: Click to unload the Student.

· Request help: Will be enabled if connected to a Class. Click to Request help from the Teacher that runs
the Class.  

Alternatively, the Student can be set up not to Load at Windows startup, not to Join class when loaded and
not to Minimize and further to load in Stealth mode where nothing on the computer screen will show that the
Student is loaded.

Load

To load the Student if not loaded, click typically Start > All programs > NetOp School > Student. If this does
not show either the Student window or the NetOp Student button, the Student is probably already loaded in
Stealth mode.

Alternative loading methods are explained in the Loading alternatives section.

When loading the Student for the first time after a typical Installation, the Setup wizard will run to enable
initial Student setup.

Unload

To unload the Student, click the NetOp Student button menu or File menu Exit command or use a Title bar
Close window control.

Unloading the Student can be protected by a Protection password to show this window when you attempt to
unload the Student:
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To unload, specify the Protection password and click OK.

This section contains these sections:

· Loading alternatives 

· Setup wizard 

4.1.1 Loading Alternatives

These Student loading alternatives are available:

1. In the folder where NetOp Student was installed, typically C:\Program files\Danware Data\NetOp School
\Student, run (double-click) the Student program file nstdw32.exe.

2. Create a desktop shortcut to the Student program file nstdw32.exe. Double-click this shortcut.

3. From a Windows Run or Command prompt window, execute the Student program file nstdw32.exe. 

To load the Student from another application, use a command that you can expand with command line
switches according to this syntax:

nstdw32 [/C:<Communication profile>] [/N:<Class name>]

If the Class name contains spaces, it must be enclosed within quotation marks.

If any of the switches are not used, the parameters that applied when the Student was last unloaded by any
user will be used.

Examples

To load the Student with the Communication profile named IPX to join the Class named Geography, use this
command line:

nstdw32 /C:IPX /N:Geography

To load the Student with the Communication profile that was used when it was last unloaded but to join the
Class named Dr. Nelson, use this command line:

nstdw32 /N:"Dr. Nelson"
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4.1.2 Setup Wizard

When any user loads the Student for the first time after an Installation that did not like Student deployment
install the Student in a fully set up state, this Setup wizard will run. You can also run the Setup wizard from
the Student window Tools menu Run setup wizard command, unless it is unavailable to you by Protection
password protection. This window will be shown in front of the Student window:

 

The Setup wizard will guide you through initial Student setup.

Click Next to show this window:
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It enables you to select how the Student shall load and start.

þ Join class at program startup: Leave checked to let the Student Join class (start communicating) when
loaded to connect to a running Class that is ready for it. Uncheck to Join class manually.

þ Load student at Windows startup: Leave checked to load the Student when Windows starts running on the
computer. Uncheck to load the Student manually.

þ Minimize student at program startup: Leave checked to load the Student minimized into a Windows
taskbar notification area NetOp Student button. Uncheck to load the Student showing the Student window.

¨ Stealth mode (hide student when started): Leave unchecked to load the Student visible on the computer
screen. Check to load the Student hidden.

Note: You can change these selections in the Student Options window General tab Startup section.

Click Next to show this window:
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It enables you to select how the Student shall connect to a Class and identify itself to Teachers.

Click one of these options:

¤ Connect to class []: Specify a Class name to, when Joining class, connect to this Class if it runs or when it
starts running.

¡ Browse for classes: When Joining class, get a list of running Classes for the Student user to decide which
of these Classes to connect to.

¡ Be available for any class: When Joining class, connect to a running Class of which the Student is a
member. If no Class of which the Student is a member is running, running Class Teacher users can connect
or invite the Student to connect to their Class.

¡ Select class: When Joining class, the Student user can specify a Class name, alternatively a computer IP
address or DNS name to connect if the specified Class runs or when it starts running, alternatively if any
Class runs on the specified address computer or when it starts running.

Note: You can change this selection on the Student Options window Class tab.

Identify student by []: The drop-down list will contain user, computer and specified name variants as
explained in the Student login tab section. Click typically Computer name if the Student runs on a network
computer or Windows login name if the Student runs in a terminal server client session.

Note: You can change this selection on the Student Options window Student login tab.

Click Next to show this window:
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It enables you to select how the Student shall communicate.

Communication profile []: The drop-down box list will contain the names of the Communication profiles that
are available on the Student. If you have no other preferences, TCP/IP, if available,  will most likely be the
right selection for you.

NetOp Name Server

¨ Use NetOp Name Server: Only if the Teachers and Students in this Student's environment shall connect
by using NetOp Name Management, check to enable the elements below.

· Primary []: Specify the Primary NetOp Name Server IP address or DNS name.

· Secondary []: Specify the Secondary NetOp Name Server IP address or DNS name.

· Name space ID []: Specify the Name space ID used by this Student's environment.

Note: You can change these selections from the Student Options window Connection tab.

Click Next to show this window:
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It enables you to register your license with the manufacturer.

Note: Registering your license with the manufacturer may prove useful if you lose your license certificate and
if you want to upgrade to a newer version of the product. Do not register if the license was already registered.

Select one of these options:

¤ Yes, I want to register my NetOp license on-line: When clicking Next, the NetOp product registration
website will open for you to register before continuing.

¡ No, but remind me later: When the Student is loaded next time, this window will be shown.

¡ No, I do not want to register my NetOp license now: You will not be reminded of registration any more.

Click Next to show this window:



243

NetOp Student

Click Finish to end the Setup wizard closing the window.

4.2 Student Window

This is the Student window:

It contains these elements:
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· Title bar 

· Menu bar

· Toolbar

· Tab panel

· Status bar

4.2.1 Title Bar

This is the Student window title bar:

Click the left Student button or right-click anywhere in the title bar to show a window control menu.

These Status indications will be shown next to the window name:

· Loading: The Student is loading.

· Not in class: The Student has not Joined class (is not communicating).

· Joining: The Student is Joining class (is starting communicating).

· Waiting for <Class name>: The Student has Joined class (is communicating) and is ready to connect to
<Class name> when it becomes available.

· <Nothing>: The Student has Joined class (is communicating) and is browsing for Classes.

· <Available>: The Student has Joined class (is communicating) and is available for any Class.

· <Class name>: The Student has Joined class (is communicating) and is connected to <Class name>.

· Controlled by <Class name>: The Student has Joined class (is communicating) and is in a session that is
controlled by the Teacher that runs <Class name>.

· Leaving: The Student is Leaving class (is disconnecting if applicable and stopping communicating).

4.2.2 Menu Bar

This is the Student window menu bar:

It contains these menus:

· File

· View

· Action

· Tools

· Help

4.2.2.1 File Menu

This is the Student window File menu:

It contains this command:
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· Exit Alt+F4: Click, click the NetOp Student button menu Exit command, press ALT+F4 or use a Title bar
window control Close functionality to unload the Student.

Note: Exit can be protected by a Protection password.

4.2.2.2 View Menu

This is the Student window View menu:

It contains this command:

· Toolbar: Click to remove/restore the Toolbar removing/restoring the check mark next to the command..

4.2.2.3 Action Menu

This is the Student window Action menu:

It contains these commands:

· Join class: Will be enabled if the Student Status is Not in class. Click or click the Toolbar Join class button
to Join class (start communicating).

· Leave class: Will be enabled if the Student Status is not Loading, Not in class, Joining or Leaving. Click or
click the Toolbar Leave class button to Leave class (disconnect if applicable and stop communicating).

Note: Leave class can be protected by a Protection password.

· Rejoin class: Will be enabled if the Student Status is not Loading, Not in class, Joining or Leaving. Click or
click the Toolbar Rejoin class button to Leave class and immediately Join class (disconnect if applicable
and stop and start communicating).

Note: Rejoin class can be protected by a Protection password.

· Request help: Will be enabled if the Student is connected to a Class and no Help request is pending. Click
or click the Toolbar Request help button, click the NetOp Student button menu or NetOp help request
button Request help command or double-click the NetOp help request button to show this window:

 

Describe the problem for which you are requesting help and click OK to send the Help request.

· Cancel help: Will be enabled if a Help request is pending. Click or click the Toolbar Cancel help button,
click the NetOp help request button menu Cancel help command or double-click the NetOp help request
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button to cancel the Help request on Student and Teacher.

· End session: Will be enabled if the Student is engaged in a session. Click to end the session.

Note: End session can be protected by a Protection password.

4.2.2.4 Tools Menu

This is the Student window Tools menu:

It contains these commands:

· Options: Click to show the Options window that is explained in the Options section.

Note: Options can be protected by a Protection password.

· Options as icons: Will be included if the Options window tabs version is enabled. Click to enable the
Options window icons version.

· Protection password: Click to show the Protection password window that is explained in the Protection
password section.

Note: Protection password can be protected by a Protection password.

· Check for new updates: Click to check for new updates to the Student installation on the update server
specified on the Web update tab.

· Run setup wizard: Click to run the Student Setup wizard.

Note: Run setup wizard can be protected by a Protection password.

· Debug trace: To include this command, press ALT+Z while showing the About NetOp School Student
window. Click to save a log of recent Student communication, which will assist NetOp professionals in
diagnosing communication problems. The debug trace is a plain text file. Interpreting its contents requires
special NetOp skills.

4.2.2.5 Help Menu

This is the Student window Help menu:

It contains these commands:

· Contents: Click to open the NetOp Student Help window that has a graphical table of contents in its left
pane.

· Online support: Click to open the Support for NetOp School web page to request technical support.

· Apply license/Online registration: Will be Apply license if a trial version is installed and Online registration if
a licensed version is installed.
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· Apply license: Click to show this window:

 

Specify your licensee name and your Student license number and click OK to replace the trial version
licensee name and license number by the specified licensee name and license number.

· Online registration: Click to open the NetOp product registration web page to register your license with
the NetOp manufacturer.

· About: Click to show this window:

It contains information on your Student installation. The build number in format YYYYDDD (Y=year number
digit, D=day number digit) is enclosed in parentheses next to the version number.

System Info: Click to show the System info window.

4.2.3 Toolbar

This is the Student window Toolbar:
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You can drag the Toolbar to place it inside or outside the Student window.

You can hide and restore the Toolbar from the View menu Toolbar command.

The Toolbar contains these buttons:

Join class: Will be enabled if the Student Status is Not in class. Click or click the Action menu Join
class command to Join class (start communicating).

Leave class: Will be enabled if the Student Status is not Loading, Not in class, Joining or Leaving.
Click or click the Action menu Leave class command to Leave class (disconnect if applicable and
stop communicating).

Note: Leave class can be protected by a Protection password.

Rejoin class: Will be enabled if the Student Status is not Loading, Not in class, Joining or Leaving.
Click or click the Action menu Rejoin class command to Leave class and immediately Join class
(disconnect if applicable and stop and start communicating).

Note: Rejoin class can be protected by a Protection password.

Request help: Will be enabled if the Student is connected to a Class and no Help request is pending.
Click or click the Action menu Request help command, click the NetOp Student button menu or
NetOp help request button Request help command or double-click the NetOp help request button to
show the Help request window to specify a problem description and send the Help request.

Cancel help: Will be enabled if a Help request is pending. Click or click the Action menu Cancel help
command, click the NetOp help request button menu Cancel help command or double-click the
NetOp help request button to cancel the Help request on Student and Teacher.

4.2.4 Tab Panel

This is the Student window Tab panel: 

It contains these tabs:

· General 

· Class 

· Messages 

· Recordings 
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4.2.4.1 General Tab

This is the Student window General tab:

 

It contains these sections:

· Status []: Will almost like the Title bar show the Student status like this:

· Loading: The Student is loading.

· Not in class: The Student has not Joined class (is not communicating).

· Joining: The Student is Joining class (is starting communicating).

· Waiting for <Class name>: The Student has Joined class (is communicating) and is ready to connect to
<Class name> when it becomes available.

· <Nothing>: The Student has Joined class (is communicating) and is browsing for Classes.

· <Available>: The Student has Joined class (is communicating) and is available for any Class.

· In <Class name>: The Student has Joined class (is communicating) and is connected to <Class name>.

· Controlled by <Class name>: The Student has Joined class (is communicating) and is in a session that
is controlled by the Teacher that runs <Class name>.

· Leaving: The Student is Leaving class (is disconnecting if applicable and stopping communicating).

· Computer and student login name []: Will show the Student computer name and Student login name.

Note: A prompted for Student login name will not be shown.

· Connection method []: Will show the Class connection method.
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4.2.4.2 Class Tab

This is the Student window Class tab:

If the Student is connected to a Class, it will show the Students in the Class.

Its table will contain connected Student records with details in these columns:

· Status: Can show these status icons:???

Engaged in a Demonstrate session.

Engaged in an Attention session.

Engaged in a Remote control session.

Engaged in a Monitor session.

Engaged in an Audio-video chat session.

Engaged in a Chat session.

Assistant Teacher in a Workgroup session.

Engaged in a Distribute files session.

Engaged in a Collect files session.

Engaged in a File manager session.

Has a pending Help request.

· Student display name: The name by which the Teacher displays the Student.

You cannot execute any actions on this tab.
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4.2.4.3 Messages Tab

This is the Student window Messages tab:

It enables you to manage received NetOp messages.

Note: When received, NetOp messages will be saved as .rtf files in the Student User configuration files
folder Messages folder. NetOp messages in this folder will be shown in the Messages tab table.

The Messages tab table will contain NetOp message records with details in these columns:

· Received: NetOp message icon and received date and time.

· From: The Teacher Options window Teachers tab Teacher name section specified Title and Name.

· Subject: First NetOp message line contents.

Right-click a record to show this menu:

It contains these commands:

· View: Click to show the NetOp message in this window:

From the menus and toolbar buttons, you can save the message in a different location with a different file
name, print the message text, copy selected text and search for text elements.
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· Delete: Click to delete the NetOp message.

4.2.4.4 Recordings Tab

This is the Student window Recordings tab:

It enables you to manage received NetOp recordings.

Note: Students will receive Teacher NetOp recordings distributed via a Groups pane Student group icon or
record in the Student User configuration files  folder screcord folder. NetOp recordings in this folder will be
available in the Recordings tab Recordings folder.

The Recordings tab contains a left folders pane and a right records pane.

The left folders pane will initially contain a Recordings root folder. Right-click in the folders pane to show this
context menu:

It contains these commands:

· Cut: Select a user created folder and click to remove the folder with its contents to place it on the clipboard.

· Copy: Select a folder and click to place a copy of the folder with its contents on the clipboard.

· Paste: Click to paste the clipboard contents into the selected folder.

· New folder: Click to create a folder in the selected folder showing this window:
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Specify the folder name and click OK to create.

· Delete: Select a folder and click to show a confirmation window to confirm deleting the folder with its
contents.

· Rename: Select a folder and click to show this window:

Edit the folder name and click OK to rename

The right records pane will show selected folder recording records in a table with these column contents:

· Name: Recording name.

· Recorded: Recording date and time.

· Duration: Recording duration.

· Teacher: Recording type of NetOp module.

Right-click in the records pane to show this context menu:

It contains these commands:

· Playback recording: Click to play back the most recently clicked record recording in the Recording
playback window.

· Cut: Select one or multiple (pressing SHIFT or CTRL) records and click to remove records to place them
on the clipboard.

· Copy: Select one or multiple (pressing SHIFT or CTRL) records and click to place a copy of them on the
clipboard.

· Paste: Click to paste the clipboard contents into the records pane.

· New: Expands into:

· Folder: Click to show the New folder window to create a folder in the selected folder.

· Delete: Select one or multiple (pressing SHIFT or CTRL) records and click to show a confirmation window
to confirm deleting them.

Drag or press CTRL and drag selected records to a folder and drop them to move or copy selected records
to the folder.
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4.2.5 Status Bar

This is the Student window Status bar: 

Its right end will show the Student computer IP address if the Student is communicating by a Communication
profile that uses the TCP/IP Communication device. If the Student uses multiple IP addresses, a + will be
shown to the right of the IP address. Click the + to show other used IP addresses.

A yellow pages icon will be shown if the Advanced TCP/IP configuration window Use NetOp Name Server
box is checked. These symbols can be shown on the icon:

· Nothing: Specified NetOp Name Servers are available.

· Red exclamation mark (!): One of two specified NetOp Name Servers is available.

· Red X: No NetOp Name Server is available.

When the mouse pointer is over a menu command or Toolbar button, the Status bar left end will show a hint
to the menu command or Toolbar button.

4.2.6 Student Tools

This section explains these Student tools:

· Options 

· Protection password 

4.2.6.1 Options

Click the Student window Tools menu Options command to show this window:

 

It provides access to Options tabs.

Right-click in the window pane to show this menu:



255

NetOp Student

It contains these commands:

· Open: Will be enabled if an option icon is right-clicked. Click or double-click an option icon to show the
option tab window.

· Large icons: Will be enabled if the small icons Options window below is shown. Click to show the large
icons Options window above.

· Small icons: Will be enabled if the large icons Options window above is shown. Click to show this window:

· Options as tabs: Click to show this Options window with tabs instead of icons after closing and opening
the Options window:

To return to the Options window with icons, click the Tools menu Options as icons command. 

The Options window contains these tabs:

· General
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· Class

· Student login

· Protection

· Audio-video chat

· Help request

· Connection

· Web update

4.2.6.1.1  General Tab

This is the Student Options window General tab:

 

It enables you to specify Student Startup and Control session properties and a Connection password in these
elements:

Startup

þ Join class at program startup: Leave checked to let the Student Join class (start communicating) when
loaded to connect to a running Class that is ready for it. Uncheck to Join class manually.

þ Load student at Windows startup: Leave checked to load the Student when Windows loads on the
computer. Uncheck to load the Student manually.

þ Minimize student at program startup: Leave checked to load the Student minimized into a Windows
taskbar notification area NetOp Student button. Uncheck to load the Student showing the Student window.

¨ Stealth mode (hide student when started): Leave unchecked to load the Student visible on the computer
screen. Check to load the Student hidden.

Note: To unhide a Stealth mode Student, run (double-click) the showhost.exe file that resides in the folder in
which the Student is installed. Unhiding a Stealth mode Student can be protected by a Protection password.

Control session

¨ Minimize student in control session: Check to minimize the Student window into a a Windows taskbar
notification area NetOp Student button when a Teacher starts a Remote control or Monitor session with it.
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¨ Student top most in control session: Check to show the Student window in front of any other window when
a Teacher starts a Remote control or Monitor session with it.

Connection password

· Specify a password to enable only Teachers whose Options window General tab Connection password
section contains the same password to connect.

4.2.6.1.2  Class Tab

This is the Student Options window Class tab:

It enables you to select how the Student shall connect to a Class.

Click one of these options:

¤ Connect to class []: The drop-down box list will contain the names of Classes connected to before. Click a
Class name to show it in the field as selected. When Joining class (starting communicating), the Student will
browse for the selected Class to connect to it if running or wait for it to run and then connect.

¡ Browse for classes: When Joining class (starting communicating), the Student will browse for running
Classes to show responses in this window:
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The Available classes pane will show the names of responding running Classes. Select one and click OK
to connect to it. Click Cancel to Leave class. Click Browse to browse again.

¡ Be available for any class: When Joining class (starting communicating), the Student will announce being
available for any Class. A Teacher that runs a Class of which the Student is a member will respond to make
the Student connect to the  Class. The users of other Teachers that run a Class can see that the Student is
available to connect or invite the Student to connect to their Class. A Class invitation can look like this:

Click OK to accept the invitation to automatically connect to the Class. Click Cancel to decline.

¡ Select class: When Joining class (starting communicating), the Student will show this window:
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The drop-down box list will contain Class names, IP addresses and DNS names that have been used
before. 

Click Class name and click a Class name in the list or specify it in the field. Click Connect to browse for the
selected Class to connect to it if running or wait for it to run and then connect.

Click IP address or DNS name and click an IP address or DNS name in the list or specify it in the field.
Click Connect to connect to the specified address to connect to the Class run by the Teacher on the
specified address computer or show an error message if no Teacher is found on the specified address.

¡ Use class server [Setup]: When Joining class (starting communicating), the Student will retrieve Class
information from a NetOp Class Server and connect accordingly. Click [Setup] to show the Class server
setup window to set up the Student to use a NetOp Class Server.

Class Server Setup

Click the Student Options window Class tab Setup button to show this window:

It enables you to set up the Student to use NetOp School class management in these elements:

· Class server []: Specify the Class server ID specified on the used NetOp Class Server.

¨ IP address or DNS name (if on another subnet) []: If the used NetOp Class Server is on an IP subnet
different from the Student computer IP subnet, you must check the box and specify the NetOp Class Server
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computer IP address or DNS name.

þ Rejoin on disconnect from Teacher: Leave checked to make the Student Rejoin class if it becomes
disconnected from a running Class. Uncheck to disable.

¨ Show class list: Leave unchecked to offer no Class options to the Student user. Check to show this
window when the Student Joins class or when its Class ends:

The pane will always include <Available for any class>. Select and click OK for the Student to become
Available for any class.

If NetOp School class management runs in Non-scheduled mode, the names of Courses to which the
Student is assigned will be shown in the pane. Select a Course name to show only the Teacher name in
the fields below. Click OK to connect to a selected Course running Class or wait for it to run and then
connect.

If NetOp School class management runs in Scheduled mode, if a Lesson of a Course to which the Student
is assigned is running, the Course name will be shown in the pane. Select a Course name to show Lesson
From time, To time, Classroom name and Teacher name in the fields below. Click OK to connect to the
Lesson. If no Lesson of a Course to which the Student is assigned is running, the user can select to show
the Course names of upcoming Lessons in the Select class window to select one to wait for it to run and
then connect.

Click Cancel to close the Select class window for the Student to become Not in class. If the Student
cannot Leave class by Protection password protection, it will become Available for any class.

Identify student by

Click one of these options for identifying the Student to the NetOp Class Server:

¤ Windows login name: By the name by which the Student user is logged in to Windows.

¡ Computer name: By the Student computer Windows name.

¡ Student login name: By the name specified on the Student login tab.

Note: This selection must be compatible with the NetOp School class management Student identification.
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4.2.6.1.3  Student Login Tab

This is the Student Options window Student login tab:

It enables you to specify the Student login name by a name type or name in this section:

Note: Each Student in a Class must have a unique Student login name. A Student that attempts to connect
to a Class that already contains a Student with the same Student login name will be rejected.

Student login name

Identify student by []: The drop-down box list contains these options:

· Windows login name: The Student login name will be the Student user Windows login name.

· Windows login name and \domain: The Student login name will be the Student user Windows login name
and domain name separated by a backslash character (\).

· Windows full name: The Student login name will be the Student user Windows full name.

· Windows full name and \domain: The Student login name will be the Student user Windows full name and
domain name separated by a backslash character (\).

· Computer name: The Student login name will be the Student computer Windows name.

· Computer name and \domain: The Student login name will be the Student computer Windows name and
domain name separated by a backslash character (\).

Note: For Students that run on a terminal server, do not select a Student login name option based on
Computer name. All Students that run on a terminal server share the same Computer name. For Students
that run on network computers, Computer name is a safe choice for the Student login name.   

· Prompt for login name: When the Student Joins class, this window will be shown:
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Specify the Student login name and click OK to apply.

If on the Options window Class tab Browse for classes is selected, this combined window will be shown:

Specify the Student login name and select an available Class and click OK to connect.

· Login as: Will enable the Enter name field below. 

Enter name []: Specify the Student login name or an environment variable whose value will be the Student
login name.

Click an option in the list to show it as selected in the field.

· This is the name that identifies the student on the teacher: Will show the Student login name according to
the selected name type. A Prompt for login name name cannot be shown.
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4.2.6.1.4  Protection Tab

This is the Student Options window Protection tab:

It enables you to protect the Student against unwanted Teacher actions.

Note: Protecting the Student applies typically to an adult teaching environment where Student users are in
full control of Student Options and do not want to be tightly controlled from the Teacher.

Protection

¨ Enable protection: Check to enable the Prevent teacher from section below.

Prevent teacher from

¨ Locking PC during attention and demonstrate: Check to disable full screen Attention or Demonstrate
sessions with this Student.

¨ Viewing thumbnail: Check to disable showing a miniature image of this Student computer's screen in
Thumbnails view.

¨ Controlling without confirm access: Check to show this window before a Remote control or Monitor
session is started with this Student:
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Click to Allow or Deny the session.

¨ Using file manager: Check to disable running a File manager session with this Student.

¨ Distributing files: Check to disable running a Distribute files session with this Student.

¨ Collecting files: Check to disable running a Collect files session with this Student.

¨ Running program: Check to disable Run program on this Student computer.

¨ Executing command: Check to disable executing Commands on this Student computer.

¨ Assigning microphone: Check to disable assigning the microphone to this Student in an Audio-video chat
session.

¨ Applying policy: Check to disable applying a Policy on this Student.

¨ Monitoring activity: Check to disable monitoring Activity on this Student computer.

4.2.6.1.5  Audio-Video Chat Tab

This is the Student Options window Audio-video chat tab:

It enables you to specify Student Audio-video chat properties in these elements.

Microphone sensitivity

· Silence level: Drag the slide to set the microphone sound input below which no audio data shall be sent.

· Line hold: Drag the slide to set the time after falling below the Silence level audio data shall continue to be
sent.

Note: Optimize by changing slide positions while running an Audio-video chat session.

· Advanced: Click to show the Advanced audio settings window.

· Check sound system: Click to check the Student computer sound system to show a check result message.
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Advanced Audio Settings

Click the Audio-video chat tab Advanced button to show this window:

It enables you to select the preferred playback and record sound device in these elements:

Playback

· Preferred device []: The drop-down box field will initially show <Use any available device>. If audio
playback devices are connected to the Student computer, <Use any available device> may use the
computer sound system or a connected device. To use your preferred device, click its name in the
drop-down box list to show it in the field.

Record

· Preferred device []: The drop-down box field will initially show <Use any available device>. If audio
recording devices are connected to the Student computer, <Use any available device> may use the
computer sound system or a connected device. To use your preferred device, click its name in the
drop-down box list to show it in the field.

4.2.6.1.6  Help Request Tab

This is the Student Options window Help request tab:

It enables you to add a Help request button in this element:
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¨ Add help request icon to the tray: Check to add this button in the Windows taskbar notification area:

If the Student is connected to a Class, right-click to show a Request help/Cancel help command. Click it or
double-click the button to request help or cancel a pending help request.

Note: A NetOp help request button will not be hidden when the Student is running in Stealth mode.

4.2.6.1.7  Connection Tab

This is the Student Options window Connection tab:

It enables you to specify Student Connection properties in these elements:

Communication profile

· The drop-down box list will contain available Communication profiles. Click one to show it in the field as
selected.

· New: Click to show the Communication profile edit window to create a Communication profile.

· Edit: Click to show the Communication profile edit window to edit the selected Communication profile.

· Delete: Click to delete the selected Communication profile.

NetOp Name Server

· Name space ID []: To connect to a Teacher using NetOp name management, this field must contain the
Name space ID specified in the matching field on the Teacher.

Subnet assistant

If a cluster of Students is located on a subnet very remote from the Teacher, you can improve
communication by making one of the cluster Students a Subnet assistant that will route communication
between the Teacher and cluster Students.

¨ Enable: Check to enable this Student's routing capabilities.
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· Address to reach teacher []: Specify the Teacher address (IP address or DNS name if communicating by
TCP/IP).

Note: For Connection tab changes to apply, you must Rejoin class.

4.2.6.1.8  Web Update Tab

This is the Student Options window Web update tab:

It enables you to update the Student installation from the web in these elements:

· Update server []: Specify the web address of the server from which to download Student update files
(default: update.netop.com, the NetOp web update server on the Internet).

Note: To support the update of many NetOp installations in an organization, we recommend to Publish new
updates to an internal web update server.

· HTTP proxy [] [Detect]: Specifying a HTTP proxy is typically not required. Before specifying a HTTP proxy,
click Update now to test the web update connection. If this yields a message indicating connection to the
update server, specify no HTTP proxy. If Update now yields no connection, click [Detect] to make NetOp
attempt to detect the HTTP proxy server to show its name and port number in the HTTP proxy field. Click
Update now to test the connection. If unsuccessful, consult with your network/system administrator about
what must be specified in the HTTP proxy field (format: <Server name>:<Port number>).

· Update now: Click to connect to the update server specified in the Update server field. A Web update
message will notify you if connection to the update server failed, if no updates are available or if updates
are available and in the latter case ask you if you want to download and install updates.

· Schedule: Click to show the Web update schedule window.
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4.2.6.2 Protection Password

Click the Student window Tools menu Protection password command to show this window:

It enables you to protect Student setup and certain user actions by a Protection password in these elements:

Change protection password: Click to show this window:

Specify the Protection password in these fields:

· Old password []: Specify the current Protection password (disabled if no Protection password is applied).

· New password []: Specify the new Protection password (leave empty if no Protection password shall be
applied).

· Confirm password []: Re-specify the new Protection password for confirmation.

Note: When a Protection password is applied, the Tools menu Protection password command will be
protected by the Protection password.

Protection password required for

¨ Configuration: Check to protect the Tools menu Options and Run setup wizard commands by the
Protection password.

¨ End session, Leave class, Exit, Unhide: Check to protect the Student user actions End session, Leave
class, Exit and Unhide by the Protection password.

Protect security configuration files

Click one of these options:

¤ Protect by protection password only (if applies): Protect Student setup only by any applied Protection
password protection that does not protect Student User configuration files.

¡ Protect files when connected: Protect Student User configuration files and disable Tools menu setup
commands when the Student is connected to a Class to prevent a connected Teacher from changing
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Student setup.

¡ Protect files when connected and class joined: Protect Student User configuration files and disable Tools
menu setup commands when the Student has Joined class to prevent a Student user that by Protection
password protection is unable to Leave class or Exit the Student from changing the Student setup.

Note: Checking boxes and clicking Protect files when connected and class joined will provide maximum
protection against Student users that want to disrupt the Class environment.
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5 Common Tools
This section explains tools that are common to Teacher and Student.

It contains the sections:

· Communication devices

· System info

5.1 Communication Devices

NetOp uses the term Communication devices for the NetOp adaptations of general communication
protocols and the NetOp proprietary protocols developed for NetOp applications.

NetOp modules use different configurations of Communication devices for communicating with other NetOp
modules in different environments. Such Communication device configurations that are given individual
names are called Communication profiles.

While a range of default Communication profiles are included when a NetOp module is installed for the first
time, a user will typically want or need to create new Communication profiles that are optimized for the user
environment.

This section explains Communication devices and how NetOp Communication profiles are created and
managed.

In the Teacher or Student Options window Connection tab Communication profile section, click New or Edit
to show this  window:

It enables you to create or edit a Communication profile in these elements:

Communication information

· Description of communication profile []: If shown from New, the field will be empty. If shown from Edit, the
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field will show the name of the selected Communication profile. Specify a Communication profile name or
edit it, if desired.

· Communication device []: The drop-down box list will contain the names of available Communication
devices that for NetOp School includes:

· NetBIOS

· IPX

· TCP/IP

· Terminal server (available only on NetOp modules that run on a terminal server). 

Select a Communication device in the list to show it in the field to make this Communication profile use the
selected Communication device.

¨ Use dial-up networking: Will be enabled only if TCP/IP is selected in the Communication device drop-down
box. Check to enable creating or editing a connection via modem to a network.

The lower window section will be named by the Communication device selection and have different contents
with different selections. Click a hotspot in the list above to jump to the section that explains the 
Communication device and its available options in the lower section of the Communication profile edit
window.

5.1.1 TCP/IP

TCP/IP (Transmission Control Protocol/Internet Protocol) is a suite of widely used network communication
protocols. NetOp School uses a NetOp adapted version of the TCP/IP suite networking protocol UDP (User
Datagram Protocol) named TCP/IP.

NetOp School utilizes the ability of UDP to send and receive name identified Broadcast communication on a
local IP network segment. UDP can also send and receive IP address and DNS name addressed Unicast
communication across large segmented IP networks including the Internet. This combination of local network
segment Broadcast communication and remote network segments Unicast communication enables running
physical Classes on a local network segment as well as virtual Classes on a large network or on the Internet.
 

This section includes these sections:

· TCP/IP settings

· TCP/IP communication profile edit

5.1.1.1 TCP/IP Settings

Communication profile

To use TCP/IP communication, in the Options window Connection tab Communication profile section select
a Communication profile that uses the TCP/IP Communication device (initially TCP/IP for local area network,
Internet for Internet and Wireless for wireless network communication).

Identification

Teachers identify themselves to Students by their running Class name.

Students identify themselves to Teachers by their Student login name, Windows login name and Computer
name. 

Computers identify themselves by one or multiple IP addresses and a DNS name.

NetOp School TCP/IP communication identifies Teachers and Students by their names and IP addresses.

Communication problems
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If NetOp School modules do not communicate as expected, use these diagnostic tools:

1. Verify that an IP connection is available between computers by using the PING utility explained below.

2. Read the TCP/IP communication profile edit section and verify that all required specifications are in place.

3. Read the NetOp School communication section. 

4. As a last resort, submit a support request by using the Support for NetOp products form on the
www.netop.com homepage.

PING utility

To verify that that an IP connection is available between two computers across a network using TCP/IP, on
one computer from a command prompt type:

PING <Other computer IP address>

The PING utility will send four data packets that request a reply. If replies are received, an IP connection is
available.

Resources

NetOp modules can use one TCP/IP port for sending and receiving communication.

We generally recommend that you use port number 1971 that is officially registered to NetOp School.

In special situations, you can use other port numbers but remember that the Teacher send port number must
always match the Student receive port number and vice versa.

5.1.1.2 TCP/IP Communication Profile Edit

The Communication profile edit window will have these contents if TCP/IP and Use dial-up networking are
selected:

The Communication information section contents are explained in the Communication devices section. This
section will explain the other sections.

TCP/IP network connection

http://www.netop.com
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This section enables you to create or edit dial-up network profiles in these elements:

· Dial-up network profile []: The drop-down box list will contain the names of dial-up network profiles that
have been used before. Click one to show it in the field.

· Dialing from and Calling card: Will show the names of these properties for the selected dial-up network
profile.  

· Configure: Click to show the Windows <Dial-up network profile name> properties window to reconfigure
the selected dial-up network profile.

· Dialing properties: Click to display the Windows Phone and modem options window to edit the dialing
properties of the selected dial-up network profile.

· Add profile: Click to show the Windows New connection wizard to create a new dial-up network profile.

TCP/IP

This section enables you to specify the TCP/IP communication properties of this Communication profile in
these elements:

· Max packet size (MTU) [] (512 – 5146 bytes): Specifies the maximum data packet size in the shown range.

Note: A high MTU can increase transfer speed and a low MTU can contribute to solving communication
problems.

¨ Optimize for Internet communication: Check to optimize MTU, compression and cache memory to
communicate across the Internet.

· Advanced: Click to show the Advanced TCP/IP configuration window.

· IP broadcast list: Click to show the IP broadcast list window.
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5.1.1.2.1  Advanced TCP/IP Configuration

In the TCP/IP communication profile edit window TCP/IP section, click Advanced to show this window:

It enables you to specify advanced TCP/IP communication properties in these elements:

Specify IP address

þ Use all available IP addresses: Leave checked to use all of the computer's IP addresses for this
Communication profile's communication. Uncheck to use only one IP address for this Communication
profile's communication to enable the field below.

· IP address []: Specify the computer IP address that shall be used.

Specify port numbers

þ Use default port numbers: Leave checked to use the official NetOp School port number 1971 for Receive
port and Send port. Uncheck to enable fields for both port numbers.

Note: Except for special situations, we recommend using the official port number. Remember that the
Teacher Send port number must match the Student Receive port number and vice versa.

NetOp Name Server

¨ Use NetOp Name Server: Leave unchecked to connect without using NetOp name management. Check to
use NetOp name management to connect swiftly across large segmented networks including the Internet.

· Primary []: Leave nns1.netop.com to use this primary NetOp Name Server on the Internet. If a local
primary NetOp Name Server is available, specify its IP address or DNS name.
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· Secondary []: Leave nns2.netop.dk to use this secondary NetOp Name Server on the Internet. If a local
secondary NetOp Name Server is available, specify its IP address or DNS name.

¨ Ignore port information from Name Server: Check to replace the destination module Receive port number
received from NetOp Name Server by the port number specified below.

Note: Some types of firewalls replace sent Receive port numbers by invalid port numbers to protect network
computers against connection attempts. In that case, NetOp Name Server will receive, store and return
invalid Receive port numbers that must be replaced by valid Receive port numbers.

· Use port []: Specify the port number that shall replace the Receive port number received from NetOp
Name Server (typically 1971).

Note: To use NetOp name management, in the Options window Connection tab NetOp Name Server section
specify the applicable Name space ID.

Unicast (only on Teacher)

¨ Enable: Check to supplement Broadcast communication by Unicast communication to each Class Student.

Multicast (only on Teacher)

¨ Enable: Check to supplement Broadcast communication by multicast communication via multicast routers.
Select one of these options:

¤ Automatic: Let NetOp specify a multicast IP address.

¡ Specify []: Specify a multicast IP address.

5.1.1.2.2  IP Broadcast List

In the TCP/IP communication profile edit window TCP/IP section, click IP broadcast list to show this window:

If NetOp name management is not used, for TCP/IP Broadcast communication to reach computers on
remote network segments computer IP addresses or DNS names must be in the IP broadcast list.

The pane will show specified IP addresses, IP address ranges and DNS names.

· Add: Click to show this window:
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Specify an IP address, IP address range ( - between addresses) or DNS name and click OK.

Note: Specifying an IP address range will send individual packets to all IP addresses in the specified
range. To avoid excess network traffic, do not specify a larger IP address range than required.

· Edit: Select an IP address, IP address range or DNS name in the pane and click to show the IP broadcast
list enter window to edit it.

· Delete: Select an IP address, IP address range or DNS name in the pane and click to delete it.

¨ Disable local subnet broadcast: Check to disable Broadcast communication to local network segment
computers.

5.1.2 Terminal Server

Terminal server is a NetOp proprietary Communication device that is available only on NetOp modules
installed on a Windows terminal server.

NetOp School Teacher and Student installed on a terminal server can run in client sessions. Each client
session Teacher can communicate with client session Students using a Terminal server Communication
profile.

A NetOp Gateway that runs on the terminal server console can route communication between client session
NetOp School modules and NetOp School modules that run on network computers or other terminal servers.

Note: The particulars of installing, setting up and running NetOp School in terminal server environments are
explained in the NetOp School in terminal server environments section.

This section includes these sections:

· Terminal server settings

· Terminal server communication profile edit

5.1.2.1 Terminal Server Settings

Communication profile

To use Terminal server communication, in the Options window Connection tab Communication profile section
select a Communication profile that uses the Terminal server Communication device (initially Terminal server
).

Identification

Teachers identify themselves to Students by their running Class name.

Students identify themselves to Teachers by their Student login name, Windows login name and Computer
name. 

Note: All Teachers and Students on a terminal server share the same Computer name.

Terminal server client sessions identify themselves by the Windows login name of the user logged in to the
terminal server.

NetOp School Terminal server communication identifies Teachers and Students by their names.

Communication problems
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If NetOp School modules do not communicate as expected, use these diagnostic tools:

1. Read the NetOp School in terminal server environments section that explains the particulars of installing,
setting up and running NetOp School on a terminal server.

2. Read the NetOp School communication section. 

3. As a last resort, submit a support request by using the Support for NetOp products form on the
www.netop.com homepage.

Resources

When NetOp School is properly installed on a terminal server, the required resources are available.

5.1.2.2 Terminal Server Communication Profile Edit

The Communication profile edit window will have these contents if Terminal server is selected:

The Communication information section contents are explained in the Communication devices section.

The Terminal server section is empty. No options or settings are available with the Terminal server
Communication device.

5.1.3 IPX

IPX (Internetwork Packet Exchange) is a networking communication protocol developed by Novell. IPX is
typically used in network environments with NetWare servers and clients.

NetOp School utilizes the ability of IPX to send and receive name identified Broadcast communication on a
local network including interconnected Novell networks. This enables running physical Classes on a local
network as well as virtual Classes across interconnected Novell networks.

This section includes these sections:

· IPX Settings

· IPX Communication Profile Edit

5.1.3.1 IPX Settings

Communication profile

To use IPX communication, in the Options window Connection tab Communication profile section select a
Communication profile that uses the IPX Communication device (initially IPX).

Identification

Teachers identify themselves to Students by their running Class name.

Students identify themselves to Teachers by their Student login name, Windows login name and Computer
name. 

http://www.netop.com
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Computers identify themselves by the MAC address of their network card. A MAC address consists of 0x
followed by a 12 digit hexadecimal number, e.g. 0x080005AF341A.

NetOp School IPX communication identifies Teachers and Students by their names and computer network
card MAC address.

Communication problems

If NetOp School modules do not communicate as expected, use these diagnostic tools:

1. Read Finding network numbers below and the IPX communication profile edit section to identify and
specify the network numbers of modules located on remote networks.

2. Experiment with the NetOp.ini setting explained below.

3. Read the NetOp School communication section. 

4. As a last resort, submit a support request by using the Support for NetOp products form on the
www.netop.com homepage.

Finding network numbers

To find the network number for a computer with a known name, type this from a command prompt:

nlist user=<Name> /a (NetWare 4.x) or

userlist /a (NetWare 3.x)

If you are attached to a NetWare server that recognizes the name, it will respond with the network number in
the address field.

NetOp.ini setting

This setting can be used in a NetOp.ini file [IPX] section:

Key Value Explanation

Max_Packet_Size= <Number> The number specifies the maximum packet size in bytes. If you encounter
communication problems, try reducing the maximum packet size to the
minimum 512 bytes.

Resources

NetOp School uses IPX socket 8641 (hex) when communicating between a Teacher and a Student.

Novell has assigned this socket to NetOp.

http://www.netop.com
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5.1.3.2 IPX Communication Profile Edit

The Communication profile edit window will have these contents if IPX is selected:

The Communication information section contents are explained in the Communication devices section.

IPX

This section enables you to specify the IPX communication properties of this Communication profile in these
elements:

Novell networks

Select one of the options:

¤ Local network only: Communicate to the local network only.

¡ User defined list of networks: Enables the Network list button. Click it to show the Novell network
numbers window.

¡ Build list of known networks: Let NetOp browse the network to build a list of known networks to enable
communication to these networks.
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The pane will show 8-digit hexadecimal network numbers of remote networks.

· Add: Click to show this window:

Specify an 8-digit hexadecimal network number or edit it and click OK to apply.

· Edit: Select a network number in the pane and click to show it in the Novell network number window to
edit it.

· Delete: Select a network number in the pane and click to delete it.

5.1.4 NetBIOS

NetBIOS (Network Basic Input/Output System) is a simple networking communication protocol for local area
network communication.

NetOp School utilizes the ability of NetBIOS to send and receive name identified Broadcast communication
on a local network segment. Communication that uses NetBIOS in its basic mode (in Windows: Microsoft
NetBEUI) cannot pass network connection elements like routers. Communication that uses NetBIOS over
IPX or TCP/IP can pass network connection elements. Communicating modules must use the same
NetBIOS mode. Different NetBIOS modes use different NetBIOS adapter numbers.

This section includes these sections:

· NetBIOS settings

· NetBIOS communication profile edit
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5.1.4.1 NetBIOS Settings

Communication profile

To use NetBIOS communication, in the Options window Connection tab Communication profile section select
a Communication profile that uses the NetBIOS Communication device (initially NetBIOS).

Identification

Teachers identify themselves to Students by their running Class name.

Students identify themselves to Teachers by their Student login name, Windows login name and Computer
name. 

Computers identify themselves by the MAC address of their network card. A MAC address consists of 0x
followed by a 12 digit hexadecimal number, e.g. 0x080005AF341A.

NetOp School IPX communication identifies Teachers and Students by their names and computer network
card MAC address.

Communication problems

If NetOp School modules do not communicate as expected, use these diagnostic tools:

1. Verify that Teacher and Student use the same NetBIOS mode, see NetBIOS and NetBIOS communication
profile edit.

2. Experiment with the NetOp.ini settings explained below.

3. Read the NetOp School communication section. 

4. As a last resort, submit a support request by using the Support for NetOp products form on the
www.netop.com homepage.

NetOp.ini settings

These settings can be used in a NetOp.ini file [NetBIOS] section:

Key Value Explanation

Max_Packet_Size= <Number> The number specifies the maximum packet size in bytes. If you encounter
communication problems, try reducing the maximum packet size to the
minimum 512 bytes.

Rcv_DG_Threads= 1 or 2 By default, NetOp uses 2 datagram threads. Under certain circumstances, 2
datagram threads cause problems, and 1 can be specified.

Resources

No particular resources are used by the NetBIOS communication device.

http://www.netop.com
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5.1.4.2 NetBIOS Communication Profile Edit

The Communication profile edit window will have these contents if NetBIOS is selected:

The Communication information section contents are explained in the Communication devices section.

NetBIOS

This section enables you to specify the NetBIOS communication properties of this Communication profile in
this element:

· Adapter number [] (0-255) [List]: Click [List] to show this window:

The table will show records of available NetBIOS modes with these column contents:

· Number: Adapter number.

· Description: Mode description.

· Version: Software version number.

· Type: Software type.

· Max packet size: Maximum packet size in bytes.

· MAC address: Network adapter MAC address.

Note: Table information is retrieved from Windows. Valid mode records will show  the computer network
card MAC address. The table may contain other records with random MAC addresses. They are invalid
and must be disregarded.

Select a record and click OK to enter the adapter number in the Adapter number field.



283

Common Tools

5.2 System Info

In the About... window, click the System info button to show this window:

It shows various system information in these elements:

· The upper section shows summary program and system information.

· The middle section shows summary screen information.

· The lower section shows summary driver information.

It has these menus:

·

Click a command to show detailed screen display information in a Screen info window.

·

Click Net addresses to show this window:
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The pane will show enabled computer network addresses.

Note: Teacher network addresses will be enabled when the Teacher runs a Class. Student network
addresses will be enabled when the Student has Joined class (is communicating).
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6 Advanced Tools
This section explains Advanced tools that are of interest mainly to system or network administrators.

It includes these sections:

· NetOp.ini

· NetOp configuration files

· NetOp School communication

· NetOp School in terminal server environments

· NetOp name management

· NetOp School class management

6.1 NetOp.ini

Installing a NetOp program on a computer for the first time will create a NetOp.ini file in the Windows (or
WINNT) folder.

NetOp.ini will be read when a NetOp program is Installed on the computer to determine among other things
the default Installation folder and program folder and will automatically be updated with each additional
NetOp program Installation.

NetOp.ini will be read when a NetOp module is loaded. It can contain special setup information that will be
applied to the NetOp module.

Typically, you do not need to worry about NetOp.ini, but you can edit it to provide desired installation and
loading options.

NetOp.ini uses the standard Windows .ini file format with sections, keys and values. It is a plain text file that
can be opened and edited in a standard text editor:
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NetOp.ini can contain the sections:

· [INSTALL]: Always included. Specifies Installation settings.

· [COEXISTENCE]: Always included. Specifies settings for running different NetOp modules on a computer
at the same time.

· [TEACHER]: Optional. Specifies Teacher settings. 

· [STUDENT]: Optional. Specifies Student settings.

· [IPX]: Optional. Specifies IPX settings.

· [NetBIOS]: Optional. Specifies NetBIOS settings.

· [DTL]: Optional. Specifies communication settings.

Other optional sections can be included in NetOp.ini.

Note: The www.netop.com website Support section KnowledgeBase section Documentation section
NetOp.ini settings section explains available NetOp.ini settings.

http://www.netop.com
http://help.netop.com
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6.1.1 [INSTALL] Section

The NetOp.ini file always included [INSTALL] section will contain keys that specify the folder path and
program folder name of the most recently installed NetOp programs. These NetOp School keys are typically
included:

SCHOOL_DIRECTORY=C:\Program Files\Danware Data\

SCHOOL_FOLDER=NetOp School

TEACHER_DIRECTORY=C:\Program Files\Danware Data\NetOp School\Teacher\

STUDENT_DIRECTORY=C:\Program Files\Danware Data\NetOp School\Student\

The values of these keys are the default suggestions when reinstalling NetOp programs.

Note: The www.netop.com website Support section KnowledgeBase section Documentation section
NetOp.ini settings section explains available NetOp.ini settings.

6.1.2 [COEXISTENCE] Section

The NetOp.ini file always included [COEXISTENCE] section will contain keys that specify if different NetOp
programs can be loaded on the computer at the same time.

It can contain these keys:

COEXIST=<0, 1 or 2>

This key will always be included.

The value 0 will not allow loading a NetOp module if another NetOp module is loaded.

The value 1 will allow loading a NetOp module temporarily suspending a loaded different NetOp module. A 
Student connected to a Class cannot be suspended.

The value 2 will allow loading a NetOp module while a different NetOp module is loaded.

LOAD_WARNING=<0 or 1>

This key is optional.

The value 0 will not show a warning message.

The value 1 or no key will show a warning message that enables the user to accept or deny temporarily
suspending a loaded module to load another module if COEXIST has the value 1.

DEBUG=<0 or 1>

This key is optional.

The value 0 or no key will hide a window that shows the loader program commands executing.

The value 1 will show a window that shows the loader program commands executing.

Note: If two NetOp modules shall run on a computer at the same time, they must use different
Communication device settings (with TCP/IP different port numbers).

Note: The www.netop.com website Support section KnowledgeBase section Documentation section
NetOp.ini settings section explains available NetOp.ini settings.

6.1.3 [TEACHER] Section

The NetOp.ini file optional [TEACHER] section can contain keys that modify certain Teacher properties.

It can contain these keys:

DATAPATH=<Path>

Teacher User configuration files will be stored in the specified <Path> instead of their default location.

LESSONPATH=<Path>

http://www.netop.com
http://help.netop.com
http://www.netop.com
http://help.netop.com
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Teacher Lesson plan files will be stored in the specified <Path> instead of their default location.

POLICYPATH=<Path>

Teacher Policy files will be stored in the specified <Path> instead of their default location.

RECORDPATH=<Path>

Teacher Recording files will be stored in the specified <Path> instead of their default location.

SNAPSHOTPATH=<Path>

Teacher Print screen to file files will be stored in the specified <Path> instead of their default location.

TESTPATH=<Path>

Teacher Test files will be stored in the specified <Path> instead of their default location.

SURVEYPATH=<Path>

Teacher Survey files will be stored in the specified <Path> instead of their default location.

BLOCKPATH=<URL path>

This key will store a Teacher Options window Sharing tab Blocking page specified URL path.

Note: You can use environment variables in the <Path> parameter.

Max_Students=<Number>

A number between 5 and 200 will specify the maximum number of Students in a Class. Default is 50.

Note: The www.netop.com website Support section KnowledgeBase section Documentation section
NetOp.ini settings section explains available NetOp.ini settings.

6.1.4 [STUDENT] Section

The NetOp.ini file optional [STUDENT] section can contain keys that modify certain Student properties.

It can contain this key:

DATAPATH=<Path>

Student User configuration files will be stored in the specified <Path> instead of their default location.

Note: The www.netop.com website Support section KnowledgeBase section Documentation section
NetOp.ini settings section explains available NetOp.ini settings.

6.1.5 [IPX] Section

The NetOp.ini file optional [IPX] section can contain keys that modify certain IPX properties.

It can contain this key:

Max_Packet_Size=<Number>

A number between 512 and 5000 will specify the maximum data transmission packet size in bytes.

Note: The www.netop.com website Support section KnowledgeBase section Documentation section
NetOp.ini settings section explains available NetOp.ini settings.

6.1.6 [NetBIOS] Section

The NetOp.ini file optional [NetBIOS] section can contain keys that modify certain NetBIOS properties.

It can contain these keys:

Max_Packet_Size=<Number>

A number between 512 and 5000 will specify the maximum data transmission packet size in bytes.

RCV_DG_THREADS=<1 or 2>

http://www.netop.com
http://help.netop.com
http://www.netop.com
http://help.netop.com
http://www.netop.com
http://help.netop.com
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1 or 2 will specify the number of received datagram threads.

Note: The www.netop.com website Support section KnowledgeBase section Documentation section
NetOp.ini settings section explains available NetOp.ini settings.

6.1.7 [DTL] Section

The NetOp.ini file optional [DTL] section can contain keys that modify certain communication properties.

It can contain these keys:

MinTimeOut=<Number>

MaxTimeOut=<Number>

Each of these keys will replace NetOp’s automatic calculation of minimum or maximum waiting time for
receiving an acknowledgement of data packet reception by the specified number of tics (1/18 second).

TimeOutTimes=<Number>

A number between 1 and 50 will add this number of timeout attempts to the default 10.

Use these keys to overcome communication problems in crowded networks where data packets take a long
time to get through or get lost.

Note: The www.netop.com website Support section KnowledgeBase section Documentation section
NetOp.ini settings section explains available NetOp.ini settings.

6.2 NetOp Configuration Files

The setup of NetOp modules is stored in configuration files, typically with the extension .ndb.

When a NetOp module is installed on a computer, its setup will be stored in Installed configuration files in the
folder where the NetOp module is installed.

When a user loads a NetOp module for the first time after it was installed, Installed configuration files will be
copied to a user folder to serve as User configuration files.

Unless the NetOp module is installed in a fully set up state by deployment, the Setup wizard will run for the
user to create a customized setup, the settings of which will be written to the User configuration files.

Folders for other NetOp files created by the user will be created in the User configuration files folder.

NetOp log files created by the user will be saved in the User configuration files folder.

This table provides an overview of NetOp School configuration and other files, their location and contents:

File name Location  File contents

Common files:

comiplst.ndb <Teacher> and
<Student>

IP broadcast list

comprof.ndb <Teacher> and
<Student>

Communication profiles

Teacher files:

classrms.ndb <Teacher> Classes

locstd.ndb <Teacher> Student file locations

loctch.ndb <Teacher> Teacher file locations

nowconf.ndb <Teacher> Teacher setup

runprog.ndb <Teacher> Run program specifications

stdgrps.ndb <Teacher> Student groups

stdinfo.ndb <Teacher> Student information

teachers.ndb <Teacher> Teacher profiles

http://www.netop.com
http://help.netop.com
http://www.netop.com
http://help.netop.com
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*.log, *.rlg <Teacher>\DeployLog Student deployment logs

*.xml <Teacher>\Lessonpl Lesson plans

*.xml <Teacher>\Policies Policies

*.dwr <Teacher>\screcord Recordings

*.ndb, setup.iss <Teacher>\StudentNDB Student deployment setup files

*.nxt, *.nxs, *.nxr <Teacher>\Tests Tests, surveys, results

Student file:

nhstconf.ndb <Student> Student setup

The meanings of <Teacher> and <Student> are explained in the Default location of user configuration files
section.

When a user changes the setup of a NetOp module during use, changes will be written to the User
configuration files immediately or when the NetOp module is unloaded.

When a user loads a NetOp module, the User configuration files will be read to re-establish the setup that
existed when the user last unloaded the NetOp module.

If User configuration files are write protected or access to the folders in which they reside is denied, user
setup changes cannot be written to files and will not be retained.

The setup of a NetOp School module can be protected by applying a Protection password. Student User
configuration files can be protected when the Student is connected to a Class or has Joined class.

If User configuration files are deleted, the user setup of deleted User configuration files will be lost. When the
module is loaded after deleting User configuration files, a new user setup in new User configuration files will
be created.

Most configuration files are written in a NetOp proprietary format that cannot be read or edited separately.

6.2.1 Default Location of User Configuration Files

If user profiles are implemented on the computer, Teacher User configuration files will by default be stored in
user folder of the user logged in to Windows. Student User configuration files will by default be stored in the
All users (Vista: ProgramData) folder.

User profiles are implemented with Windows Vista, XP, 2000 and NT and can be implemented with Windows
ME, 98 and 95:

· On Windows Vista, user folders are typically C:\Users\<Windows login user name>.

· On Windows XP and 2000, user folders are typically C:\Documents and settings\<Windows login user
name>.

· On Windows NT, user folders are typically C:\WINNT\Profiles\<Windows logon user name>.

· On Windows ME, 98 and 95, user folders, if implemented, are typically are C:\Windows\Profiles\<Windows
logon user name>.

By default, User configuration files will reside in the path <User folder>\Application data\<NetOp module
path>, where <NetOp module path> is the full path to the folder in which the NetOp module is installed. If the
NetOp module is installed in the C:\Program files folder, only the path from that folder is used in <NetOp
module path>.

Note: Application data is a hidden folder. To show it and its contents, on the Windows folder options window
View tab select Show hidden files and folders.

If user profiles are implemented, this is the meaning of <Teacher> and <Student> in the NetOp configuration
files section table.

If user profiles are not implemented using Windows ME, 98 or 95, User configuration files will by default
reside in a Config folder in the folder in which the NetOp module is installed.

You can store User configuration files in other locations, see Other locations of user configuration files.
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6.2.2 Other Locations of User Configuration Files

You can store NetOp User configuration files and other user created files in other user individual or general
locations by specifying some or all of these keys in the NetOp.ini file:

[TEACHER]

DATAPATH=<Path>

LESSONPATH=<Path>

POLICYPATH=<Path>

RECORDPATH=<Path>

SNAPSHOTPATH=<Path>

TESTPATH=<Path>

SURVEYPATH=<Path>

and/or

[STUDENT]

DATAPATH=<Path>

- where <Path> is the full path to the folder in which User configuration files or other user created files shall
be stored.

In this case, this is the meaning of <Teacher> and <Student> in the NetOp configuration files section table.

6.3 NetOp School Communication

NetOp School uses two different types of communication between Teachers and Students, namely
Broadcast communication and Unicast communication.

Broadcast communication 

Broadcast communication will communicate to all reachable recipients. 

Broadcast communication will reach local network computers but will typically not pass routers and other
network connection elements to reach remote network computers. 

Using TCP/IP, local Broadcast communication can be extended by sending the same communication by
Unicast communication to individual IP addresses and/or DNS names of computers beyond the local network
specified in an IP broadcast list or received by using NetOp Name Server.

Unicast communication

Unicast communication will communicate to a specific recipient. 

Initial Unicast communication must contain destination computer or terminal server client session
identification. TCP/IP identifies computers by their IP address or DNS name. Terminal server identifies client
sessions by their Windows login user name. IPX and NetBIOS identify computers by their MAC address.

Responses to Broadcast communication and Unicast communication will be sent by Unicast communication
that can pass the network connection elements passed by the communication responded to. 

NetOp Unicast communication will (unless being extended Broadcast communication) request a
communication receipt acknowledgement returned to the sender.

NetOp School uses Broadcast communication for these actions:

Announcement

An Announcement is Broadcast communication that does not request a response.

When a Teacher loads with a Class name, Reannounces class, Changes class or Unloads, it will send an
Announcement.

· A Student that is Waiting for the announced Class will return Unicast communication to connect to the
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Class.

· A Student that is Available will in response to a Class Announcement return Unicast communication
stating its Status, which will add the Student in the Teacher Available students pane. If the responding
Student is a member of the Class, the Teacher will by Unicast communication request the Student to
connect, which the Student will do by Unicast communication.

· A Student that while connected receives an Announcement that the Teacher Changes class or Unloads
will disconnect. 

When a Student Joins class with the Options window Class tab Be available for any class option selected,
or with this option selected becomes Available, it will send an Announcement.

· On Teachers that run a Class, the Announcement will add the Student in the Available students pane.

· A Teacher that runs a Class in which the Announcement Student is a member will by Unicast
communication request the Student to connect, which the Student will do by Unicast communication.

When a Student from being Available Leaves class or connects to a Class to no longer be Available, it will
send an Announcement.

· On Teachers that run a Class, the Announcement will remove the Student in the Available students
pane.

Browse

A Browse is Broadcast communication that requests a response from specified recipients.

When a Student Joins class with the Options window Class tab Browse for classes option selected, it will
send Broadcast communication that requests a response from Teachers that run a Class. Teachers that
run a Class will respond by Unicast communication to enable the Student to build a list of available Classes
. If the Student user selects a Class in the list and clicks OK, the Student will connect by Unicast
communication.

When a Student Joins class with the Options window Class tab Connect to class: <Class name> option
selected, it will send Broadcast communication that requests a response from the Teacher that runs <
Class name>. If the Student receives a response, it will connect by Unicast communication. If the Student
does not receive a response, it will become Waiting for <Class name> to respond to a Teacher
Announcement of <Class name>.

Most other NetOp School communication including in-Class communication will be by Unicast
communication.

6.4 NetOp School in Terminal Server Environments

You can install NetOp School on a Windows terminal server to run Classes between Teachers and Students
in client sessions in a terminal server environment (TSE). 

A NetOp Gateway that runs on the terminal server console can route communication between client session
NetOp School modules and NetOp School modules that run on network computers or other terminal servers
to run Classes in a mixed terminal server and network environment.

This section will explain the particulars of NetOp School in a TSE in these sections:

· Installation (TSE)

· Teacher and student setup (TSE)

· NetOp Gateway setup (TSE)

· NetOp School functionality (TSE)

6.4.1 Installation (TSE)

On a terminal server, you cannot install by running the product .msi file.

Click Start > Control panel > Add or remove programs to install from the Add new programs button.
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Always install Teacher and Student.

To enable communicating with Teachers and Students outside the terminal server, also install NetOp
Gateway.

6.4.2 Teacher and Student Setup (TSE)

Teacher setup

When a specific user in a terminal server client session loads the Teacher for the first time after Installation,
the Teacher Setup wizard will run for the user to create an initial personal Teacher setup. 

In the Class management window, click Windows login name to initially use this name option for the Student
display name because all Students in a TSE share the same Computer name.  

In the Communication profile window, select Terminal server to enable communicating in the TSE.

The Teacher User configuration files and user created files will be stored in the user's user profile folder on
the terminal server to apply when loading the Teacher from the user's terminal server client session.

Student setup

When any user in a terminal server client session loads the Student for the first time after Installation, the
Student Setup wizard will run for the user to create an initial general Student setup.

In the Classroom window, click the preferred Class connect option and in the Identify student by drop-down
box select an option that is not based on the computer name because all Students in a TSE share the same
computer name.

In the Communication profile window, select Terminal server to enable communicating in the TSE.

The Student User configuration files will be stored in the All users folder on the terminal server to apply when
any user loads the Student from a terminal server client session.

Protected student setup

To apply a uniform protected Student setup that will prevent Student users from changing the Student setup
to disrupt the Class environment, an administrator should set up the Student with maximum Protection
password protection before other users are allowed to load the Student.

Individual student setup

In an adult teaching environment, you may prefer to apply an individual Student setup for each user.

To store Student User configuration files in each user's user profile folder on the terminal server, assuming
that the Student is installed in its default folder add this key in the terminal server NetOp.ini file [STUDENT]
section:

DATAPATH=%USERPROFILE%\Application Data\Danware Data\NetOp School\Student\

6.4.3 NetOp Gateway Setup (TSE)

To enable communication between inside TSE Teachers and Students and outside TSE Teachers and
Students, a correctly set up NetOp Gateway must be running on the terminal server console.

NetOp Gateway is an extended NetOp Remote Control Host with the capability to route communication
between different Communication devices.

With NetOp School in TSE, the task is to route between inside TSE communication that uses the Terminal
server Communication device and outside TSE communication that uses typically the TCP/IP
Communication device.

NetOp Gateway setup in general is explained in the NetOp Remote Control documentation that will be
available with NetOp Gateway. Pay special attention to this:

· Set up NetOp Gateway from the terminal server keyboard, mouse and screen (the terminal server
console).

· Be sure to observe the NetOp net number rules, particularly if multiple terminal servers are connected to
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the same network.

· When installed, NetOp Gateway will in the Advanced TCP/IP configuration window typically specify the
NetOp Remote Control default port number 6502. Be sure to change it into your NetOp School port
number, typically 1971.

· If Teachers and Students running on one terminal server shall communicate with Teachers and Students
running on another terminal server connected to the same network, add these keys to the NetOp.ini file
[DTL] section on both terminal servers:

GWRestrictedBroadcast=0

GWAllowFullBroadcast=1

Explanation: Routing communication through two NetOp Gateways across a network is generally disabled
because it can in some setups cause an uncontrolled propagation of network traffic (broadcast storm).
These keys will safely enable communication through two TSE NetOp Gateways across a network.

6.4.4 NetOp School Functionality (TSE)

NetOp School has in most respects the same functionality in a TSE as in a network environment. However,
some Teacher Commands actions work differently:

· Log off, Restart and Shut down will log off the Student user from the terminal server client session.

Caution: The same commands executed on a Student that runs on the terminal server console will execute
like in a network environment affecting the entire terminal server.

6.5 NetOp Name Management

To connect swiftly between network computer Teachers and Students across large segmented networks
including the Internet without the need to specify destination addresses in an IP broadcast list, use NetOp
name management.

NetOp name management runs using NetOp Name Server that is an extended NetOp Remote Control Host
with the capability to resolve the names of NetOp modules that communicate using the TCP/IP
Communication device into their IP address.

To use NetOp name management, in the selected TCP/IP Communication profile Advanced TCP/IP
configuration window NetOp Name Server section check the Use NetOp Name Server box and specify in the
Primary and Secondary fields the DNS name or IP address of the NetOp Name Servers you will use. In the
Teacher or Student Options window Connection tab NetOp Name Server section Name space ID field,
specify the up to 32 characters word that identifies your private name space. All Teachers and Students that
shall connect by NetOp name management must specify the same NetOp Name Servers and Name space
ID.

When you connect by a Class or Student name, NetOp Name Server will resolve it into its matching IP
address by which you will connect.

Two NetOp Name Servers with the DNS names nns1.netop.com and nns2.netop.dk run permanently on the
Internet for public use. Your private Name space ID will ensure full privacy. NetOp Name Server is also
available for private installation.

When a NetOp module that uses NetOp name management starts communicating (Teacher loads running a
Class, Student Joins class), it will send its names and IP address to NetOp Name Server to enable resolving
names into the matching IP address. To ensure that the stored information is always up to date, NetOp
Name Server will request renewal of the information every few minutes and delete information that is not
renewed.

For further details on NetOp name management, see the www.netop.com website Support section
KnowledgeBase section Documentation section Manuals section. NetOp name management documentation
is included in the NetOp Remote Control Administrator's manual.

http://www.netop.com
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6.6 NetOp School Class Management

NetOp School class management provides centralized control of a teaching organization's NetOp School
Classes.

It consists of these elements:

· NetOp Class Server: A NetOp Remote Control Host with the added capability of providing Class
information from a central Class database to Teachers and Students.

· Class database: A database server residing Class information database.

· NetOp Class Manager: A database client application by which you can create and manage the Class
database.

Teachers and Students interact with NetOp School class management as illustrated in this diagram:

1a./1b. Request class information: When Teachers load and Students Join class and after they end a
Class, they will request Class information from NetOp Class Server. Teacher users can request Class
information at any time.

2. Query class database: NetOp Class Server will query the Class database for requesting Teacher and
Student Class information.

3a./3b. Return class information: NetOp Class Server will return this Class information to requesting
Teachers and Students.

4. Connect: Teacher users can select an available Class to run it. Students can be set up to:

· connect to or wait for a running Class to which they are assigned, or

· enable the user to select a running, upcoming or generally available Class to connect to or wait for it or
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select to be Available for any  class.

NetOp School class management can in a specified Term run in one of two modes:

· Non-scheduled mode: Teachers and Students will be assigned to Courses. NetOp School class
management will not schedule Course Classes. Teachers can run Classes of Courses to which they are
assigned, typically according to a schedule specified outside NetOp School class management. Students
will or can connect to Classes of Courses to which they are assigned.

· Scheduled mode: Teachers and Students will be assigned to Courses. NetOp School class management
will schedule Course Lessons in Classrooms, typically on a weekly basis. Teachers and Students will or
can connect in Classes according to this schedule.

NetOp School class management including NetOp Class Server and NetOp Class Manager is available for
installation on a teaching organization's network.

For further details on NetOp School class management, see the www.netop.com website Support section
KnowledgeBase section Download products section NetOp School section. Click the current NetOp School
version in your preferred language to show available download options. Under NetOp School Class Server,
click Manual (PDF) to download the current NetOp School class management user's manual.

http://www.netop.com
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